Contents

About This Guide 9

1 Basic Concepts 11
  1.1 Bundles ................................................................. 11
  1.2 Bundle Group ......................................................... 12
  1.3 Folder ................................................................... 12
  1.4 Actions ................................................................. 12
  1.5 Action Sets ............................................................. 13
    1.5.1 Distribute .......................................................... 13
    1.5.2 Install ............................................................. 13
    1.5.3 Launch ............................................................ 14
    1.5.4 Repair ............................................................ 15
    1.5.5 Uninstall .......................................................... 15
    1.5.6 Terminate ......................................................... 16
    1.5.7 Preboot ........................................................... 17
  1.6 Assigning Bundles .................................................... 17
  1.7 Packaging Considerations ............................................ 17
    1.7.1 Time Required for Packaging: ................................. 17
    1.7.2 Space Required for Packaging: ............................... 18
  1.8 Content ................................................................. 19
    1.8.1 Content Replication .............................................. 19
    1.8.2 Content Delivery ................................................ 19
  1.9 Assigning Bundles ..................................................... 19
  1.10 Assigning Bundles .................................................... 19
  1.11 Assigning Bundles .................................................... 19

2 Creating Bundles 21
  2.1 Installing ZCC Helper .................................................. 21
  2.2 Creating Linux Bundles ............................................... 22
  2.3 Creating Macintosh Bundles .......................................... 22
  2.4 Creating Preboot Bundles ............................................ 26
  2.5 Creating Windows Bundles .......................................... 26
  2.6 Creating Bundles by Using the zman Command Line Utility 37
    2.6.1 Creating a Simple Bundle ....................................... 37
    2.6.2 Creating a Bundle with Content and Dependency on Another Bundle 39
    2.6.3 Understanding the zman Bundle XML File Format ........... 40
  2.7 Creating iOS Bundles ................................................ 42
  2.8 Creating Corporate Bundles ........................................ 42
  2.9 Exporting and Importing Bundles ................................. 43
    2.9.1 Exporting Bundles .............................................. 43
    2.9.2 Importing Bundles .............................................. 43

3 Viewing the Bundle Information 45
  3.1 Understanding the Bundle Page .................................... 45
  3.2 Bundle Summary Page ............................................... 45
    3.2.1 General ............................................................ 45
    3.2.2 Bundle Status ................................................... 49
    3.2.3 Message Log ..................................................... 50
    3.2.4 Upcoming Events ............................................... 51
4 Managing Bundle Groups

4.1 Creating Bundle Groups ............................................ 53
4.2 Renaming or Moving Bundle Groups ................................ 54
4.3 Copying the System Requirements of a Bundle Group .............. 54
4.4 Group Members ..................................................... 55
  4.4.1 Adding Members to a Group .................................... 55
  4.4.2 Removing Members from a Group ................................. 55
  4.4.3 Reordering Members in a Group ................................. 55
  4.4.4 Copy Members .................................................. 55
  4.4.5 Move Members .................................................. 55
4.5 Deleting a Bundle Group .............................................. 56
4.6 Adding a Bundle to a Group ......................................... 56
4.7 Copying a Bundle Group to a Content Server ....................... 57

5 Managing Folders

5.1 Creating Folders ..................................................... 59
5.2 Renaming or Moving Folders ......................................... 59
5.3 Deleting a Folder .................................................... 60

6 Actions

6.1 Action - Copy Directory ............................................. 61
  6.1.1 General ....................................................... 63
  6.1.2 Requirements ................................................ 65
6.2 Action - Copy Files .................................................. 65
  6.2.1 General ....................................................... 65
  6.2.2 Requirements ................................................ 66
6.3 Action - Create/Delete Directory .................................... 67
  6.3.1 General ....................................................... 67
  6.3.2 Requirements ................................................ 68
6.4 Action - Delay ........................................................ 68
  6.4.1 General ....................................................... 69
  6.4.2 Requirements ................................................ 69
6.5 Action - Display Message ............................................ 69
  6.5.1 General ....................................................... 70
  6.5.2 Requirements ................................................ 70
6.6 Action - Distribute Files ............................................. 70
6.7 Action - Edit INI File ............................................... 71
  6.7.1 General ....................................................... 71
  6.7.2 Advanced ..................................................... 73
  6.7.3 Requirements ................................................ 73
6.8 Action - Edit Text File ............................................... 74
  6.8.1 General ....................................................... 74
  6.8.2 Requirements ................................................ 75
6.9 Action - End Process ................................................ 75
  6.9.1 General ....................................................... 76
  6.9.2 Requirements ................................................ 76
6.10 Action - File Removal ............................................... 76
  6.10.1 General ....................................................... 76
  6.10.2 Requirements ................................................ 77
6.11 Action - Install Bundle ............................................. 77
  6.11.1 General ....................................................... 77
  6.11.2 Requirements ................................................ 78
6.12 Action - Install Directory ......................................... 78
  6.12.1 General ....................................................... 78
## 10 Managing System Requirements

10.1 Adding System Requirements for a Bundle .................................................. 159
10.1.1 Filter Conditions .................................................................................. 159
10.1.2 Filter Logic .......................................................................................... 165
10.2 Copying a Bundle’s System Requirements .................................................. 165
10.3 Copying a Bundle Group’s System Requirements ...................................... 166

## 11 Managing Bundle Settings

11.1 Managing System Variables ....................................................................... 167
11.2 Primary Server Replication ......................................................................... 169
11.3 Satellite Server Replication ......................................................................... 169
11.4 Sandbox Settings ....................................................................................... 170
11.5 End Point Throttle ...................................................................................... 170
11.6 Image Bundle Flag Settings ......................................................................... 170

## 12 Managing Action and Action Sets

12.1 Managing Actions ....................................................................................... 171
12.2 Modifying Action Set Options .................................................................... 173
  12.2.1 Install Action Set Options .................................................................... 174
  12.2.2 Launch Action Set Options ................................................................... 174
  12.2.3 Uninstall Action Set Options ................................................................. 175
  12.2.4 Terminate Action Set Options ................................................................. 176

## 13 Accessing Bundles on a Managed Device

13.1 Bundles vs. Applications ............................................................................ 177
13.2 User-Assigned vs. Device-Assigned Bundles .............................................. 178
13.3 Accessing Bundles ....................................................................................... 178
  13.3.1 ZENworks Window ............................................................................. 178
  13.3.2 ZENworks Explorer ........................................................................... 180
  13.3.3 ZENworks Icon .................................................................................. 182
13.4 Understanding Bundle Icons ...................................................................... 182
13.5 Launching a Bundle .................................................................................... 182
13.6 Postponing a Bundle Download ................................................................. 183
13.7 Repairing a Bundle .................................................................................... 183
13.8 Viewing a Bundle’s Properties ................................................................. 183
13.9 Uninstalling a Bundle ............................................................................... 184

## A Install, Uninstall, and Repair MSI Bundle Parameters

A.1 Install Parameters ......................................................................................... 185
  A.1.1 Restart Options ..................................................................................... 186
  A.1.2 Display Options ................................................................................... 186
  A.1.3 Install Options ..................................................................................... 187
  A.1.4 Command Line Parameters ................................................................. 187
A.2 Uninstall Parameters ................................................................................... 187
  A.2.1 Restart Options ..................................................................................... 187
  A.2.2 Display Options ................................................................................... 188
  A.2.3 Command Line Parameters ................................................................. 188
A.3 Repair Parameters ....................................................................................... 188
  A.3.1 Restart Options ..................................................................................... 189
  A.3.2 Display Options ................................................................................... 190
  A.3.3 Repair Options .................................................................................... 190

Contents 7
A.3.4 Command Line Parameters .................................................. 191

B Authentication Hook ............................................................. 193

C How Bundle Versions Affect an Install Action Set ................. 195
  C.1 Triggers that Cause an Install Action Set to Run ............... 195
  C.2 Sample Scenario .................................................................. 195
  C.3 Additional Scenarios .............................................................. 196

D Best Practices .......................................................................... 199
  D.1 Changing the Look and Feel of the Start Menu on a Windows Vista Device ............................................ 199
  D.2 Pinning Applications to the Start Menu on a Windows Vista Device ........................................................... 199
  D.3 Assigning Bundles to a Device or User ................................. 200
  D.4 ZENworks Explorer Folder Naming Convention .................. 200
  D.5 Creating Bundles with Large Content ................................. 200

E Troubleshooting ...................................................................... 201
About This Guide

This ZENworks Software Distribution Reference includes conceptual and task-based information to help you effectively manage software distribution in your ZENworks system. This guide is organized as follows:

- Chapter 1, "Basic Concepts," on page 11
- Chapter 2, "Creating Bundles," on page 21
- Chapter 3, "Viewing the Bundle Information," on page 45
- Chapter 4, "Managing Bundle Groups," on page 53
- Chapter 5, "Managing Folders," on page 59
- Chapter 6, "Actions," on page 61
- Chapter 7, "Understanding Bundle Change Management," on page 127
- Chapter 8, "Managing Bundles," on page 129
- Chapter 9, "Managing Bundle Assignments," on page 149
- Chapter 10, "Managing System Requirements," on page 159
- Chapter 11, "Managing Bundle Settings," on page 167
- Chapter 12, "Managing Action and Action Sets," on page 171
- Chapter 13, "Accessing Bundles on a Managed Device," on page 177
- Appendix A, "Install, Uninstall, and Repair MSI Bundle Parameters," on page 185
- Appendix C, "How Bundle Versions Affect an Install Action Set," on page 195
- Appendix D, "Best Practices," on page 199
- Appendix E, "Troubleshooting," on page 201

Audience

This guide is intended for ZENworks administrators.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation included with this product. Please use the User Comments feature at the bottom of each page of the online documentation.

Additional Documentation

ZENworks is supported by other documentation (in both PDF and HTML formats) that you can use to learn about and implement the product. For additional documentation, see the ZENworks documentation Web site (http://www.novell.com/documentation/zenworks2017).
Basic Concepts

Novell ZENworks provides great flexibility in distributing software. You can distribute applications and individual files, or simply make modifications to existing files on a device.

The following sections contain additional information that is important as you begin creating and managing bundles to distribute software:

- Section 1.1, “Bundles,” on page 11
- Section 1.2, “Bundle Group,” on page 12
- Section 1.3, “Folder,” on page 12
- Section 1.4, “Actions,” on page 12
- Section 1.5, “Action Sets,” on page 13
- Section 1.6, “Assigning Bundles,” on page 17
- Section 1.7, “Packaging Considerations,” on page 17
- Section 1.8, “Content,” on page 19

1.1 Bundles

Bundles are used to configure and manage applications and to distribute software. A bundle consists of all the files, configuration settings, installation instructions, and so forth required to deploy and manage the application or files on a device.

Bundles are categorized into various types based on the device operating system and the functionality required.

You can use ZENworks Control Center or the zman command line utility to create the following bundles:

- **Linux Bundle**: Allows you to configure and manage applications on Linux devices.
- **Linux Dependency Bundle**: Allows the software packages to be available on Linux devices to resolve package dependencies.
- **Macintosh Bundle**: Allows you to configure and manage applications on Macintosh devices.
- **Preboot Bundle**: Allows you to perform a set of tasks on a managed or unmanaged device before the operating system boots up on the device.
- **Windows Bundle**: Allows you to configure and manage applications on Windows devices.
- **iOS Bundle**: Allows you to configure and manage applications on iOS devices.
- **Corporate Bundle**: Allows you to distribute corporate resources such as Wi-Fi settings to mobile devices.

ZENworks also supports the following bundles:

- **Patch Bundle**: Allows you to deploy the patches on Windows devices. This bundle type is created by the ZENworks Patch Management product.
- **Linux Patch Bundle**: Allows you to deploy the patches on Linux devices. This bundle type is created by the ZENworks Patch Management product.
To create a software bundle, you use the Create New Bundle Wizard in ZENworks Control Center or you use the zman command line utility. For more information on using ZENworks Control Center, see Chapter 2, “Creating Bundles,” on page 21 and for information on using the zman command line utility, see “Bundle Commands” in the ZENworks Command Line Utilities Reference.

The sections in this guide provide conceptual and task-based information to help you effectively manage software distribution in your ZENworks system. You can also use the Online Help system for information about creating bundles.

1.2 Bundle Group

A bundle group lets you logically group the bundles. You can add bundles as members of a bundle group. Creating bundle groups eases administration efforts by letting you assign the group, rather than each individual bundle, to devices and users. For more information on bundle groups, see Chapter 4, “Managing Bundle Groups,” on page 53.

1.3 Folder

A folder is an organizational object. You can use folders to structure your bundles and bundle groups into a manageable hierarchy. For example, you might want a folder for each type of bundle (Linux Bundles folder, Windows Bundles folder, Preboot Bundles folder, and so forth). Or, if applications are department-specific, you might want a folder for each department (Accounting Department folder, Payroll Department folder, and so forth).

1.4 Actions

An action is a part of an activity that is carried out during application management. Actions enable you to perform tasks such as copying files, creating directories, and installing files on managed devices. For more information, see “Actions” on page 61.

To Create an action during the bundle creation process: In the Bundle Creation Wizard, select the bundle category based on the action that you want to add to the bundle. For more information, see “Creating Bundles” on page 21.

To Create an action after a bundle is created:

1. On the Bundles page, click the Actions tab
2. Click the relevant action set tab (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot).
3. Click the Add drop-down list, and then select the action you want. For more information, see “Actions” on page 61
1.5 **Action Sets**

Action sets help users manage the application, based on the operations performed during application lifecycle management. You can group actions under various action sets.

The Actions panel displays the action sets available for the selected bundle. You can use the following action sets, based on the bundle type:

- Section 1.5.1, “Distribute,” on page 13
- Section 1.5.2, “Install,” on page 13
- Section 1.5.3, “Launch,” on page 14
- Section 1.5.4, “Repair,” on page 15
- Section 1.5.5, “Uninstall,” on page 15
- Section 1.5.6, “Terminate,” on page 16
- Section 1.5.7, “Preboot,” on page 17

The Distribution, Install, and Launch action sets run in sequence, when a bundle runs. The order of execution is as follows: Distribute, Install and Launch. The Repair, Uninstall, and Terminate action sets are performed based on user requests through bundle options.

### 1.5.1 Distribute

The Distribute action set distributes the content associated with all bundle actions. Within this action set, the default action of Distribute Files distributes the content. The actions that can have content are Install MSI, Install MSP, Install RPM, Install Files, Install Directory, and Run Script.

You can add actions to this action set, in addition to the default action of Distribute Files. The added actions are executed only after the default action is executed.

When you create or modify a bundle, you can click Add on the Distribute page to configure actions to be performed after the distribution of content. Some of the available actions include Launch Executable, Launch Java Application, Prompt User, and Run Script.

The distribution of the content for each assignment is managed through the distribution. For information about the distribution, see Step 5 on page 150.

### 1.5.2 Install

The Install action set installs the application associated with the bundle. When you create or modify a bundle, you can click Add on the Install page to configure actions associated with the installation activities of an application. Some of the frequently used actions associated with installation activities include Install MSI, Install MSP, Install Network MSI, Launch Executable, Run Script, and Install RPM.

Some of the additional actions you can use during installation include Install Files, Install Directory, Registry Edit, Edit INI File, Edit Text File, Start/Stop Service, End Process, and Reboot/Shutdown.

For more information about the Install actions, see Chapter 6, “Actions,” on page 61.
Install Options

The Install Options dialog box allows you to specify how often the install actions associated with the bundle are performed on the managed devices. If the install action set or its options are modified and the bundle is re-published, then when the bundle is installed or launched, the install action set is invoked again, even if it has been set to install only once.

1. When you create or modify a bundle, click Options on the Install page.
2. Select the Install Frequency, based on the number of times you want to execute the Install action set:
   - Install once per device: Executes the Install action set only once on the managed device. Configuration changes in the action set result in re-execution of this action set.
   - Install once per user per device: Executes the Install action sets once for each user on each managed device. This option is applicable only for Windows devices.
   - Install always: Executes the Install action set each time the bundle runs.
3. Select Download Options to specify whether to allow users to postpone performing the Install actions of the bundle and to specify the number of allowed postponements:
   - Always allow postpones: Allows the user to postpone the installation any number of times.
   - Never allow postpones: Prevents the user from postponing the installation.
   - Limit postpones to: Specify the number of times that the user can postpone the installation.

You manage the execution of the Install action set for each assignment through the Install Immediately after Distribution option in the Bundle Distribution dialog box. For information about the distribution, see “Distribution Schedule.” on page 150.

1.5.3 Launch

You use the Launch action set to launch an application that is associated with the bundle. When you create or modify a bundle, you can click Add on the Launch page to configure actions that launch the application. Some of the most frequently used actions associated with the launch activities include Launch Executable, Run Script, Launch Java Application, and Launch Thin Client Application.

Launch Options

The Launch Options dialog box allows you to specify how often the Launch actions associated with the bundle are performed on the managed devices. By default, the Launch actions occur based on the bundle’s or when the user launches the bundle by using its shortcut from the application window, desktop, and so forth. If the launch action set or its options are modified and the bundle is re-published, then when the bundle is launched, the launch action set will be invoked again even if it has been set to launch once.

1. When you create or modify a bundle, click Options on the Launch page to navigate to the Launch Options dialog box.
2. Select the Run once check box to specify the bundle’s Launch actions. If you do not select this option, the Launch actions are performed each time a user launches the application contained in the bundle.

When you select the Run once check box, other Launch options are enabled.
Select the relevant Launch options:

- **For each device**: Select this option to launch the bundle’s actions once on each managed device.

- **For the first user that logs in**: Select this option to launch the bundle’s actions once on each managed device, when the first user logs in to that device. If subsequent users log in to the device, the action set is not launched. When you select this option, the bundle’s icon is removed from the device’s application window, desktop, and so forth.
  
  This option is applicable only for Windows devices.

- **For every user that logs in**: Select this option to launch the bundle’s actions once for every user that logs in to the device.
  
  This option is applicable only for Windows devices.

You manage the execution of the Launch action set for each assignment through the Launch or through the Launch Immediately after Installation option in the bundle distribution. For information about the Distribution, see “Distribution Schedule:” on page 150.

### 1.5.4 Repair

You use the Repair action set to repair the installation of a specific application. When you execute this action set, the default action of Repair Install Actions triggers the execution of the Install and Launch action sets.

You can add actions such as Repair Bundle to this action set in addition to the default Repair Install Actions. The added actions are executed only after the default action is executed.

**NOTE:** The Repair action set has no options.

### 1.5.5 Uninstall

You use the Uninstall action set to un install an application. When you execute this action set, the install operations of the Install action set are reversed by the default uninstall action of Undo Install Actions.

You can add actions such as Uninstall Bundle to this action set, apart from the default action Undo Install Actions. The added actions are executed only after the default action is executed.

**Uninstall Options**

You can enable the user on the managed device to uninstall the application. You specify the details in the Uninstall Options dialog box:

1. When you create or modify a bundle, click Options on the Uninstall Page to navigate to the Uninstall Options dialog box.
2. Select the Enable Uninstall check box to enable the uninstallation of the application from the device.
   
   For example, if a bundle is already installed on a device, you can select Enable Uninstall to uninstall the bundle from the device.

   The other uninstall options are enabled only when you select the Enable Uninstall check box.
3 Select the Uninstall options:
   1. Select one of the following options to specify if the user should be allowed to uninstall or cancel the uninstallation of an application on a device by choosing one of the following:
      - **Allow user to perform uninstall**: Enables users to remove the application from their devices.
      - **Display message to the user before uninstalling the application**: Displays a message to the warn the user that the application will be uninstalled from the device. This option is applicable only on Windows devices.
      - **Allow user to cancel the uninstallation of the application**: Enables the user to cancel the uninstallation of the application.
        You can enable this option only if the **Display message to the user before uninstalling the application** option is enabled. This option is applicable only on Windows device.
   2. Under **Blocked Assignment Options** select Uninstall application to uninstall a blocked application from the device.
   3. Select any additional uninstallation options that you want:
      - **Uninstall application if not used within _days**: Automatically removes the application, if it is not used within the specified number of days (the default period is 30 days).
      - **Ignore chained dependencies**: Enables uninstallation of a dependent application that is referenced by two or more applications. For example, assume that there are three applications - A, B, and C - where C is the dependent application, A installs application C, and application B uninstalls application C. Application C is uninstalled only if Ignore Chained Dependencies is selected.
      - **Do not uninstall application on unassignment**: Prevents an application from being uninstalled after it is unassigned from the device or user.

   The **Undo Install Actions** option is available, only after you select Enable Uninstall in the Uninstall Options dialog box. Click **Undo Install Actions** on the Uninstall page to go to the Undo Install Actions dialog box.

### 1.5.6 Terminate

You use this action set to stop the execution of an application that is running because of actions in the Launch action set. When you execute this action set, the launch operations are reversed by the default Terminate Application action.

You can add actions to this action set, in addition to the default Terminate Application action. The added actions are executed only after the default action.

**Terminate Options**

The Terminate Options dialog box allows you to enable or disable the Terminate action set.

1. When you create or modify a bundle click Options on the Terminate page to go to the Terminate Options dialog box.
2. Select the Enable Terminate check box to terminate the actions of the bundle.

   The Terminate action set is applicable only for Windows bundles. This action set is enabled by default.
The **Terminate Application** option is available only after you select the **Enable Terminate** check box in the Terminate Options dialog box.

1. Click **OK** to undo all operations that are performed in the **Launch** action set.

2. If you want to display a message to users before terminating an application, click **Terminate Application Prompt** on the Terminate page to go to the Terminate Application Prompt dialog box.

3. Specify the information you want users to see before terminating the application, then click **OK**.

### 1.5.7 Preboot

This action set is associated only with Preboot bundles and is not applicable for Windows or Linux bundles. If you select a Preboot bundle, **Preboot** is the only action set available in the action panel.

- When you create or modify a bundle, click **Add** on the Preboot page to configure the actions associated with the Preboot bundle.

Some of the frequently used actions associated with the Preboot action set include AutoYaST Bundle, DellDTK Configuration, Imaging Script, Kickstart, Linked Application Bundle, Multicast Image Set, Third Party Image, and ZENworks Image. For more information about the Preboot actions, see “Preboot Actions” in the *Preboot Services and Imaging Reference* guide.

### 1.6 Assigning Bundles

You can assign bundles to users and devices. When you assign a bundle to users, the bundle is available to all assigned users regardless of the device they log on to. When you assign a bundle to a device, the bundle is available to all users who log in to the assigned device.

For more information on assigning bundles and bundle groups to users and devices, see Chapter 9, “Managing Bundle Assignments,” on page 149.

### 1.7 Packaging Considerations

Because of the way that ZENworks handles bundle packaging, be aware of the following considerations when you create bundles:

- Section 1.7.1, “Time Required for Packaging;” on page 17
- Section 1.7.2, “Space Required for Packaging;” on page 18

#### 1.7.1 Time Required for Packaging:

Large MSI and MSP bundles might take several hours to package before they are available on ZENworks content servers (ZENworks Servers and Content Distribution Points) in your Management Zone.

Large application files are compressed and encrypted, resulting in smaller bundles that reduce bandwidth during transmission and provide greater security during transmission and on the content server. The encrypted bundles cannot be removed from the content server and inappropriately used.
1.7.2 **Space Required for Packaging:**

Creating bundles that contain content temporarily requires up to twice the amount of disk space as the original files. The bundle creation process uploads copies of the original files from the local machine to a temporary directory on the ZENworks content server. The process then packages those files as encrypted, compressed ZENworks content files. After the ZENworks content files are created, the original uploaded files are automatically deleted.

If you are using ZENworks Control Center to create the bundle, and if you do not log out correctly (for example, if you close your browser before completing the Create New Bundle Wizard, you browse to somewhere else, or your machine crashes), the temporary directory is automatically cleared after the session time-out is reached. The default time out is 30 minutes.

In some circumstances (for example, if the ZENworks Server goes down during processing), the bundle creation process is unable to delete these temporary files. You can manually delete them as necessary.

Depending on the operating system and the utility used to create the bundle, the temporary files are located in the following directories:

**Table 1-1 Location of Temporary Files for Windows**

<table>
<thead>
<tr>
<th>Utility Used to Create the Bundle</th>
<th>Location of the Temporary Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZENworks Control Center</td>
<td>zenworks_home\share\tomcat\temp</td>
</tr>
<tr>
<td>zman (command line utility)</td>
<td>zenworks_home\work\content-repo\tmp</td>
</tr>
<tr>
<td>ZENworks Migration Utility</td>
<td>zenworks_home\work\collection\datamodel</td>
</tr>
</tbody>
</table>

**Table 1-2 Location of Temporary Files for Linux**

<table>
<thead>
<tr>
<th>Utility Used to Create Bundle</th>
<th>Location of Temporary Files</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZENworks Control Center</td>
<td>/var/tmp/</td>
</tr>
<tr>
<td>zman (command line utility)</td>
<td>/var/opt/novell/zenworks/content-repo/tmp/</td>
</tr>
<tr>
<td>ZENworks Migration Utility</td>
<td>/var/opt/novell/zenworks/collection/datamodel/</td>
</tr>
</tbody>
</table>

If the space on the temporary location is insufficient, you can specify a different disk drive to be the location of temporary files.

For more information on changing the location of temporary files on a Windows device, see “Changing the Location of the Temporary Location on a Windows Server” in the ZENworks Primary Server and Satellite Reference.

For more information on changing the location of temporary files on a Linux device, see “Changing the Location of the Temporary Location on a Linux Server” in the ZENworks Primary Server and Satellite Reference.
1.8 Content

When you create bundles containing content, the content is copied to content servers (ZENworks Servers or Content Distribution Points), replicated to other content servers, and delivered to managed devices.

- Section 1.8.1, “Content Replication,” on page 19
- Section 1.8.2, “Content Delivery,” on page 19

1.8.1 Content Replication

Content replication lets you determine how often content (bundle and policy files) is updated on the ZENworks (primary) Servers and Content Distribution Points. ZENworks Servers and Content Distribution Points are collectively referred to as content servers when discussing them in their roles of hosting content.

When a bundle or policy that contains content is added to the Management Zone, the ZENworks database is updated to reflect the addition of the content. Content servers are responsible for periodically reading the ZENworks database to discover new content. Each content server that does not have the content then retrieves the content from the server where it resides.

If content has been removed from the Management Zone, each content server also removes obsolete content during the update.

Content replication for a bundle can be configured through the Primary Server replication settings or Satellite Server replication settings. For more information on the settings, see Chapter 11, “Managing Bundle Settings,” on page 167.

For more information, see “Content Replication” in the ZENworks Primary Server and Satellite Reference.

1.8.2 Content Delivery

Content delivery, or distribution, refers to the process of transferring bundle and policy content from a content server (ZENworks Server or Content Distribution Point) to a managed device.

There are a variety of settings you can use to determine how content is delivered to managed devices:

- You can set up Closest Server rules that determine from which content server a managed device downloads its content.
- You can set times, referred to as delivery blackout dates, when content cannot be downloaded by managed devices.
- You can decide how often you want managed devices to look for new content to download.

For information about performing these tasks, see “Content Delivery” in the ZENworks Primary Server and Satellite Reference.
Creating Bundles

A bundle consists of all the files, configuration settings, installation instructions, and so forth required to deploy and manage the application or files on a device.

Novell ZENworks lets you create bundles by using ZENworks Control Center or by using the zman command line utility.

The following sections contain step-by-step instructions about creating bundles by using ZENworks Control Center:

- Section 2.1, “Installing ZCC Helper,” on page 21
- Section 2.2, “Creating Linux Bundles,” on page 22
- Section 2.3, “Creating Macintosh Bundles,” on page 22
- Section 2.4, “Creating Preboot Bundles,” on page 26
- Section 2.5, “Creating Windows Bundles,” on page 26
- Section 2.7, “Creating iOS Bundles,” on page 42

The following section explains how to create bundles by using the zman command line utility:

- Section 2.6, “Creating Bundles by Using the zman Command Line Utility,” on page 37

2.1 Installing ZCC Helper

ZENworks ZCC Helper is a standalone application which provides a browser independent way to perform various actions such as:

- On Windows:
  - Icon Extractor
  - Remote Management
  - Uploading Imaging Files
  - Windows Group Policy
  - File and Directory Upload

- On Linux:
  - Remote Management
  - File and Directory Upload

To install ZCC Helper:

1. In ZENworks Control Center, click Configuration.
2. In the left navigation pane, click Download ZENworks Tools.
3. In the left navigation pane of the ZENworks Download page, click Administrative Tools.
4. Click the Configuration tab.
5. Depending on the device architecture (32-bit or 64-bit), download the appropriate RPM or MSI. `novell-zenworks-zcc-helper-<version>.msi` for Windows devices
Creating Bundles

novell-zenworks-zcc-helper-<version>.rpm for Linux devices

6 Save and install the ZCC Helper.

NOTE

- Windows:
  - For 64-bit operating system, no need to install the JRE, as JRE is included with ZCC Helper.
  - For 32-bit operating system, the 3rd party JRE (8.x or higher version) should be manually installed.

- Linux:
  - For 64-bit operating system, no need to install the JRE, as JRE is included with ZCC Helper. However, on 64-bit SLES 11 devices, the 3rd party JRE (8.x or higher version) should be installed and then set the ZCC_JAVA_HOME environment variable.
  - For 32-bit operating system, the 3rd party JRE (8.x or higher version) should be manually installed, and then set the ZCC_JAVA_HOME environment variable.

2.2 Creating Linux Bundles

You can create two types of bundles on Linux devices - Linux bundles and Linux Dependency bundles. Linux bundles allow you to configure, manage applications, and store the package updates on Linux devices. Linux Dependency bundles allow you to distribute software to Linux devices and provide the dependent packages.

For more information on how to create these bundles, see “Using Bundles for Linux Devices” in the ZENworks Linux Package Management Reference.

2.3 Creating Macintosh Bundles

Macintosh bundles allow you to configure, manage applications, and store the package updates on Macintosh devices.

You can use ZENworks Control Center or the zman command line utility to create bundles. The following procedure explains how to create a bundle using ZENworks Control Center. If you prefer the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

If you are creating Macintosh bundle on a windows device, then you need to install ZCC Helper.

To create a Macintosh bundle:

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
3. Select Macintosh Bundle, then click Next to display the Select Bundle Category page.
4. Select the desired bundle category:
   - Empty Bundle: A bundle with no initial tasks. This bundle category is useful to quickly create a bundle without performing all of tasks in the Create New Bundle Wizard. After you create the empty bundle, you can edit its details to add assignments, actions, and so forth, at a later time.
   - Copy Directory: Copies a source directory to the specified location on the managed device.
   - Copy Files: Copies files to the specified location on the managed device.
**Create/Delete Directory:** Creates or Deletes a directory on the managed device.

**Install Directory:** Uploads the contents of a directory and its sub-directories to the ZENworks content system and then installs them to the specified destination path on the managed device. By default, the content is replicated to all primary servers.

**Install Files:** Uploads the files to the ZENworks content system and then installs them to the specified destination path on the managed device. By default, the content is replicated to all primary servers.

5 Click Next to display the Define Details page, then fill in the fields:

- **Bundle Name:** Provide a name for the bundle. The bundle name must be different than the name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name you provide displays in ZENworks Control Center and the ZENworks Agent (on managed devices).

For more information, see “Naming Conventions in ZENworks Control Center” in the *ZENworks Control Center Reference*.

- **Folder:** Type the name or browse to and select the ZENworks Control Center folder where you want the bundle to reside. The default path is the context from where the bundle creation wizard is invoked. For example, if you choose to create a new bundle from the bundles page, the default folder path is `/bundles`. However, if you choose to create a bundle from with a bundle folder named `folder1`, the default folder path is `/bundles/folder1`. You can also create additional folders to organize your bundles.

- **Icon:** ZENworks Configuration Management lets you select an icon that users see during installation of a particular bundle. This icon applies only to the icon displayed by ZENworks Agent on the managed device. ZCC uses default icons to represent the different bundles.

Before an icon can be selected, you need to install ZCC Helper.

To select an icon, click ![icon](image), allow browser to launch ZCC Helper, and then browse and select the icon you want to display on managed devices.

If the file contains multiple icons, using ZCC Helper you can select the required icon.

If you do not specify an icon, a default icon is used.

**NOTE:** The icon (.ico file) uploaded while creating a Linux or a Macintosh bundle using a Windows device is not displayed on the agent, instead the default icon is displayed.

- **Description:** Provide a short description of the bundle’s contents. This description displays in ZENworks Control Center and in the ZENworks Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in Step 4:

- **Empty Bundle:** Continue with Step 10 on page 26.
- **Create/Delete Directory:** Continue with Step 7 on page 23.
- **Install Directory:** Continue with Step 8 on page 24.
- **Install Files:** Continue with Step 9 on page 25.

7 (Conditional) If you are creating a Create/Delete Directory bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:
Creating Bundles

8 (Conditional) If you are creating an Install Directory bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Action Type field</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Create Directory</strong>: Creates a directory on the managed device when the action is performed.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Delete Directory</strong>: Deletes a directory on the managed device when the action is performed.</td>
</tr>
<tr>
<td>Select Directory page &gt; Directory Name field</td>
<td>Specify the complete path of the directory you want to create or delete on the managed device. This path must be resolved by the device on which the bundle is run.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Source Directory field</td>
<td>Click 📦, and allow browser to launch ZCC Helper. Select Folder dialog box is displayed, browse and select the file to upload.</td>
</tr>
<tr>
<td></td>
<td>The <strong>Status</strong> field displays each file’s upload status.</td>
</tr>
<tr>
<td></td>
<td>Select the Upload all files within the source directory as a single package option to enable all the files within the specified source directory to be uploaded as a single content.</td>
</tr>
<tr>
<td></td>
<td>If ZCC Helper is not installed on this device, it must be installed before you can browse to and upload files.</td>
</tr>
<tr>
<td>Select Directory page &gt; Upload Files As field</td>
<td>Specifies whether the content has been uploaded as a single content or multiple contents to the ZENworks content repository.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Upload all files within the source directory as a single package</strong> option in the Select Directory dialog box is not selected, then the files are uploaded by packaging in to multiple contents and the value of <strong>Upload Files As</strong> option is displayed as <strong>Multiple Content</strong>.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Upload all files within the source directory as a single package</strong> option in the Select Directory dialog box is selected, then the files are uploaded by packaging in to single content and the value of <strong>Upload Files As</strong> option is displayed as <strong>Single Content</strong>.</td>
</tr>
<tr>
<td>Select Directory page &gt; Destination Directory field</td>
<td>Specify the destination path on the device where you want to install the directory.</td>
</tr>
<tr>
<td>Select Directory page &gt; Permissions field</td>
<td>You can configure permissions and set the access for the directory that you have installed.</td>
</tr>
<tr>
<td></td>
<td><strong>Mode</strong>: Select this option and enter a 3 digit octal number to specify the permissions for owner, group, and others.</td>
</tr>
<tr>
<td></td>
<td><strong>Owner</strong>: Select this option and set the access for Owner, Group, and Others.</td>
</tr>
</tbody>
</table>
Creating Bundles

9 (Conditional) If you are creating an Install Files bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Ownership field</td>
<td>You can configure permissions and set the access for the directory that you have installed.</td>
</tr>
<tr>
<td></td>
<td><strong>Root:</strong> Select this option to provide the ownership for the root user.</td>
</tr>
<tr>
<td></td>
<td><strong>User:</strong> Select this option to provide the ownership for a particular user. You can also specify the group of the user.</td>
</tr>
<tr>
<td>Select Directory page &gt; Copy Option</td>
<td>Select a copy option from the list. For more information on the options, click Help.</td>
</tr>
<tr>
<td>Select Files page &gt; File field</td>
<td>Click Add to display the Select File dialog box, specify the files you want to install on the device, then click Open. Repeat this step as many times as necessary to copy the desired files.</td>
</tr>
<tr>
<td></td>
<td>Click OK to upload the files to the server. The File option lists all the uploaded files, the size of the files, and how the content is packaged.</td>
</tr>
<tr>
<td></td>
<td>If ZCC Helper is not installed on this device, you must install it before you can browse for file paths.</td>
</tr>
<tr>
<td>Select Files page &gt; Destination Directory field</td>
<td>Specify the destination directory on the device in which you want to install the file.</td>
</tr>
<tr>
<td>Select Directory page &gt; Permissions field</td>
<td>You can configure permissions and set the access for the directory that you have installed.</td>
</tr>
<tr>
<td></td>
<td><strong>Mode:</strong> Select this option and enter a 3 digit octal number to specify the permissions for owner, group, and others.</td>
</tr>
<tr>
<td></td>
<td><strong>Owner:</strong> Select this option and set the access for Owner, Group, and Others.</td>
</tr>
<tr>
<td>Select Directory page &gt; Ownership field</td>
<td>You can configure permissions and set the access for the directory that you have installed.</td>
</tr>
<tr>
<td></td>
<td><strong>Root:</strong> Select this option to provide the ownership for the root user.</td>
</tr>
<tr>
<td></td>
<td><strong>User:</strong> Select this option to provide the ownership for a particular user. You can also specify the group of the user.</td>
</tr>
<tr>
<td>Select Files page &gt; Unpack field</td>
<td>Select this option to indicate that the files that are compressed in GZIP, BZIP2, or ZIP formats should be decompressed and extracted on to the device where you want to install them.</td>
</tr>
<tr>
<td></td>
<td>By default, ZipperUtil.sh is used to unpack the files. If you want to unpack the files using Java API, in the xplatzmd.properties file, the value of install-file-unpack-with-java-first should be set to True.</td>
</tr>
<tr>
<td>Select Files page &gt; Delete After Unpack field</td>
<td>Select this option to indicate that the GZIP, BZIP2 or ZIP files should be deleted after extracting them on to the device where you want to install them.</td>
</tr>
</tbody>
</table>
Creating Bundles

Review the information on the Summary page, making any changes to the bundle settings by using the Back button as necessary.

Skip to Step 13 to create the published version of the bundle.

(Conditional) Select the Create as Sandbox option to create a sandbox-only version of the bundle.

A sandbox-only version of a bundle enables you to test the bundle on your device before actually deploying it. For more information on a sandbox-only bundle, see Chapter 7, “Understanding Bundle Change Management,” on page 127.

(Conditional) Select the Define Additional Properties option to display the bundle’s Action page after the wizard completes. You can use the various tabs to edit the bundle’s assignments, system requirements, actions, settings, and content replication settings.

Click Finish to create the bundle as configured per settings on the Summary page.

When you click Finish, the bundle is created but it does not have users or devices assigned, so group membership. At some point in the future, you need to configure additional options for the bundle by continuing with Section 9.1, “Assigning Existing Bundles to Devices,” on page 149 or Section 9.2, “Assigning Existing Bundles to Users,” on page 152.

For information on the viewing the bundle information, see Chapter 3, “Viewing the Bundle Information,” on page 45.

2.4 Creating Preboot Bundles

Preboot bundles let you performs operations before the operating system boots. The various Imaging bundle types let you install images on one or more devices, or run ZENworks scripts containing any commands that you can issue from the imaging bash prompt.

For more information about Imaging bundles, see the ZENworks Preboot Services and Imaging Reference.

2.5 Creating Windows Bundles

A Windows bundle lets you distribute a Microsoft* Windows Installer (MSI) package, Microsoft Windows Software Patch (MSP) package, thin-client application, or other Windows-based applications to a Windows device.

You can use ZENworks Control Center or the zman command line utility to create bundles. The following procedure explains how to create a bundle using ZENworks Control Center. If you prefer the zman command line utility, see “Bundle Commands” in “ZENworks Command Line Utilities”.

To create a Windows bundle:

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundle list, click New, then click Bundle to display the Select Bundle Type page.
3. Select Windows Bundle, then click Next to display the Select Bundle Category page.
4. Select the desired bundle category.
**Empty Bundle:** A bundle with no initial tasks. This bundle category is useful to quickly create a bundle without performing all of tasks in the Create New Bundle Wizard. After you create the empty bundle, you can edit its details to add assignments, actions, and so forth, at a later time.

**Copy Directory:** Copies a source directory to the specified location on the managed device.

**Copy Files:** Copies files to the specified location on the managed device.

**Create/Delete Directory:** Creates or Deletes a directory on the managed device.

**Install Directory:** Uploads the contents of a directory and its sub-directories to the ZENworks content system and then installs them to the specified destination path on the managed device. By default, the content is replicated to all primary servers.

**Install Files:** Uploads the files to the ZENworks content system and then installs them to the specified destination path on the managed device. By default, the content is replicated to all primary servers.

**MSI Application:** An application that is packaged as a .msi file so that it can be installed by the Microsoft Windows Installer program.

For important information about creating MSI Application bundles, see Section 1.7, “Packaging Considerations,” on page 17.

If you have a non-MSI application that is more complex than this, we recommend that you use ZENworks Software Packaging, powered by AdminStudio ZENworks Edition, to create an MSI package for the application and then use the MSI Application option to create a bundle. For more information on installing AdminStudio, see AdminStudio ZENworks Edition Installation Guide.

**MSP Application:** An application patch that is packaged as a .msp file so that it can be applied by the Microsoft Windows Installer program.

For important information about creating MSP Application bundles, see Section 1.7, “Packaging Considerations,” on page 17.

**Simple Application:** An example of a Simple Application would be launching Windows Note pad. Typically, Simple Applications requires ZENworks Agent to copy a few files to the workstation or make a few changes to the workstations registry, INI files, environment variables, and so forth.

If you have a non-MSI application that is more complex than this, we recommend that you use ZENworks Software Packaging, powered by AdminStudio ZENworks Edition, to create an MSI package for the application and then use the MSI Application option to create a bundle. For more information on installing AdminStudio, see AdminStudio ZENworks Edition Installation Guide.

**Thin-Client Application:** An application, running on a terminal server, that is accessed through a terminal server client session (either RDP or ICA).

**Web Application:** An application that is launched by using a URL in a Web browser.

5. Click **Next** to display the Define Details page, then fill in the fields:

**Bundle Name:** Provide a name for the bundle. The bundle name must be different than the name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name you provide displays in ZENworks Control Center and the ZENworks Agent (on managed devices).

For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.

**Folder:** Type the name or browse to and select the ZENworks Control Center folder where you want the bundle to reside. The default path is the context from where the bundle creation wizard is invoked. For example, if you choose to create a new bundle from the bundles page, the default folder path is /bundles. However, if you choose to create a bundle from with a bundle folder named folder1, the default folder path is /bundles/folder1. You can also create additional folders to organize your bundles.
**Icon:** ZENworks Configuration Management lets you select an icon that users see during installation of a particular bundle. This icon applies only to the icon displayed by ZENworks Agent on the managed device. ZCC uses default icons to represent the different bundles.

Before an icon can be selected, you need to install ZCC Helper.

To select an icon, click , allow browser to launch ZCC Helper, and then browse and select the icon you want to display on managed devices.

If the file contains multiple icons, using ZCC Helper you can select the required icon.

If you do not specify an icon, a default icon is used.

**NOTE:** All icons for bundles need to have a color depth of 256. True color depth for icons is not supported.

**Description:** Provide a short description of the bundle's contents. This description displays in ZENworks Control Center and in the ZENworks Agent.

6 Click Next, then skip to the appropriate step, depending on which bundle category you chose in Step 4:

- **Empty Bundle:** Continue with Step 17 on page 36.
- **Copy Directory:** Continue with Step 7 on page 28.
- **Copy Files:** Continue with Step 8 on page 29.
- **Create/Delete Directory:** Continue with Step 9 on page 29.
- **Install Directory:** Continue with Step 10 on page 30.
- **Install Files:** Continue with Step 11 on page 31.
- **MSI Application:** Continue with Step 12 on page 32.
- **MSP Application:** Skip to Step 13 on page 34.
- **Simple Application:** Skip to Step 14 on page 34.
- **Thin Client Application:** Skip to Step 15 on page 35.
- **Web Application:** Skip to Step 16 on page 36.

7 (Conditional) If you are creating an Copy Directory bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:
<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Source Directory field</td>
<td>If you have not installed ZCC Helper on this device, you must do so before you can browse for a directory. Click <strong>Browse</strong>, and allow browser to launch ZCC Helper. The Select Folder dialog box is displayed, click browse and select the directory to copy.</td>
</tr>
<tr>
<td>Select Directory page &gt; Destination Directory field</td>
<td>Specify the destination path on the device where you want to copy the directory.</td>
</tr>
<tr>
<td>Select Directory page &gt; Copy Option</td>
<td>Select a copy option from the list. For more information on the options, click <strong>Help</strong>.</td>
</tr>
<tr>
<td>Select Directory page &gt; Attributes field</td>
<td>Select one or more of the following attributes: <strong>Hidden</strong>: Select the <strong>Hidden</strong> check box to specify that the directory is hidden after being copied. <strong>Read-only</strong>: Select the <strong>Read-only</strong> check box to specify that the directory is read-only after being copied.</td>
</tr>
</tbody>
</table>

8 (Conditional) If you are creating an Copy Files bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36. Click **Help** for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Files page &gt; File field</td>
<td>Click <strong>Add</strong>, allow browser to launch ZCC Helper. The Select Files dialog box is displayed, specify the files you want to copy to the device, then click <strong>OK</strong>. Repeat this step as many times as necessary to copy the desired files. If the ZCC Helper is not installed on this device, you must install it before you can browse for file paths.</td>
</tr>
<tr>
<td>Select Files page &gt; Destination Directory field</td>
<td>Specify the destination directory on the device in which you want to copy the file.</td>
</tr>
<tr>
<td>Select Files page &gt; Create Shortcuts for Source Files</td>
<td>Select the <strong>Create Shortcuts for Source Files</strong> option to create shortcut icons for the source file on the destination directory. The source files are not copied to the destination directory.</td>
</tr>
<tr>
<td>Select Files page &gt; Copy Option</td>
<td>Select a copy option from the list. For more information on the options, click <strong>Help</strong>.</td>
</tr>
<tr>
<td>Select Files page &gt; Attributes field</td>
<td>Select one or more of the following attributes: <strong>Hidden</strong>: Select the <strong>Hidden</strong> check box to specify that the file is hidden after being copied. <strong>Read-only</strong>: Select the <strong>Read-only</strong> check box to specify that the file is read-only after being copied.</td>
</tr>
</tbody>
</table>

9 (Conditional) If you are creating an Create/Delete Directory bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.
Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Action Type field</td>
<td>Select one of the following:</td>
</tr>
<tr>
<td></td>
<td>• Create Directory: Creates a directory on the managed device when the action is performed.</td>
</tr>
<tr>
<td></td>
<td>• Delete Directory: Deletes a directory on the managed device when the action is performed.</td>
</tr>
<tr>
<td>Select Directory page &gt; Directory Name field</td>
<td>Specify the complete path of the directory you want to create or delete on the managed device. This path must be resolved by the device on which the bundle is run.</td>
</tr>
</tbody>
</table>

10 (Conditional) If you are creating an Install Directory bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Directory page &gt; Source Directory field</td>
<td>Click , and allow browser to launch ZCC Helper. The Select Directory dialog box is displayed, click browse and select the file to upload. By default, the content is encrypted and compressed before it is distributed to assigned devices. However, If you do not want to compress or encrypt the content, select the Do not compress or encrypt uploaded content option. The Status field displays each file’s upload status. Select the Upload all files within the source directory as a single package option to enable all the files within the specified source directory to be uploaded as a single content. If ZCC Helper is not installed on this device, it must be installed before you can browse to and upload files to be copied.</td>
</tr>
<tr>
<td>Select Directory page &gt; Upload Files As field</td>
<td>Specifies whether the content has been uploaded as a single content or multiple contents to the ZENworks content repository. If the Upload all files within the source directory as a single package option in the Select Directory dialog box is not selected, then the files are uploaded by packaging in to multiple contents and the value of Upload Files As option is displayed as Multiple Content. If the Upload all files within the source directory as a single package option in the Select Directory dialog box is selected, then the files are uploaded by packaging in to single content and the value of Upload Files As option is displayed as Single Content.</td>
</tr>
</tbody>
</table>
### Wizard Page and Field Details

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
</table>
| Select Directory page > Packaging field | Specifies how the content is packaged before it is distributed to assigned devices.  
If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is not selected, the value of Packaging option is initially displayed as Auto as the content is in the process of being encrypted and compressed. After the content has been encrypted and compressed, the value of Packaging option changes to Compressed, Encrypted.  
If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is selected, the value of Packaging option is displayed as None because the content is neither compressed nor encrypted. |
| Select Directory page > Destination Directory field | Specify the destination path on the device where you want to install the directory. |
| Select Directory page > Copy Option | Select a copy option from the list. For more information on the options, click Help. |
| Select Directory page > Attributes field | Select one or more of the following attributes:  
Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.  
Read-only: Select the Read-only check box to specify that the directory is read-only after being copied. |

### 11 (Conditional) If you are creating an Install Files bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
</table>
| Select Files page > File field | Click Add, allow browser to launch ZCC Helper. The Select Files dialog box is displayed, specify the files you want to install on the device, then click Upload. Repeat this step as many times as necessary to copy the desired files.  
By default, the content is encrypted and compressed. If you do not want to compress or encrypt the content, select the Do not compress or encrypt uploaded content option.  
Click OK to upload the files to the server. The File option lists all the uploaded files, the size of the files, and how the content is packaged.  
If ZCC Helper is not installed on this device, you must install it before you can browse for file paths. |
| Select Files page > Destination Directory field | Specify the destination directory on the device in which you want to install the file. |
| Select Files page > Copy Option | Select a copy option from the list. For more information on the options, click Help. |
Creating Bundles

(Conditional) If you are creating an MSI Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
</table>
| Select Files page > Attributes field | Select one or more of the following attributes:  
  **Hidden**: Select the Hidden check box to specify that the file is hidden after being copied.  
  **Read-only**: Select the Read-only check box to specify that the file is read-only after being copied. |
| Select .msi File page > Upload .msi file for normal install field | Use this option if you want the .msi file copied to the ZENworks Server and then distributed from the ZENworks Server to assigned users and devices. This is referred to a normal install because ZENworks Agent copies the .msi file to the managed device’s local drive and then the Microsoft Windows Installer program installs the application from the local .msi file.  
  Click ![image](image.png) allow browser to launch ZCC Helper. The Select .msi File dialog box is displayed. Click Browse to select the .msi file to upload.  
  Select the Include all files in and below the directory of this file option to include all the supporting files that are within the directory containing the .msi file and the subdirectories within it.  
  **NOTE**: By default, ZENworks Control Center has a 30-minute timeout value. If you leave ZENworks Control Center idle on your computer for more than 30 minutes, you are prompted to log in again before continuing. Because the upload process can take considerable time for a large .msi file, the default timeout value does not apply for this page. |
| Select .msi File page > Enter UNC path of .msi file for network install field | Use this option if you want the Microsoft Windows Installer program to install the application from the .msi file on a network location. You must specify the complete path to the .msi file to use as the source file during distribution to the workstation.  
  You can use a mapped drive or UNC path. If you use a drive mapping, you must ensure that all workstations have the same drive mapped to the source location. For this reason, we recommend that you specify a UNC path.  
  After you create the MSI bundle, you cannot change the .msi filename; however, you can change the path to the .msi file. If you change the .msi filename, the installation fails. |
<p>| Select .msi File page &gt; Install Parameters field | Click <img src="image.png" alt="image" /> to display the Install Parameters dialog box, then specify the desired parameters. For more information, click the Help button or see Section A.1, “Install Parameters,” on page 185. |
| Select .msi File page &gt; Uninstall Parameters field | Click <img src="image.png" alt="image" /> to display the Uninstall Parameters dialog box, then specify the desired parameters. For more information, click the Help button or see Section A.2, “Uninstall Parameters,” on page 187. |</p>
<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select .msi File page &gt; Repair Parameters field</td>
<td>Click <img src="image.png" alt="image" /> to display the Repair Parameters dialog box, then specify the desired parameters. For more information, click the <em>Help</em> button or see Section A.3, “Repair Parameters,” on page 188.</td>
</tr>
<tr>
<td>Select .msi File page &gt; MSI Properties field</td>
<td>The MSI package contains the property values that were defined during the administrative installation of the application. These property values determine the way the Microsoft Windows Installer installs the application to the workstation. In some cases, you might want to change one or more of the property values. For example, a property value might define the default location for a user's work files. By adding the property to the list and changing the property's value, you can override the default location defined in the MSI package.</td>
</tr>
<tr>
<td>If necessary, you can add public properties that were not included in the MSI package. When doing so, you should be careful to add only those properties that are valid for the package.</td>
<td></td>
</tr>
<tr>
<td>To override a property value, you change the property value and add the property to the Properties list so that Application Launcher knows to use that property value rather than the one defined in the MSI package. To do so, click <em>Add</em> to display the <strong>MSI Properties</strong> dialog box. In the <em>Name</em> field, select the property whose value you want to override, specify the new value in the <em>Value</em> field, then click <em>OK</em> to add the property to the <strong>MSI Properties</strong> list.</td>
<td></td>
</tr>
<tr>
<td>To modify a property that is in the <strong>MSI Properties</strong> list, select the property, click <em>Edit</em>, modify the value data, then click <em>OK</em>.</td>
<td></td>
</tr>
<tr>
<td>To remove a property from the <strong>MSI Properties</strong> list, select the property, then click <em>Remove</em>. Deleting the property causes future installations of the application to use the property value defined in the MSI package.</td>
<td></td>
</tr>
<tr>
<td>Select .msi File page &gt; Select Transforms File field</td>
<td>Click <em>Add</em> to browse to and select the desired . You can upload the or you can specify its location.</td>
</tr>
<tr>
<td>Different groups within an organization often use the same application, but that does not mean they require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 10 different feature sets or other alterations for the same application, you can deploy the same MSI package to all 10 user groups, but with a different (MST) applied for each group.</td>
<td></td>
</tr>
<tr>
<td>A is a collection of changes applied to an MSI installation. It contains all modification information, such as whether features are installed; how they are installed; which files, shortcuts, and registry entries are included; and Add/Remove Programs applet information.</td>
<td></td>
</tr>
<tr>
<td>If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create and manage transforms</td>
<td></td>
</tr>
</tbody>
</table>
Creating Bundles

If you are creating an MSP Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36. Click Help for information about each page or refer to the following table:

13 If you are creating an MSP Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
</table>
| Select Command page > Executable to run field | The Select Command page lets you specify an optional executable to run after the .msi file installs. Click Browse to browse for and select the executable to run. If the executable is installed in the Program Files directory on the managed device, you must use macros as follows:  
  * On 32-bit managed device: ${ProgramFiles}\filename.  
  * On 64-bit managed device: ${ProgramFiles32}\filename.  
  If you have not installed ZCC Helper on this device, you must do so before you can browse to and upload files. |

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select .msp File page &gt; Upload .msp file for normal install field</td>
<td>Use this option if you want the .msp file copied to the ZENworks Server and then distributed from the ZENworks Server to assigned users and devices. This is referred to as a normal install because ZENworks Agent copies the .msp file to the managed device’s local drive and then it is installed from the local .msp file.</td>
</tr>
<tr>
<td>Select .msp File page &gt; Enter UNC path of .msp file for network install field</td>
<td>Use this option if you want to install from the .msp file on a network location. You must specify the complete path to the .msp file to use as the source file during distribution to the workstation. You can use a mapped drive or UNC path. If you use a drive mapping, you must ensure that all workstations have the same drive mapped to the source location. For this reason, we recommend that you specify a UNC path. After you create the MSP bundle, you cannot change the .msp filename; however, you can change the path to the .msp file. If you change the .msp filename, the installation fails.</td>
</tr>
<tr>
<td>Select .msp File page &gt; Command Line Parameters field</td>
<td>After you select the .msp file, the Command Line Parameters field is automatically populated, for example /p patch_package /qn where /p designates a patch file, patch_package specifies the .msp file, and /qn specifies an installation with no user interface (silent installation). To install a .msp file, you should normally use the /qn option. You can, however, specify additional options. For more information, see the MSDN Web site (<a href="http://msdn2.microsoft.com/en-us/library/aa372866.aspx">http://msdn2.microsoft.com/en-us/library/aa372866.aspx</a>).</td>
</tr>
</tbody>
</table>

14 If you are creating Simple Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:
If you are creating a Thin Client Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enter the Command to Run page &gt; Command field</td>
<td>Specify the command to launch the application. You should include the full path to the executable in case the executable is not in the device’s search path. This path, whether the application is on the device’s local drive or a network resource, must be relative to the device. For example, if the executable file is on the device’s local drive, you would specify something like <code>c:\winnt\notepad.exe</code>. If the executable file is on a network resource, you would specify something like <code>j:\apps\notepad.exe</code> (if all users will have J: mapped to the location) or <code>\server1\vol1\apps\notepad.exe</code>.</td>
</tr>
<tr>
<td>Enter the Command to Run page &gt; Command Line Parameters field</td>
<td>Specify any command line parameters that need to be passed to the executable. ZENworks Agent passes the parameters exactly as they are specified. Therefore, the parameter syntax you use must exactly match the syntax the executable requires. For example, if <code>word.exe</code> has a <code>/f=filepath</code> parameter that requires paths with spaces to be enclosed in quotation marks, you would specify the following: <code>/f=&quot;c:\my docs\sample.doc&quot;</code></td>
</tr>
<tr>
<td>Enter the Command to Run page &gt; Working Directory field</td>
<td>Specify the path to the directory you want the application to use for its working files.</td>
</tr>
</tbody>
</table>

15 If you are creating a Thin Client Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:
Creating Bundles

16 If you are creating a Web Application bundle, follow the wizard prompts until you reach the Summary page, then skip to Step 17 on page 36.

Click Help for information about each page or refer to the following table:

<table>
<thead>
<tr>
<th>Wizard Page and Field</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Server Domain field</td>
<td>If the terminal server is part of a Windows NT* domain or an Active Directory* domain, enter the domain name. If the user’s name and password in the domain matches the user name and password in Novell eDirectory, the user is not prompted to log in to the terminal server when launching the application.</td>
</tr>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Application Path field</td>
<td>Specify the path to the application’s executable file from the perspective of the terminal server.</td>
</tr>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Application Working Directory field</td>
<td>Specify the path to the directory you want the application to use for its working files.</td>
</tr>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Color Depth field</td>
<td>Select the number of colors for the RDP client session. You can select 256 Colors, High Color (15 bits), High Color (16 bits), or True Color (24 bits). The default is True Color (24 bits).</td>
</tr>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Screen Size field</td>
<td>If you want the RDP client session to use the entire desktop area, select Operate in full screen mode. Otherwise, select Use specified screen size and manually set the width and height (in pixels).</td>
</tr>
<tr>
<td>Configure Thin Client Details page &gt; RDP Session: Advanced Settings for redirection field</td>
<td>Select the settings such as drivers, printers, serial ports, and smart cards that you want to map to the remote desktop machine.</td>
</tr>
</tbody>
</table>

17 Review the information on the Summary page, making any changes to the bundle settings by using the Back button as necessary.

18 Skip to Step 20 to create the published version of the bundle.

19 (Conditional) Select the Create as Sandbox option to create a sandbox-only version of the bundle.

A sandbox-only version of a bundle enables you to test the bundle on your device before actually deploying it. For more information on a sandbox-only bundle, see Chapter 7, “Understanding Bundle Change Management,” on page 127.

20 (Conditional) Select the Define Additional Properties option to display the bundle’s Action page after the wizard completes. You can use the various tabs to edit the bundle’s assignments, system requirements, actions, settings, and content replication settings.

21 Click Finish to create the bundle as configured per settings on the Summary page.
Creating Bundles

When you click Finish, the bundle is created but it does not have users or devices assigned, and group membership. At some point in the future, you need to configure additional options for the bundle by continuing with Section 9.1, “Assigning Existing Bundles to Devices,” on page 149 or Section 9.2, “Assigning Existing Bundles to Users,” on page 152.

For information on the viewing the bundle information, see Chapter 3, “Viewing the Bundle Information,” on page 45.

2.6 Creating Bundles by Using the zman Command Line Utility

ZENworks Configuration Management allows you to create different types of bundles, such as Windows bundle and Preboot bundle. Each bundle has its own set of data and configuration settings. Because it is complex to pass the data as arguments in the command line, the zman utility takes XML files as an input to create bundles. To use the zman command line utility to create a bundle, you must have a bundle of the same type already created through ZENworks Control Center and export it to XML. For more information on creating bundles by using ZENworks Control Center, see Chapter 2, “Creating Bundles,” on page 21. You can use the exported XML file as a template to create bundles by using zman.

For example, you can export a Windows bundle already created through ZENworks Control Center into an XML file, then use it to create another Windows bundle with zman.

A bundle can have file content associated with it. For example, an MSI file to be installed is a file content associated with a Windows MSI Bundle.

Bundles can also have dependencies on other bundles.

NOTE: If you use the zman bundle-create command to create a Linux bundle with the Install RPM) action or a Linux Dependency bundle with the Distribute RPM action, ensure that you run the command within a working directory, so the path of the RPM files in the ActionInfo XML can be resolved.

For example, assume that you use the zman bundle-export-to-file command to export a Linux bundle with the Install RPM action, along with its content. If you want to create a new bundle from the exported bundle XML file and content, you need to ensure that you are running the zman bundle-create command within the directory that contains the ActionInfo XML file. You need to do this because the exported ActionInfo XML file contains the relative path of the RPMs, and the path resolves correctly only if you are running the command from the directory that contains the ActionInfo XML file.

Review the following sections to create a bundle by using the zman command line utility:

- Section 2.6.1, “Creating a Simple Bundle,” on page 37
- Section 2.6.2, “Creating a Bundle with Content and Dependency on Another Bundle,” on page 39
- Section 2.6.3, “Understanding the zman Bundle XML File Format,” on page 40

2.6.1 Creating a Simple Bundle

To create a bundle that has no content or dependency on another bundle:

1. Create a bundle in ZENworks Control Center.
For example, use ZENworks Control Center to create a Web Application bundle called Google, which launches the Google Web site (http://www.google.com).

2 Export the bundle to an XML file by using the following command:

zman bundle-export-to-file bundle_name bundle_filename.xml

For example, export the Google bundle to google.xml by using the zman bundle-export-to-file google google.xml command.

If you want to create a new bundle with new data, continue with Step 3. If you want to create a new bundle with the same data as the google bundle, skip to Step 4.

3 Modify the XML file according to your requirements.

For example, change the value of <URL> from http://www.google.com to http://www.yahoo.com in the Launch URL Action section of Launch ActionSet in the XML file as shown below.

```xml
<ns2:ActionSets>
  <Id>104e5d74804052eb7ddc4a2f54358d97</Id>
  <Type>Launch</Type>
  <Version>1</Version>
  <Modified>false</Modified>
  <Data>
    <ns1:Launch/>
  </Data>
  <Actions>
    <Id>2ef5c645774759e9868ba2c157301949</Id>
    <Type>Launch URL Action</Type>
    <Data>
      <ns1:LaunchUrlActionData>
        <URL>http://www.yahoo.com</URL>
        <WaitForExit>false</WaitForExit>
      </ns1:LaunchUrlActionData>
    </Data>
    <ContinueOnFailure>false</ContinueOnFailure>
    <Enabled>true</Enabled>
    <Properties />
  </Actions>
</ns2:ActionSets>
```

4 Create a new bundle by using the following command:

zman bundle-create new_bundle_name bundle_xml_filename.xml

For example, to create the yahoo bundle, enter the zman bundle-create yahoo google.xml command at the console prompt.
2.6.2 Creating a Bundle with Content and Dependency on Another Bundle

1. Create two bundles in ZENworks Control Center.
   
   For example, use ZENworks Control Center to create two MSI application bundles called officeXP and officeXPSP1. The officeXP bundle installs Microsoft Office XP through an MSI. The officeXPSP1 bundle installs the Service Pack 1 for Microsoft Office XP. In the officeXP bundle, add an Install Bundle action to install officeXPSP1.

2. Export the bundle, which has the dependency on another bundle, to an XML file by using the following command:

   zman bundle-export-to-file bundle_name bundle_filename.xml

   This creates bundle_filename.xml and bundle_filename_ActionContentInfo.xml files.

   For example, export the officeXP bundle to officeXP.xml by using the zman bundle-export-to-file officeXP officeXP.xml command. The officeXP.xml and officeXP_ActionContentInfo.xml files are created.

   Sample xml format templates, WindowsMSIBundle.xml and ActionInfo.xml, are available at /opt/novell/zenworks/share/zman/samples/bundles on a Linux server and in "%ZENWORKS_HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.

   For more information about ActionContentInfo.xml, see Section 2.6.3, “Understanding the zman Bundle XML File Format,” on page 40.

   If you want to create a new bundle with new data, continue with Step 3. If you want to create a new bundle with the same data as the officeXP bundle, skip to Step 4.

3. Modify the officeXP.xml and officeXP_ActionContentInfo.xml files according to your requirements.

   For example, to create a new bundle to install ApplicationX and its support pack, do the following:

   - Change all references of officeXP.msi to ApplicationX.msi in the officeXP_ActionContentInfo.xml file.
   - Create another bundle called as ApplicationX-SP1 that installs the support pack for Application X.
   - Change the path of the dependent OfficeXPSP1 bundle to ApplicationX-SP1 in the officeXP_ActionContentInfo.xml to install both ApplicationX and its support pack.

   A sample officeXP_ActionContentInfo.xml is as follows:

   ```xml
   <ActionInformation>
   <ActionSet type="Install">  
     <Action name="Install MSI" index="1">  
     <Content>  
       <ContentFilePath includeAllFilesinFolder="false">E:\files\ApplicationX.msi</ContentFilePath>  
     </Content>  
   </Action>
   <Action name="Install Bundle" index="2">  
   </Action>
   </ActionSet>
   </ActionInformation>
   ```
<DependentBundlePath>bundlefolder/ApplicationX-SP1</DependentBundlePath>

</Action>
</ActionSet>

<ActionSet type="Uninstall">
<Action name="Undo Install Actions" index="1">
<Content>
<ContentFilePath includeAllFilesinFolder="false" includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</ContentFilePath>

</Content>
</Action>
</ActionSet>
</ActionInformation>

4 Create a bundle by using the following command:

zman bundle-create new_bundle_name bundle_xml_filename.xml bundle_location --actioninfo bundle_name_ActionContentInfo.xml

If you do not specify the location of the bundle creation, the bundle is created in the root folder (/Bundles) by default.

For example, use the following command to create a bundle called ApplicationX in the root folder (/Bundles):

zman bundle-create ApplicationX officeXP.xml --actioninfo officeXP_ActionContentInfo.xml

You can also specify the folder in which the bundle should be created.

For example, use the following command to create a bundle called ApplicationY in the Software folder under the root folder (/Bundles/Software):

zman bundle-create ApplicationY officeXP.xml /Bundles/Software --actioninfo officeXP_ActionContentInfo.xml

2.6.3 Understanding the zman Bundle XML File Format

The bundle-export-to-file command serializes the bundle information, which is stored in the database, into an XML file. Each bundle contains actions that are grouped into action sets such as Install and Launch. An exported bundle XML file contains information for the bundle, such as UID, Name, Path, PrimaryType, SubType, Category, System Requirements, and information on all ActionSets and their actions. The file does not include information about assignment of the bundle to devices or users, and add-on images for the bundle.

A sample XML format template, WindowsMSIBundle.xml, is available at /opt/novell/zenworks/share/zman/samples/bundles on a Linux server and in "%ZENWORKS_HOME%\Novell\Zenworks\share\zman\samples\bundles on a Windows server.

NOTE: If the exported XML file contains extended ASCII characters, you must open it in an editor by using UTF-8 encoding instead of ANSI encoding, because ANSI encoding displays the extended ASCII characters as garbled.
When you create a bundle from the XML file, zman uses the information specified in the <Description>, <SubType>, <Category>, <ActionSets>, and <SysReqs> elements of the file. The values for the Name and Parent Folder are taken from the command line. For the remaining elements, the default value is used.

Follow the guidelines listed below to work with the XML file:

- If you want to create a bundle without file content or dependency on another bundle, you need only the bundle XML file to create a bundle.

- If you want to create a bundle with content or dependency on another bundle, you must provide an additional XML file, which contains the path of the content file or the dependent bundle, as an argument to the --actioninfo option of the bundle-create command.

A sample XML format template, ActionInfo.xml, is available at /opt/novell/zenworks/share/zman/samples/bundles on a Linux server and in "$ZENWORKS_HOME\Novell\Zenworks\share\zman\samples\bundles" on a Windows server.

- If you want to modify the <Data> element of actions in the exported XML file, ensure that the new data is correct and that it conforms to the schema. The zman utility does a minimal validation of the data and does not check for the errors in the data. Hence, the bundle might be successfully created, but with invalid data. Such a bundle fails when deployed on a managed device.

- File content or bundle dependencies are associated with a particular action in <ActionSet>. The Action Content Information XML file should contain the path of the file to which the file content is to be associated and the index of the action in the <ActionSet>.

For example, the MSI file to be installed when you create the Windows MSI Bundle is associated to the first Install MSI action in the Install action set of the created Windows MSI Bundle.

- The <ActionSet> is specified by the type attribute. It should be the same as the Action Set type of the bundle XML file.

- The <Action> element has a name attribute, which is optional, for user readability.

- The index attribute is mandatory. It specifies the action to which the content or dependency should be associated. The index value of the first action in <ActionSet> is 1.

- Each action can have multiple <Content> elements, each containing a <ContentFilePath> element. The <ContentFilePath> element contains the path of the file content to be associated with the Action. Ensure that the filename is the same as the filename specified in the bundle XML file in <Data> for that action.

- Ensure that the order of the <Content> elements is in accordance with the order in the bundle XML file. For example, the Windows MSI bundle should have the MSI file in the first <Content> element, followed by <Content> elements with the path to the MST files in the order specified in <Data> for that action.

- For creating Windows MSI bundles, you can include all the files in the folder or subfolders by setting the includeAllFilesinFolder and includeAllFilesinSubFolders attributes to True. The dependency to another bundle can be specified by giving the bundle path as a value of the <DependentBundlePath> element. The path of the bundle specified should be relative to / Bundles as shown below.

```xml
<ActionSet type="Install">
  <Action name="Install MSI" index="1">
    <Content>
      <ContentFilePath includeAllFilesinFolder="false"
                       includeAllFilesinSubFolders="false">E:\files\ApplicationX.msi</ContentFilePath>
    </Content>
  </Action>
</ActionSet>
```
To get the UID of an object, use the `object-get-GUID` command. You must manually edit the object UIDs in the bundle XML file in the following scenarios:

- In the Bundle Installed system requirement, the path and the UID of the bundle must be changed in the `<BundleInstalledReq>` element under the `<SysReqs>` element.
- In the Imaging bundle, the UID of the server containing the `.img` file must be manually changed in the ZENworks Image and Multicast Image Set actions. Also, the UID of the linked application bundle must be manually changed in the Linked Application Bundle and Multicast Image Set actions. Ensure that the linked bundle already has an add-on image that was created manually, because it is not automatically created when the bundle is linked to the image bundle.

**NOTE:** If you export a bundle which has a with string values into an XML file, the string value in it will be in Base 64 encoding format. You cannot use this XML file as a template to create another bundle using zman, because the string value which is in Base 64 format in this XML file cannot be changed.

### 2.7 Creating iOS Bundles

iOS bundles allow you to configure and manage Apple App Store apps, Apple VPP apps, and Enterprise apps. You can also distribute a configuration profile using the iOS Bundles feature. For more information on these bundles, see ZENworks 2017 Mobile Management Reference.

### 2.8 Creating Corporate Bundles

Allows you to configure and manage corporate resources on devices. Using this bundle you can create a Wi-Fi profile that will enable you to configure and distribute Wi-Fi configurations to devices. For more information on these bundles, see ZENworks 2017 Mobile Management Reference.

### 2.9 Exporting and Importing Bundles

Using the Export and Import bundles feature, you can copy bundles from one zone to another. This feature helps you to export and import bundles from a test environment to a production environment.

**Use Case:** This feature is useful in a scenario where you want to deploy an application to multiple devices using the bundle feature, and prior to publishing the bundle, you want to test it to ensure that there are no glitches during deployment.
The bundle export and import feature enables you to create a bundle in a test zone and test the functionality of the bundle. After you have tested the bundle, you can export the bundle as a ZIP file to your local drive using the Export feature that is available in ZENworks Control Center (ZCC). The same ZIP file can then be imported to the production zone by using the Import feature.

2.9.1 Exporting Bundles

This feature enables you to export bundles to the local drive. If you export bundles using the ZMAN command prompt, only the XML files are exported. However, when you export bundles using this feature the metadata files, icons, settings and XML files are also exported.

To Export Bundles:

1. Log into ZENworks Control Center, and in the left pane click Bundles.
2. Select the bundles that you want to export.
3. Click Action > Export.

Based on the browser settings, you will be either prompted for the download location or the bundle will be automatically saved to the default download location.

2.9.2 Importing Bundles

This enables you to import bundles from the local drive into the zone.

Before importing any bundles ensure that you have configured the following bundle settings:

- Action sets associated with the bundle. For more information, see Chapter 6, “Actions,” on page 61
- System requirements. For more information see, ZENworks 2017 System Requirements.
- The Bundle – Relationships. For more information, see Section 8.8, “Dependency Bundles,” on page 145

To import bundles:

1. Click New > Import Bundle.
2. Upload the bundle in the required format:
   - ZIP file: Click and allow the browser to launch ZCC Helper. Click Browse to select the required file and then click Upload.
   - A directory: Click and allow the browser to launch ZCC Helper. Click Browse to select the required folder and then click Upload.

   **NOTE:** To upload files, you need to ensure that ZCC Helper is installed on the device.
3. Select Maintain Folder Structure, to retain the folder structure of the imported bundle.
4. Select Create as Sandbox to create a sandbox-only version of the bundle that can be tested before being published.
5. Click Next.
6. (Optional) In the Bundle Configuration page, double-click the bundle name to edit the name.
7. Click Next. The Bundle Summary page displays the details of the imported bundles.
8. Click Finish. The Bundle Import Status page displays the status of all the bundles that were imported.
NOTE: To view the import status of the bundles, click the Import Status button.
Viewing the Bundle Information

When you create a bundle, the bundle is listed on the Bundles page of the ZENworks Control Center.

For more information on the created bundle, review the following sections:
- Section 3.1, “Understanding the Bundle Page,” on page 45
- Section 3.2, “Bundle Summary Page,” on page 45

3.1 Understanding the Bundle Page

The Bundles page displays the following information:
- **Status**: Gives a quick indication of message logging and enforcement status of the bundle. The status icons are:
  - No warning or error messages; bundle enforcement succeeded
  - Warning messages; bundle enforcement succeeded
  - Error messages; bundle enforcement failed
- **Name**: Displays the object’s (bundle, bundle group, or the bundle folder) name. Click the name to view or edit the object’s information.
- **Type**: Displays the type of the object. For example, a Folder, Bundle Group, Windows Bundle, Linux Bundle, or Preboot Bundle.
- **Category**: Displays the bundle category selected during the creation of the bundle. For example, Copy Directory.
- **Enabled**: Displays whether the bundle is enabled to be deployed on a device or not. The possible values are Yes and No.
- **Version**: Displays the latest published version of the bundle. However, if the bundle is a sandbox-only bundle, it displays Sandbox.
- **Has Sandbox**: Displays whether the bundle has a sandbox or not. The possible values are Yes and No.

3.2 Bundle Summary Page

The Summary page of a bundle displays the following panels:
- Section 3.2.1, “General,” on page 45
- Section 3.2.2, “Bundle Status,” on page 49
- Section 3.2.3, “Message Log,” on page 50
- Section 3.2.4, “Upcoming Events,” on page 51

3.2.1 General

The General panel provides a summary of the bundle’s general settings.
Bundle Type
Displays the type of bundle.

Size
Click Compute to display the size of the content associated with the bundle. To view the correct size of the bundle, check for the bundle size information in the bundle summary page after the content import is complete.

When you create a bundle, the bundle's files are imported to the ZENworks content repository. The import is a server process that can take a while. Until the import is complete, the size of the bundle is displayed as 0 (zero).

Version
Displays the latest published version of the bundle. However, if the bundle is a sandbox-only bundle or has a sandbox, it displays Sandbox.

Enabled
Displays whether or not the bundle can be deployed to managed devices. If a bundle is enabled, it can be deployed to managed devices.

When you disable a bundle that has already been deployed to a managed device, the bundle icon is removed from all the shortcut locations of the device. However, all the actions performed on the device prior to the disabling of the bundle remain unchanged. If this bundle is assigned to a new device, the bundle shortcut icons are not placed in the device's shortcut locations.

If the bundle is disabled, click Enable to allow it to be deployed.

Number of Errors Not Acknowledged
An error is anything that causes the deployment or installation of the bundle to fail. The number displayed indicates the number of unacknowledged errors, which are any errors that you have not specifically marked as acknowledged. Unacknowledged errors are displayed in the Message Log section.

Number of Warnings Not Acknowledged
A warning is anything that does not cause the deployment or installation of the bundle to fail, but indicates minor problems with the bundle. The number displayed indicates the number of unacknowledged warnings, which are any warnings that you have not specifically marked as acknowledged. Unacknowledged warnings are displayed in the Message Log section.

GUID
Displays the bundle’s GUID (global unique identifier), a randomly generated string that provides a unique identifier for the bundle. You cannot edit the GUID.
Display Name
Displays the bundle’s name as it appears in ZENworks Control Center (ZCC) and the ZENworks Agent (on managed devices). Click Edit to change the name. Changing the name does not cause the bundle to be redeployed.

Description
Displays the bundle’s description, if one was provided when the bundle was created. The description appears in ZCC and the ZENworks Agent (on managed devices). Click Edit to change the description.

Icon
Determines the shortcut icon that ZENworks Agent displays on managed devices. During creation of the bundle, if you specified a custom icon rather than using the standard ZENworks bundle icon, this field displays the image and name of the custom icon. If you did not specify a custom icon, this field is empty and the standard icon is used.

Click Edit to change the icon, delete the icon, or add an icon if one is not specified.

To select an icon, click , allow browser to launch ZCC Helper, and then browse to and select the icon you want to display on managed devices.

If you do not specify an icon, a default icon is used.

NOTE: For Linux bundles, only the PNG and JPEG formats are supported.

Contacts
Displays the contact information (names, phone numbers, and e-mail addresses) of the people who you want users to contact with problems or questions about the bundle. The contact information is displayed by ZENworks Agent on managed devices.

Click Edit to change the contact information, delete contact information, or add contact information.

Administrator Notes
Displays any information that has been added specifically for ZENworks administrators to view. The notes are displayed only in ZCC.

Click Edit to change the notes, add notes, or delete notes. Editing the note does not create a sandbox. You can edit the administrator notes for any version of a bundle.

ZENworks Explorer Folder Path
Displays the folder path used by ZENworks Agent when displaying the bundle on the Start menu.

For example, if you specify Applications/Accounting as the path and choose to display the bundle on the Start menu, ZENworks Agent creates an Applications/Accounting folder on the Start menu and adds the bundle to it.

You can place multiple bundles in a single folder by specifying the same folder path for each of the bundles.
Click **Edit** to change the folder path, add a folder path, or delete the folder path.

**Add-On Image File**

You can create an image file for the bundle to use as an add-on image to a base image. If you have already created an image file for the bundle, this field displays the name of the image file. Otherwise, click **Create** to create the image file and assign it to image servers.

If the bundle includes any dependent bundles, you can also create and assign an add-on image for the dependent bundles.

**Show Bundle Activity**

Click **Yes** to display the bundle activity indicator window during the distribution, installation, verification, and uninstallation of a bundle on the managed device. The user on the managed device cannot close this bundle activity indicator window.

On Windows 2000 devices, the control that indicates the progress of the bundle execution on the managed device is not displayed in the bundle activity indicator window.

**Dependency Bundles**

Displays **None** if there are no bundle dependencies for this bundle. If there are dependencies for this bundle, click **Display Bundle Dependencies** to display a list of additional bundles that are required by this bundle.

The list is for viewing only. To change a bundle dependency, switch to the **Actions** tab, click the appropriate action (for example, **Install** or **Launch**), then locate the **Linked Application Bundle** or **Linked Preboot Bundle**. Select the entry and perform the action you want (for example, edit or delete it).

For more information, see "Dependency Bundles" on page 145.

**Severity**

This field is available only for Linux bundles. It indicates the severity, such as Security, Recommended or Optional.

**YUM Service**

This field is available only for Linux bundles and Linux Dependency bundles.

Click **Create** to create a YUM service and assign it to ZENworks Servers in a Management Zone. You can create a YUM service for a bundle and use it on devices that are not managed by ZENworks. Click **Help** for more information on how to create a YUM service.

When you create the YUM service, the bundle’s Summary page is displayed. The **YUM Service** field displays the relative path of the repository. The In-Progress icon indicates the progress. Click the **Summary** tab to refresh the page. The 🤖 icon indicates that the service is hosted on the Primary Server. The relative path of the YUM repository is displayed in the **YUM Service** field.

A yellow 🟢 icon is displayed when the repository is not updated with the packages in the bundle.

Click **Edit** to edit the YUM service details. You can edit the YUM service to add or remove Primary Servers.
3.2.2 Bundle Status

The Bundle Status panel displays a summary of the bundle’s assignment, deployment, and launch status. The User row displays the status of the bundle through assignment to users; the Device row displays the status of the bundle through assignment to devices. A bundle can be directly assigned or assigned through membership in a folder or group. You can click an underlined link in any column to view the status of the individual users and devices to which the bundle is assigned, retry a failed bundle, or export the data to a CSV file.

A bundle’s status is calculated using the status of many events. For example, a device might indicate that the bundle failed when the distribution was successful, but the installation failed. The numbers in the various columns represent an overall view of the bundle’s status.

NOTE: The Bundle Status panel on the bundle’s sandbox or the older versions page does not display the status. However, the Bundle Status panel on the bundle’s published version page displays the status of the bundle’s published version, sandbox, and the older versions.

The bundle status information is separated into the following groups listed below, which are independent of each other. For example, it is possible for an installation to be successful, but the launch to be unsuccessful.

Assignment Status

The following status information is available:

**Targeted:** Displays the number of users and devices to which the bundle is assigned.

**Devices Effective:** Displays the number of devices on which the bundle is effective through a user or device assignment. A bundle is effective for a device if the device meets the system requirements of the bundle. The number of users or devices in the Devices Effective column might be less than the number in the Targeted column because the bundle might be assigned to a device that does not meet the bundle’s system requirements. For example, you might have a Windows bundle assigned to a Linux device, but the bundle is not effective for that device.

**Devices Not Effective:** Displays the number of devices on which the bundle is not effective through a user or device assignment. If a bundle is not effective for the device, it means that the device does not meet the bundle’s system requirements.

**Pending:** The pending status for the device displays the number of devices on which the bundle is not yet distributed or executed, such as devices that are switched off. Click the underlined link to display the list of such devices.

**Blocked/Targeted:** Displays the number of users or devices on which the bundle is blocked from being used out of the targeted number of the users or devices. Click the underlined link to display the list of such users or devices.

Deployment Status

The following status information is available:

**Devices Pending:** Displays the number of devices on which the bundle is pending. A bundle’s status is pending if the bundle has met the device’s system requirements, but the bundle has not been distributed to the device or the bundle has been distributed to the device but the bundle has not been installed.
Devices Succeeded: Displays the number of devices on which the bundle was successfully distributed and installed.

Devices Failed: Displays the number of devices on which the bundle’s distribution or installation failed.

Launch Status

The following status information is available:

Succeeded: Displays the number of devices on which the application in the bundle was successfully launched.

Failed: Displays the number of devices on which the application in the bundle was not successfully launched.

3.2.3 Message Log

The Message Log panel displays all unacknowledged messages generated for the object. An unacknowledged message is one that you have not yet reviewed and marked as acknowledged.

- Status: Displays an icon indicating the type of message: critical, warning, and normal.
- Message: Displays a brief description of the event that occurred.
- Date: Displays the date and time the event occurred.

NOTE: The Message Log panel on the bundle’s sandbox or the older versions page does not display any messages. However, the Message Log panel on the bundle’s published version page displays the messages of the bundle’s published version, sandbox, and the older versions.

A message remains in the Message Log list until you acknowledge it. You can acknowledge individual messages, acknowledge all messages at one time, or view more information about both acknowledged and unacknowledged messages. The following table explains how to do these tasks:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Acknowledge a message         | 1. Click the message to display the Message Detail Information dialog box.  
                               | 2. Click Acknowledge.                                                   | If you decide that you don’t want to acknowledge the message, click Finished to dismiss the dialog box. This causes the message to remain in the Message Log list. |
| Acknowledge all messages      | 1. In the Tasks list located in the left navigation pane, click Acknowledge All Messages. |                                                                                   |
| View all acknowledged or unacknowledged messages | 1. Click the Advanced button to display the Edit Message Log page. | In addition to viewing all acknowledged and unacknowledged messages, you can also view only those messages with a specific status or date, view more details about messages, and acknowledge messages. Click the Help button on the Edit Message Log page for specific information about performing tasks on that page. |
3.2.4 Upcoming Events

The Upcoming Events panel lists all bundles to deploy or launch today on all managed devices in your ZENworks Management Zone. To view the events for another day, click the icon to select a specific day or use the 1, 7, and 31 arrows to view events for the previous or next day, week, or month.

Click a bundle to display or edit its details such as summary, relationship, requirement, actions, or settings.

Click a time to view the bundle’s details, including the time the event is to fire, its type (Date Specific, Event, Recurring, etc.), the dates on which the event is to be performed, and the event’s start and end time.

Click to view the bundle’s assignment details, including the bundle’s folder and its assignments (devices or workstations).
Viewing the Bundle Information
Managing Bundle Groups

A bundle group lets you group bundles to ease administration and to provide easier assigning and scheduling of the bundles in the bundle group.

You can use ZENworks Control Center or the zman command line utility to create bundle groups. This section explains how to perform this task using the ZENworks Control Center. If you prefer the zman command line utility, see "Bundle Commands" in ZENworks Command Line Utilities Reference.

For information on assigning a bundle group to a user or device, see Chapter 9, “Managing Bundle Assignments,” on page 149.

The following sections contain more information:

- Section 4.1, “Creating Bundle Groups,” on page 53
- Section 4.2, “Renaming or Moving Bundle Groups,” on page 54
- Section 4.3, “Copying the System Requirements of a Bundle Group,” on page 54
- Section 4.4, “Group Members,” on page 55
- Section 4.5, “Deleting a Bundle Group,” on page 56
- Section 4.6, “Adding a Bundle to a Group,” on page 56
- Section 4.7, “Copying a Bundle Group to a Content Server,” on page 57

4.1 Creating Bundle Groups

1. In ZENworks Control Center, click the Bundles tab.
2. Click New > Bundle Group.
3. Fill in the fields:
   - **Group Name**: Provide a name for the bundle group. The name must be different than the name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name you provide displays in ZENworks Control Center.
   
   For more information, see "Naming Conventions in ZENworks Control Center" in the ZENworks Control Center Reference.
   
   - **Folder**: Type the name or browse to and select the ZENworks Control Center folder where you want the bundle to reside. The default is /bundles, but you can create additional folders to organize your bundles.
     
     If you want to create the group in another folder, browse to and select the folder. By default, the group is created in the current folder.
   
   - **Description**: Provide a short description of the bundle group's contents. This description displays in ZENworks Control Center.
     
4. Click Next to display the Add Group Members page, then specify bundles to be members for the group.

You can add any number of bundles to the group. You cannot add other bundle groups to the group.

4a. Click Add to display the Select Members dialog box.
Because you are adding bundles to the group, the Select Members dialog box opens with the Bundles folder displayed.

4b Browse for and select the bundles you want to add to the group. To do so:

4b1 Click next to a folder to navigate the folders until you find the bundle you want to select.

   If you know the name of the bundle you are looking for, you can also use the Item name box to search for the bundle.

4b2 Click the underlined link in the Name column to select the bundle and display its name in the Selected list.

4b3 (Optional) Repeat Step 4a and Step 4b to add additional bundles to the Selected list.

4b4 Click OK to add the selected bundles to the group.

5 Click Next to display the Summary page, review the information and, if necessary, use the Back button to make changes to the information.

6 (Optional) Select the Define Additional Properties option to display the group’s properties page after the group is created. You can then configure additional bundle properties.

7 Click Finish to create the group.

Before the bundle group’s contents are distributed to devices or users, you must continue with Section 9.3, “Assigning a Bundle Group to Devices,” on page 154 or Section 9.4, “Assigning a Bundle Group to Users,” on page 156.

4.2 Renaming or Moving Bundle Groups

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-down list, you must select an object by clicking the check box next to the object’s name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the box next to the bundle group’s name, click Edit, then click an option:

   Rename: Click Rename, provide a new name for the folder, then click OK.

   Move: Click Move, select a destination folder for the selected objects, then click OK.

4.3 Copying the System Requirements of a Bundle Group

For more information, see Section 4.3, “Copying the System Requirements of a Bundle Group,” on page 54.
4.4 Group Members

This section enables you to manage members in the group.

4.4.1 Adding Members to a Group

To add a member to a group

1. Click Add to display the Select Members dialog box.
2. Browse and select the bundles you want to assign to the group.
   You can also use the Item name box to search for the bundle.
3. Click OK to add the selected bundle to the group.

4.4.2 Removing Members from a Group

Select the check box next to the member you want to delete, and Click Remove.

4.4.3 Reordering Members in a Group

To reorder the bundle group member:

1. Select the check box next to the member you want to move.
2. Click Move Up or Move Down to relocate.

4.4.4 Copy Members

Using Copy Member, you can:

Copy a member to an existing group

1. Select Add selected items to an existing Group, and click .
   In the Select Group page, select the required group, and then click OK.
2. In the Copy To Group, click OK.

Copy a member by creating a new group

1. Select Create a new Group to contain the selected items, and specify the following:
   Group Name: Specify the group name.
   Folder: Specify the name, or browse to the ZCC folder where you want to create the group.
2. Click OK.

4.4.5 Move Members

Using Move Member, you can:
Move a member to an existing group

1. Select **Add selected items to an existing Group**, and click .
   
   In the **Select Group** page, select the required group, and then click OK.
2. In the Move To Group, click OK.

Move a member by creating a new group

1. Select **Create a new Group to contain the selected items**, and specify the following:
   
   **Group Name:** Specify the group name.
   
   **Folder:** Specify the name, or browse to the ZCC folder where you want to create the group.
2. Click OK.

4.5 Deleting a Bundle Group

Deleting a bundle group does not delete its bundles. It also does not uninstall the bundles from devices where they have already been installed. To uninstall the bundles from devices, you should use the **Uninstall** option for each bundle before deleting the bundle group.

1. In ZENworks Control Center, click the **Bundles** tab.
2. In the **Bundles** list, select the check box next to the bundle group (or bundle groups).
3. Click **Delete**.

**NOTE:** Deleting a bundle group does not immediately remove the YUM service that was created for the bundle group. The YUM service is removed when the next YUM Services Refresh is configured. Click the **Click here to Update YUM Service Now** link in **YUM Service Settings** to remove the YUM service immediately.

4.6 Adding a Bundle to a Group

You can add the bundle to any bundle groups that already exist or you can create a new bundle group as part of the assignment process. The bundle inherits the group’s assignments and settings, which means that you save time by managing one bundle group rather than each individual bundle. Adding a bundle to a group is not the same as assigning a bundle to a group (user or device). For more information on assigning bundles to devices, see **Assigning Existing Bundles to Devices** and assigning bundles to users, see **Assigning Existing Bundles to Users**.

1. In ZENworks Control Center, click the **Bundles** tab.
2. In the **Bundles** list, select the check box next to the bundle (or bundles).
3. Click **Action > Add to Group**.
4. Select **Add selected items to an existing group** if the group to which you want to add the objects already exists.
   
   or
   
   Select **Create a new group to contain the selected items** if you need to create a new group for the selected objects.
5 (Conditional) If you chose Add selected items to an existing group in Step 4, click Next to display the Targets page.

The Targets page lets you select the groups to which you want to add the objects (users, devices, bundles, policies).

5a Click Add to display the Select Groups dialog box.

5b Browse for and select the groups to which you want to add the objects. To do so:

5b1 Click next to a folder to navigate the folders until you find the group you want to select.

If you know the name of the group you are looking for, you can also use the Item name box to search for the group.

5b2 Click the underlined link in the Name column to select the group and display its name in the Selected list.

5b3 Repeat Step 5b1 and Step 5b2 to add additional groups to the Selected list.

5b4 When you are finished selecting groups, click OK.

6 (Conditional) If you chose Create a new group to contain the selected items in Step 4, click Next to display the Basic Information page, then fill in the fields:

Name: Provide a name for the group. The group name must be different than the name of any other object (group, folder, device, user, bundle, policy, and so forth) that resides in the same folder and must conform to the ZENworks object naming conventions.

For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.

Folder: By default, the group is created in the current folder. If you want to create the group in another folder, browse to and select the folder.

Description: Provide a short description of the group’s purpose or contents.

7 Click Next to display the Summary page, review the information and, if necessary, use the Back button to make changes to the information.

8 Click Finish to add the selected objects to the group.

4.7 Copying a Bundle Group to a Content Server

By default, a bundle is copied to each content server. If you specify certain content servers as hosts, the bundle is hosted on only those content servers; it is not copied to all content servers.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Action > Specify Content Server.

4 On the Content Servers/Distribution Points Where Content Will Be Specifically Included page, select the content servers.

This page lets you identify the content servers (ZENworks Servers and Distribution Points) that you want to host the previously selected content (bundles and policies). The content is hosted only on the content servers you select; it is excluded from all other content servers.

The relationships between content and content servers that you create using this wizard override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and Server 2 and you use this wizard to include it on Server 1 only, Bundle A is no longer available on Server 2.

4a In the Available list, select the desired ZENworks Servers and Distribution Points.
You can use Shift+click and Ctrl+click to select multiple bundles or policies.
You cannot include content on a Distribution Point without including it on the Distribution Point's parent ZENworks Server. You must select both the Distribution Point and its parent.

4b. Click the button to move the selected content servers to the Selected list.

5. Click Next to display the Finish page, then review the information and, if necessary, use the Back button to make changes to the information.

6. Click Finish to create the relationships between the content and the content servers. Depending on the relationships created, the content is replicated to or removed from content servers during the next replication.
Managing Folders

A folder is an organizational object. You can use folders to structure your bundles and bundle groups into a manageable hierarchy for your ZENworks system. For example, you might want a folder for each type of bundle (Windows Bundles folder, Preboot Bundles folder, and so forth), or, if applications are department-specific, you might want a folder for each department (Accounting Department folder, Payroll Department folder, and so forth).

The following sections contain additional information:

- Section 5.1, “Creating Folders,” on page 59
- Section 5.2, “Renaming or Moving Folders,” on page 59
- Section 5.3, “Deleting a Folder,” on page 60

5.1 Creating Folders

1. In ZENworks Control Center, click the Bundles tab.
2. Click New > Folder.
3. Provide a unique name for your folder. This is a required field.
   When you name an object in ZENworks Control Center (folders, bundles, bundle groups, catalogs, and so forth), ensure that the name adheres to the naming conventions not all characters are supported. For more information on naming conventions, see "Naming Conventions in ZENworks Control Center" in the ZENworks Control Center Reference.
4. Type the name or browse to and select the folder that contains this folder in the ZENworks Control Center interface. This is a required field.
5. Provide a short description of the folder's contents.
6. Click OK.

5.2 Renaming or Moving Folders

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a Folder object, you can rename or move the Folder object, but not copy it. If the option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is selected, the Rename option is not available from the Edit menu.

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the box next to the folder’s name, then click Edit.
3. Select an option:
   - Rename: Click Rename, provide a new name for the folder, then click OK.
• **Move:** Click **Move**, choose a destination folder for the selected objects, then click **OK**.

### 5.3 Deleting a Folder

Deleting a folder also deletes all of its contents (bundles, bundle groups, subfolders).

1. In ZENworks Control Center, click the **Bundles** tab.
2. In the **Bundles** list, select the check box next to the folder (or folders).
3. Click **Delete**.
Actions

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, the possible action sets are Distribute, Install, Launch, Repair, Uninstall, Terminate, and Preboot. For example, if you select a Windows bundle, six action sets (Distribute, Install, Launch, Repair, Uninstall, Terminate) are available. If you select a Preboot bundle, Preboot is the only available action set available.

You can choose to modify the action sets. For more information on modifying the action set options, see Section 12.2, "Modifying Action Set Options," on page 173.

The bundle category that you select during bundle creation is listed as an action in the actions page. For example, if you selected the Copy Directory category during the bundle creation, Copy Directory action is listed in the Install tab of the actions page. You can also add an action to any of the available action sets. When you do so, that action is also performed whenever the action set is applicable. For example, when you add an action to the Install action set, that action is performed whenever the bundle is installed.

For information on managing the actions, see Section 12.1, "Managing Actions," on page 171.

To access the action dialog box:

1. In ZENworks Control Center, click the Bundles tab.
2. Click the underlined link of a bundle in the Name column of the Bundles list.
3. Click the Actions tab.
4. Click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contain information about the actions you can configure for the Distribute, Install, Launch, Repair, and Terminate action sets.

For more information about the actions you can configure for the Preboot action set, see the ZENworks Preboot Services and Imaging Reference.

- Section 6.2, “Action - Copy Files,” on page 65
- Section 6.4, “Action - Delay,” on page 68
- Section 6.5, “Action - Display Message,” on page 69
- Section 6.6, “Action - Distribute Files,” on page 70
- Section 6.7, “Action - Edit INI File,” on page 71
- Section 6.8, “Action - Edit Text File,” on page 74
- Section 6.9, “Action - End Process,” on page 75
- Section 6.10, “Action - File Removal,” on page 76
- Section 6.11, “Action - Install Bundle,” on page 77
- Section 6.12, “Action - Install Directory,” on page 78
- Section 6.13, “Action - Install Files,” on page 81
6.1 Action - Copy Directory

The Action - Copy Directory dialog box lets you specify the directory to be copied and its destination directory. You can also specify the executable security level and the specific requirements that a device must meet for the action to be executed on the device.

NOTE: Copying a file or directory copies the file or directory from one location to another without uploading the files into the ZENworks content repository. Copying a file or directory is described as copying without using content. When copying a file or directory, the managed device performs the copy operation and must be able to resolve both the source and destination paths. Also, when copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it is distributed to assigned devices. Installing a file or directory is described as copying using content. When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must add a launch executable action (Launch Windows Executable, Launch Java Application, and so forth) to the bundle.
You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the Copy Directory bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.1.1, “General,” on page 63
- Section 6.1.2, “Requirements,” on page 65

6.1.1 General

The General page lets you specify the source directory, destination directory, copy option, and the executable security level.

Source Directory

If you have not installed ZCC Helper on this device, you must do so before you can browse for a directory.

Click Browse, and allow browser to launch ZCC Helper. The Select Folder dialog box is displayed, select the directory to copy.

Destination Directory

Specify the destination path on the device where you want to copy the directory.

Copy Option

Select a copy option from the list:

Copy Always: Copies the content of the directory regardless of whether the files currently exist on the workstation.

Copy If Exists: Copies the content of the directory only if the files currently exist on the workstation.

Copy If Does Not Exist: Copies the content of the directory only if the files does not currently exist on the workstation.

Copy If Newer: Copies the content of the directory only if the modified date and time of the file is newer than the existing file’s date and time, or if the files do not currently exist on the workstation.

Copy If Newer and Exists: Copies the content of the directory only if it already exists on the workstation and the existing file has an older modification date or time.

Copy if Newer Version: Copies the content of the directory only if the internal version of the file is newer than the existing file’s version (if version information is present).

Request Confirmation: Prompts the user to confirm that the content of the directory should be copied when the directory already exists on the workstation.
Copy If Different: Copies the content of the directory if the creation date, creation time, or size of the file is different than the existing file’s date, time, or size.

Attributes

Select one or more of the following attributes:

Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.

Read-only: Select the Read-only check box to specify that the directory is read-only after being copied.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device the application executable can run in either the “user” space or the “system” space. By default, the Run normal option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user’s security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don’t allow system to interact with desktop): The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application’s interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention. If you use mapped network drives to specify files and directories, the action fails because system users do not have access to user mapped drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see “Using the Credential Vault” in the ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.
6.1.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.2 Action - Copy Files

The Action - Copy Files dialog box lets you specify files to copy to the device and the specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the Copy Files bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.2.1, “General,” on page 65
- Section 6.2.2, “Requirements,” on page 66

6.2.1 General

The General page lets you specify the files to copy to the device and the executable security level.

File Details

Click Add to display the Select Files dialog box. In the Select Files dialog box, click Add, allow browser to launch ZCC Helper. In the Select File dialog box, browse for the file path and click OK. Click the Help button for more information.

Edit File Details

The Edit File Details dialog box page lets you specify a copy option, the complete path of the source file to be copied, the path of the destination file, and whether the file is hidden or read-only after being copied to the device. Click any of the file names in the File Details dialog box to go to the Edit File Details dialog box.

Renaming the source file: To copy the source file to the destination directory with a different name, specify the new name along with the destination path in the Destination File Name field in the Edit File Details dialog box.

For example, to copy run.exe from C:\Program Files\Internet Explorer\ to D:\My Applications\Internet Explorer\ie.exe, use ie.exe as the new name you specify in the Destination File Name field in the Edit File Details dialog box.

Copy Option: Select a copy option from the list. For details, see Copy Option in the Action - Copy Directory section.
Attributes: Select one or more of the following attributes:

- Hidden: Select the Hidden check box to specify that the directory is hidden after being copied.
- Read-only: Select the Read-only check box to specify that the directory is read-only after being copied.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the “user” space or the “system” space. By default, the Run normal option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user’s security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

Run as logged in user: The action uses the logged-in user’s credentials. For example, the action has the same rights to the registry and the file system as the logged-in user.

Run as secure system user (Don’t allow system to interact with desktop): The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application’s interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention. If you use mapped network drives to specify files and directories, the action fails because system users do not have access to user mapped drives.

Run as dynamic administrator: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see "Using the Credential Vault" in the ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.2.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.3 **Action - Create/Delete Directory**

The Action - Create/Delete Directory dialog box lets you create or delete a directory on the managed device and define the specific requirements that a device must meet for the action to be executed on the device.

The **Delete Directory** action deletes the entire folder along with its inner files and folders; it also deletes the folders that are in the hidden mode.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the **Create/Delete Directory** bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the **Bundles** tab, click the underlined link of a bundle in the **Name** column of the **Bundles** list, click the **Actions** tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the **Add** drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.3.1, “General,” on page 67
- Section 6.3.2, “Requirements,” on page 68

### 6.3.1 General

The **General** page lets you specify the name of the directory to create or delete from the managed device and the executable security level.

**Create Directory**

Creates a directory on the managed device when the action is performed.

**Delete Directory**

Deletes a directory on the managed device when the action is performed.

**Delete readonly directory**

Deletes read-only directory on the managed device when the action is performed.

**Directory Name**

Specify the complete path of the directory you want to create or delete on the managed device. This path must be resolved by the device on which the bundle is run.
Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the "user" space or the "system" space. By default, the Run normal option is selected, which causes the application to run in the "user" space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the "system" space or as a dynamic administrator, as described below:

- **Run as logged in user**: The action uses the logged-in user's credentials. For example, the action has the same rights to the registry and the file system as the logged-in user.

- **Run as secure system user (Don't allow system to interact with desktop)**: The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application's interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention. If you use mapped network drives to specify files and directories, the action fails because system users do not have access to user mapped drives.

- **Run as dynamic administrator**: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

**Select credential for network access**: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see Using the Credential Vault in the ZENworks Control Center Reference.

**NOTE**: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

### 6.3.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

### 6.4 Action - Delay

The Action - Delay dialog box lets you specify a system delay between two actions in the action set and the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.
The following sections contains additional information:

- Section 6.4.1, “General,” on page 69
- Section 6.4.2, “Requirements,” on page 69

6.4.1 General

The General page lets you specify a system delay between two actions in the action set.

Delay for a Specific Time

Specify the desired time delay, in seconds. After completing the action, the system delays for the specified amount of time before performing the next action.

Wait for Processes or Services to Start

Specify the processes or services that must start before the next action in the action set is performed.

To add a process or service to the list:

1. Click Add to display the Add Service/Process dialog box.
2. Select Process, specify the process that must start before performing the next action, then click OK. You can specify either the name of the process or its full path. For example, you can specify notepad.exe or ${SystemRoot}\system32\notepad.exe.
   or
   Select Service, specify the service that must start before performing the next action, then click OK.
3. Repeat Step 2 as needed.
4. Specify the maximum amount of time to wait for the process or service to start before performing the next action in the action set. If the process or service does not start in the specified amount of time, the next action is performed.
5. Click OK.

Click Edit to change a process or service, or click Remove to delete a process or service.

6.4.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.5 Action - Display Message

The Action - Display Message dialog box lets you specify a message to display on devices when the action is performed and the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.
The following sections contains additional information:

- Section 6.5.1, “General,” on page 70
- Section 6.5.2, “Requirements,” on page 70

6.5.1 General

The General page lets you specify a message to display on devices when the action is performed.

Define Prompts

Define the prompt that you want to display on the device. Additionally, you can specify different locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the prompt defined in the same locale as the operating system locale. However, if the operating system locale does not match any of the specified locales, then ZENworks displays the prompt defined by the first locale in the list.

To create a message:

1. Click Add to display the Select Locale and Prompt dialog box.
2. Select a language from the Locale drop-down list. The message displays only on devices in the specified locale. You can create different messages, each with its own locale setting.
3. Specify the text you want to display on the device.

   **NOTE:** On a Macintosh and a Linux device, the new line character does not work. To display a message on a new line, you must use a `<br>` tag before the message.

4. Click OK.

Click Edit to change the prompt, or click Remove to delete the prompt.

6.5.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.6 Action - Distribute Files

The Distribute Files Action distributes the content of the bundle from the ZENworks Server to the managed device or user. There are no configuration tasks that you need to perform for this action.
6.7 Action - Edit INI File

The Action - Edit INI File dialog box lets you specify a configuration file and configure the list of changes to be performed on the file. You can also create a file, if one does not exist. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contain additional information:

- Section 6.7.1, “General,” on page 71
- Section 6.7.2, “Advanced,” on page 73
- Section 6.7.3, “Requirements,” on page 73

6.7.1 General

The General page lets you specify a configuration file and configure the list of changes to be performed on the file. You can also create a file, if one does not exist.

Filename

Specify the file that you want to change. For example, C:\Program Files\OpenOffice.org 2.0\program\setup.ini.

Encoding

Specify the encoding that you want to use:

- **Auto detect**: Use the encoding used in the original file that you specified in the Filename field. This is the default option.
- **ASCII**: Use ASCII encoding.
- **Unicode**: Use Unicode encoding.
- **UTF-8**: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

Create File, If Does Not Exist

Specify whether you want to create the file specified in the Filename field, if it does not exist. The file is created with the same name and the extension as specified in File Path. If the file specified in File Path does not have an extension, then the created file also does not have any extension.

If this option is selected and Encoding is set to Auto detect, the file is created in UTF-8 format with the same name and the extension as specified in File Path.
INI Changes

The INI Changes page lets you specify the INI file to change, add sections to the file, add keys to a section in the file, and import changes from another INI file.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following table lists the tasks you can perform to manage INI changes.

Table 6-1 INI Tasks

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specify the INI file to change</td>
<td>1. Specify the file that you want to change.</td>
<td>For example, C:\Program Files\OpenOffice.org 2.0\program\setup.ini.</td>
</tr>
</tbody>
</table>
| Add a section                 | 1. Click Add, then click New Section Change to open the Add a Change dialog box.  
                                         2. Fill in the fields, then click OK.  
                                         Click the Help button for additional information. |
| Add keys to a section         | 1. Click the section to which you want to add the keys.               | If you specify an existing section and add new keys to the list, then the existing section is updated with the newly added keys. For example, if a section sect1 with k1=v1 already exists and if you specify a new section sect1 with k1=v1, k2=v2, then the newly added key k2=v2 is added to sect1. |
| Edit an INI Change            | 1. Click the desired item you want to edit. The Add a Change dialog box is displayed. | The Section Change Type configured for the section is displayed by default in the Add Change dialog box. |
| Remove a section or keys      | 1. Select the check box next to the desired item, then click Delete.  |                    |
| Import INI changes from another file | 1. Click Import to display the Import INI Changes from File dialog box.  
                                         2. Specify the file from which you want to import changes, then click OK. |
| Change the order of items     | 1. Select the check box next to an item, click Edit, then select an option (Sort, Move Up, Move Down). |
6.7.2 Advanced

The Advanced page lets you create the file (if it does not exist), specify the number of backup files to retain, and specify key-value separators and comment characters.

Create File, If Does Not Exist: Specify whether you want to create the file specified in the Filename field, if it does not exist.

Number of File Backup(s) to Retain: Specify the number of backups of the INI file to retain. The default is 5 backup copies, but you can specify any number between 1 and 25. When the number of backup copies of the file exceeds the number specified here, the oldest backup file is overwritten.

Key-Value Separator: Specify the character you want to separate key values. You can use an equals sign (=) or a colon (:) as the separator.

Value Separator: Specify the character you want to separate the multiple values. You can use characters such as equals sign (=), comma (,), space ( ), hash (#), semicolon (;) or a colon (:).

Comment Character: Specify the character you want precede comments in the INI file. You can use a semicolon (;) or a pound sign (#).

Append key-value separator to the key when value is not available: Select this option to append the key-value separator to the key even if the value is not available. For example, in the setup.ini file used by Acrobat Reader*, the CmdLine key does not have a value but requires a key-value separator.

6.7.3 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.8 Action - Edit Text File

The Action - Edit Text File dialog box lets you specify a file and configure the list of changes to be performed on the file. You can also create a file, if one does not exist. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.8.1, “General,” on page 74
- Section 6.8.2, “Requirements,” on page 75

6.8.1 General

The General page lets you specify a file and configure the list of changes to be performed on the file. You can also create a file, if one does not exist.

Filename

Specify the file that you want to change. For example, ${SystemDrive}\Program Files\myfile.txt.

File Backup(s) to Retain

Specify the number of backups of the text file to retain. The default is 5 backup copies, but you can specify any number between 1 and 25. When the number of backup copies of the file exceeds the number specified here, the oldest backup file is overwritten.

Encoding

Specify the encoding that you want to use:

- Auto detect: Use the encoding used in the original file that you specified in the Filename field. This is the default option.
- ASCII: Use ASCII encoding.
- Unicode: Use Unicode* encoding.
- UTF-8: Use UTF-8 (8-bit UCS/Unicode Transformation Format) encoding.

File Operation > Specify Contents of the File

Use this option to specify the contents of the text file.

- Import Contents from an Existing File on this Device: Browse to and select the text file from which you want to import its contents.
- Contents of the File: Specify the contents of the newly created file.
File Operation > Specify Changes to the File

Use this option to specify the changes to the text file.

- **Change List**: Specify the changes that you want to make to the text file. Click **Add** to open the Add a Change dialog box, fill in the fields, then click **OK**. Click the **Help** button for additional information.

  You can edit or remove an entry, or you can use the **Move Up** and **Move Down** buttons to order the list. The changes to the file are made in the order listed.

- **Create File, If Does Not Exist**: Specify whether you want to create the file specified in the **Filename** field, if it does not exist.

- **Contents of the File**: If you selected the **Create File, If Does Not Exist** check box, specify the contents of the newly created file that is created if the specified file does not exist.

- **Apply Changes Configured in the Change List**: Specify whether you want to apply the changes that you added to the **Change List** box to the newly created file.

Run Action As

On Windows, specify **System** (the default) or **User** from the **Run Action As** list. Specify **System** if removing files requires access to all areas of the device's file system. If you use mapped network drives to specify files and directories, you must run the action as **User**.

On Linux, specify **root** (the default) or **User** from the list. Specify **root** only if the managed devices are run by the root user.

6.8.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.9 Action - End Process

The Action - End Process dialog box lets you specify the executable name of the process that you want to stop (for example, `notepad`, `mspaint`, `winword`, and so forth). If the process is not running on the device, the End Process task completes. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this information in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add dropdown list, then select an available action.

The following sections contains additional information:

- **Section 6.9.1, “General,” on page 76**
- **Section 6.9.2, “Requirements,” on page 76**
6.9.1 General

The General page lets you specify the executable name of the process that you want to stop (for example, notepad, mspaint, winword, and so forth). If the process is not running on the device, the End Process task completes.

6.9.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.10 Action - File Removal

The Action - File Removal dialog box lets you specify files or directories to remove from the device and the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

You can use this action to perform an automated system cleanup. For example, you can specify that the c:\windows\Temp\Temporary Internet Files directory and all files matching c:\windows\Temp\*.log are removed from the device.

On a Windows managed device, you cannot remove read-only files. If you specify a directory that contains several files (including some read-only files), the directory and the read-only files are not removed when the File Removal action runs. The files that are not read-only, however, are removed from the Windows device.

The following sections contains additional information:

- Section 6.10.1, “General,” on page 76
- Section 6.10.2, “Requirements,” on page 77

6.10.1 General

The General page lets you specify files or directories to remove from the device.

Full Path to Source Files/Directories

Specify the full path to the file or directory that you want to remove, then click Add to add the file or directory to the list. You can use wildcard characters. If you use a mapped network drive to specify the path, you must select User from the Run Action As list.

Include System Files

Select this option to remove system files. If you specify a directory for removal that includes both system and non-system files, only non-system files are deleted, unless you specify this option.
Delete Folder Only if Empty

Select this option if you want to remove the specified folders only if they are empty.

When a File is Locked, Retry _ Times, Every _ Seconds

If a file is locked when the action is performed, the file cannot be removed. Select the check box and then specify the number of retry attempts and the time interval between attempts. By default, the action is retried 3 times with 5 seconds between each attempt.

Run Action As

On Windows, specify System (the default) or User from the Run Action As list. Specify System if removing files requires access to all areas of the device’s file system. If you use mapped network drives to specify files and directories, you must run the action as User, else the action fails because system users do not have access to user mapped drive.

On Linux, specify root (the default) or User from the list. Specify root only if the managed devices are run by the root user.

6.10.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.11 Action - Install Bundle

The Action - Install Bundle dialog box lets you browse to and select the bundle to install on the device. The bundle is installed on the device even if it has not been previously assigned to that device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.11.1, “General,” on page 77
- Section 6.11.2, “Requirements,” on page 78

6.11.1 General

The General page lets you browse to and select the bundle to install on the device. The bundle is installed on the device even if it has not been previously assigned to that device.

Click [ ] to browse to and select the bundle to install on the device.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the down arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types of bundles are displayed. If you know the name of the bundle you are looking for, you can use the Item name box to search for the bundle.
Creating this action creates a bundle dependency. For more information, see Section 8.8, “Dependency Bundles,” on page 145.

6.11.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.12 Action - Install Directory

The Action - Install Directory dialog box lets you specify the directory to be installed, specify a destination path, specify whether the directory is hidden or read-only after being installed on the device, and specify a copy option. You can also specify the requirements that a device must meet for the action to be executed on the device.

Copying a file or directory copies the file or directory from one location to another without uploading the files into the ZENworks content repository. Copying a file or directory is described as copying without using content. When copying a file or directory, the managed device performs the copy operation and must be able to resolve both the source and destination paths. Also, when copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it is distributed to assigned devices. Installing a file or directory is described as copying using content. When installing a file or directory, the file or directory is cached on the managed device. If a directory does not have any content, it is not uploaded to the content repository. This causes any successive action depending on this empty directory to fail.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to the bundle.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the Install Directory bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.12.1, “General,” on page 78
- Section 6.12.2, “Requirements,” on page 81

6.12.1 General

The General page lets you specify the directory to be installed, specify a destination path, specify whether the directory is hidden or read-only after being installed on the device, and specify a copy option.
Source Directory

Click , allow browser to launch ZCC Helper. In the Select Directory dialog box, browse and select the directory you want to install on the device.

If you have not installed ZCC Helper on this device, you must do so before you can browse to and upload directories to be installed.

By default, the content uploaded to the ZENworks content repository is encrypted and compressed before it is distributed to assigned devices. However, if you do not want the content to be encrypted and compressed, then select the Do not compress or encrypt uploaded content option.

Select the Upload all files within the source directory as a single package option to enable all the files within the specified source directory to be uploaded as a single content. This option is helpful in scenarios where you choose to upload a large number of files. For example, selecting a Microsoft Office application as a source directory.

NOTE: You cannot upload an empty directory.

Upload Files As

Specifies whether the content has been uploaded as a single content or multiple contents to the ZENworks content repository.

- If the Upload all files within the source directory as a single package option in the Select Directory dialog box is not selected, then the files are uploaded by packaging in to multiple contents and the value of Upload Files As option is displayed as Multiple Content.
- If the Upload all files within the source directory as a single package option in the Select Directory dialog box is selected, then the files are uploaded by packaging in to single content and the value of Upload Files As option is displayed as Single Content.

NOTE

When you select the Upload all files within the source directory as a single package option, if there are an empty sub directories with the directory, they will be ignored.

Packaging

Specifies how the content is packaged before it is distributed to assigned devices.

If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is not selected, the value of Packaging option is initially displayed as Auto as the content is in the process of being encrypted and compressed. After the content has been encrypted and compressed, the value of Packaging option changes to Compressed, Encrypted.

If the Do not compress or encrypt uploaded content option in the Select Directory dialog box is selected, the value of Packaging option is displayed as None because the content is neither compressed nor encrypted.

Destination Directory

Specify the destination directory on the device in which you want to install the directory.
Hidden
Select the **Hidden** check box to specify that the directory is hidden after installation.

Read-Only
Select the **Read-only** check box to specify that the directory is read-only after installation.

Copy Option
Select a copy option from the list:

- **Copy Always**: Copies the contents of the directory regardless of whether the files currently exist on the workstation.
- **Copy If Exists**: Copies the contents of the directory only if the files currently exist on the workstation.
- **Copy If Does Not Exist**: Copies the contents of the directory only if the files do not currently exist on the workstation.
- **Copy If Newer**: Copies the contents of the directory only if the modified date and time of the file is newer than the existing file’s date and time, or if the files do not currently exist on the workstation.
- **Copy If Newer and Exists**: Copies the contents of the directory only if it already exists on the workstation and the date and time of the file is newer than the existing file’s date and time.
- **Copy If Newer Version**: Copies the contents of the directory only if the internal version of the file is newer than the existing file’s version (if version information is present).
- **Request Confirmation**: Prompts the user to confirm that the content of the directory should be copied when the directory already exists on the workstation.
- **Copy If Different**: Copies the contents of the directory if the creation date, creation time, or size is different than the existing file’s date, time, or size.

Executable Security Level
On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the “user” space or the “system” space. By default, the **Run normal** option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user’s security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

- **Run as logged in user**: The action uses the logged-in user’s credentials. For example, the action has the same rights to the registry and the file system as the logged-in user.
- **Run as secure system user (Don’t allow system to interact with desktop)**: The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application’s interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention. If you use mapped network drives to specify files and directories, the action fails because system users do not have access to user mapped drives.
Run as dynamic administrator: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see “Using the Credential Vault” in the ZENworks Control Center Reference.

NOTE: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.12.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.13 Action - Install Files

The Action - Install Files dialog box lets you specify the file to copy to the content server and from content server to the device, the destination directory and filename, and the copy options. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the Install Files bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.13.1, “General,” on page 81
- Section 6.13.2, “Requirements,” on page 83

6.13.1 General

The General page lets you specify the file to copy to the content server and from content server to the device, the destination directory and filename, and the copy options. Click Add to display the Select Files dialog box.

The Select Files dialog box lets you specify the files to be copied, specify a destination and source directory, specify whether the files are hidden or read-only after being copied to the device, and specify a copy option.
Copying a file or directory copies the file or directory from one location to another without uploading the files into the ZENworks content repository. Copying a file or directory is described as copying without using content. When copying a file or directory, the managed device performs the copy operation and must be able to resolve both the source and destination paths. Also, when copying a file or directory, the file or directory is not cached on the managed device.

Installing a file or directory uploads the file or directory to the ZENworks content repository before it is distributed to assigned devices. Installing a file or directory is described as copying using content. When installing a file or directory, the file or directory is cached on the managed device.

Installing an executable file does not launch or execute the file. To launch or execute the file, you must add a launch executable action (Launch Executable, Launch Java Application, and so forth) to the bundle.

File

Click Add, allow browser to launch ZCC Helper. The Select Files dialog box is displayed, click Add, select the files you want to copy to the device, and then click Upload. Repeat this step as many times as necessary to copy the desired files.

If ZCC Helper is not installed on this device, you must install it before you can browse for file paths.

By default, the content uploaded to the ZENworks content repository is encrypted and compressed before it is distributed to assigned devices. However, if you do not want the content to be encrypted and compressed, then select the Do not compress or encrypt uploaded content option.

Destination Directory

Specify the destination directory on the device in which you want to install the file.

Copy Option

Select a copy option from the list:

- **Copy Always**: Copies the file regardless of whether the file currently exists on the workstation.
- **Copy If Exists**: Copies the file only if the file currently exists on the workstation.
- **Copy If Does Not Exist**: Copies the file only if the file does not currently exist on the workstation.
- **Copy If Newer**: Copies the file only if its modified date and time is newer than the existing file’s date and time, or if the file does not currently exist on the workstation.
- **Copy If Newer and Exists**: Copies the file only if it already exists on the workstation and the date and time of the file is newer than the existing file’s date and time.
- **Copy if Newer Version**: Copies the file only if its internal version is newer than the existing file’s version (if version information is present).
- **Request Confirmation**: Prompts the user to confirm that the file should be copied when the file already exists on the workstation.
- **Copy If Different**: Copies the file if its creation date, creation time, or size is different than the existing file’s date, time, or size.

Hidden

Select the Hidden check box to specify that the file is hidden after installation.
Read-Only

Select the Read-only check box to specify that the file is read-only after installation.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the "user" space or the "system" space. By default, the Run normal option is selected, which causes the application to run in the "user" space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the "system" space or as a dynamic administrator, as described below:

- **Run as logged in user**: The action uses the logged-in user's credentials. For example, the action has the same rights to the registry and the file system as the logged-in user.

- **Run as secure system user (Don't allow system to interact with desktop)**: The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application's interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention. If you use mapped network drives to specify files and directories, the action fails because system users do not have access to user mapped drives.

- **Run as dynamic administrator**: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

- **Select credential for network access**: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see “Using the Credential Vault” in the ZENworks Control Center Reference.

---

**NOTE:** Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

### 6.13.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.14 Action - Install MSI

The Action - Install MSI dialog box lets you specify the location of the MSI file; its Install, Uninstall, and Repair parameters; the transform file; and the executable security level. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the MSI Application bundle category. For more information, see Section 2.5, "Creating Windows Bundles," on page 26.
- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contain additional information:

- Section 6.14.1, "General," on page 84
- Section 6.14.3, "Requirements," on page 86

6.14.1 General

The General page lets you specify the location of the MSI file; its Install, Uninstall, and Repair parameters; the transform file; and the executable security level.

.msi File

Click , allow browser to launch ZCC Helper. The Select .msi File dialog box is displayed, click browse and select the .msi file to install.

Select the Include all files in and below the directory of this file option to include all the supporting files that are within the directory containing the .msi file and the subdirectories within it.

If you have not installed the ZCC Helper on this device, you must do so before you can browse to and upload files.

Install Parameters

Click to display the Install Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.

Uninstall Parameters

Click to display the Uninstall Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.

Repair Parameters

Click to display the Repair Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.
**MSI Properties**

The MSI package contains the property values that were defined during the administrative installation of the application. These property values determine the way the Microsoft Windows Installer installs the application to the workstation. In some cases, you might want to change one or more of the property values. For example, a property value might define the default location for a user’s work files. By adding the property to the list and changing the property’s value, you can override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing so, you should be careful to add only those properties that are valid for the package. The following options are available:

- **Add**: To override a property value, you change the property value and add the property to the Properties list so that Application Launcher knows to use that property value rather than the one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In the Name field, select the property whose value you want to override, specify the new value in the Value field, then click OK to add the property to the MSI Properties list.

- **Edit**: To modify a property that is in the MSI Properties list, select the property, click Edit, modify the value data, then click OK.

- **Remove**: To remove a property from the MSI Properties list, select the property, then click Remove. Deleting the property causes future installations of the application to use the property value defined in the MSI package.

**IMPORTANT**: The total length of the MSI Properties and the Install Parameters should not exceed 1024 characters.

---

**6.14.2 Advanced**

**Transform File**

Click Add, in the Select Transform File dialog box click , allow browser to launch ZCC Helper. In the Select Transform File dialog box, click Browse, select the desired transform file, and then click Upload. You can upload the transform file or you can specify its location.

If you have not installed ZCC Helper on this device, you must do so before you can browse for a file.

Different groups within an organization often use the same application, but they might not require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 10 different feature sets or other alterations for the same application, you can deploy the same MSI package to all 10 user groups, but with a different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification information, such as whether features are installed; how they are installed; which files, shortcuts, and registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create and manage transforms.
Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the “user” space or the “system” space. By default, the Run normal option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user’s security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

- **Run as logged in user**: The MSI application inherits the logged-in user’s credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.

  Select the application’s display mode: Normal, Minimized, Maximazed, or Hidden. In Hidden mode, the application runs normally without a user interface available. This is useful if you want the application to process something, then go away without user intervention.

  Select Grant administrator privilege to user during installation to provide administrator privileges to the logged-in user. However, providing administrator privileges to a user might pose security risks. If this option is selected, the user on the managed device is prompted to enter the password when the MSI is installed on the device. To install the MSI, the user must log in to the device with a user account that has a password configured.

  **NOTE**: On a Vista device, if the administrator is logged in to the device and the Grant administrator privilege to user during installation is selected, the action is performed in the quiet mode.

- **Run as secure system user (Don’t allow system to interact with desktop)**: The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application's interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention.

- **Run as dynamic administrator**: A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

  You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

  **NOTE**: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.14.3 **Requirements**

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.15 **Action - Install MSP**

The Action - Install MSP dialog box lets you specify the location of the MSP file, command line parameters, and executable security level. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the **MSP Application** bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.
- In ZENworks Control Center, click the **Bundles** tab, click the underlined link of a bundle in the **Name** column of the **Bundles** list, click the **Actions** tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the **Add** drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.15.1, “General,” on page 87
- Section 6.15.2, “Requirements,” on page 88

### 6.15.1 General

The Action - Install MSP dialog box lets you specify the location of the MSP file, command line parameters, and executable security level.

#### .msp File

Click ![Select .msp File](image), allow browser to launch ZCC Helper. In the **Select .msp File** dialog box, click browse and select the MSP file, and then click **Upload**. You can also enter the UNC path of the .msp file for a network install.

If you have not installed ZCC Helper on this device, you must do so before you can browse for a file path.

#### Command Line Parameters

Specify the command line parameters that you want to run when the MSP file is installed.

#### Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the “user” space or the “system” space. By default, the **Run normal** option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user’s security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

- **Run as logged in user**: The MSI application inherits the logged-in user’s credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.
Select the application’s initial window size: Normal, Minimized, Maximized, or Hidden. In Hidden mode, the application runs normally without a user interface available. This is useful if you want the application to process something then go away without user intervention.

- **Run as secure system user (Don't allow system to interact with desktop):** The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application’s interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention.

- **Run as dynamic administrator:** A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

  You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

---

**NOTE:** Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

### 6.15.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

### 6.16 Action - Install Network MSI

The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install, Uninstall, and Repair parameters; transform file; and executable security level. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- **Section 6.16.1, “General,” on page 88**
- **Section 6.16.2, “Advanced,” on page 90**
- **Section 6.16.3, “Requirements,” on page 91**

### 6.16.1 General

The Action - Install Network MSI dialog box lets you specify the location of the MSI file; its Install, Uninstall, and Repair parameters; the transform file; and the executable security level.
.msi File

Click Browse, allow browser to launch ZCC Helper. In the Select File dialog box, click Browse, select the .msi file to install, and then click OK.

If you have not installed ZCC Helper on this device, you must do so before you can browse for a file.

Install Parameters

Click to display the Install Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.

Uninstall Parameters

Click to display the Uninstall Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.

Repair Parameters

Click to display the Repair Parameters dialog box, then specify the desired parameters. Click the Help button for additional information.

MSI Properties

The MSI package contains the property values that were defined during the administrative installation of the application. These property values determine the way the Microsoft Windows Installer installs the application to the workstation. In some cases, you might want to change one or more of the property values. For example, a property value might define the default location for a user’s work files. By adding the property to the list and changing the property’s value, you can override the default location defined in the MSI package.

If necessary, you can add public properties that were not included in the MSI package. When doing so, you should be careful to add only those properties that are valid for the package. The following options are available:

- **Add**: To override a property value, you change the property value and add the property to the Properties list so that Application Launcher knows to use that property value rather than the one defined in the MSI package. To do so, click Add to display the MSI Properties dialog box. In the Name field, select the property whose value you want to override, specify the new value in the Value field, then click OK to add the property to the MSI Properties list.

- **Edit**: To modify a property that is in the MSI Properties list, select the property, click Edit, modify the value data, then click OK.

- **Remove**: To remove a property from the MSI Properties list, select the property, then click Remove. Deleting the property causes future installations of the application to use the property value defined in the MSI package.
6.16.2 Advanced

Transform File

Click Add, in the Select Transform File dialog box click , allow browser to launch ZCC Helper. In the Select Transform File dialog box, click Browse, select the desired transform file, and then click Upload. You can upload the transform file or you can specify its location.

If you have not installed ZCC Helper on this device, you must do so before you can browse to for a file path.

Different groups within an organization often use the same application, but that doesn’t mean they require the same feature set. One of the benefits of Windows Installer is that if you have 10 groups needing 10 different feature sets or other alterations for the same application, you can deploy the same MSI package to all 10 user groups, but with a different transform file (MST) applied for each group.

A transform file is a collection of changes applied to an MSI installation. It contains all modification information, such as whether features are installed; how they are installed; which files, shortcuts, and registry entries are included; and Add/Remove Programs applet information.

If you have vendor-supplied MSI packages, you can use AdminStudio ZENworks Edition to create and manage transforms.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the “user” space or the “system” space. By default, the Run normal option is selected, which causes the application to run in the “user” space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the “system” space or as a dynamic administrator, as described below:

- Run as logged in user: The MSI application inherits the logged-in user’s credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.

  Select the application’s display mode: Normal, Minimized, Maximzed, or Hidden. In Hidden mode, the application runs normally without a user interface available. This is useful if you want the application to process something, then go away without user intervention.

  Select Grant administrator privilege to user during installation to provide administrator privileges to the logged-in user. However, providing administrator privileges to a user might pose security risks. If this option is selected, the user on the managed device is prompted to enter the password when the MSI is installed on the device. To install the MSI, the user must log in to the device with a user account that has a password configured.

NOTE: On a Vista device, if the administrator is logged in to the device and the Grant administrator privilege to user during installation is selected, the action is performed in the quiet mode.
Run as secure system user (Don't allow system to interact with desktop): The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application's interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention.

Run as dynamic administrator: A dynamic administrator is an administrator account that is locally created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. Because the dynamic administrator does not have access to the network, the network shares on which the MSI is available must be made publicly accessible. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see Using the Credential Vault in the ZENworks Control Center Reference.

NOTE: Performing this action as a dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.16.3 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.17 Action - Launch Bundle

The Action - Launch Bundle dialog box lets you specify the bundle to launch on the device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.17.1, “General,” on page 92
- Section 6.17.2, “Requirements,” on page 92
6.17.1 General

The General page lets you specify the bundle to launch on the device. Click  to display the Select the Bundle to Launch dialog box.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the down- arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types of bundles are displayed (Linux, Preboot, and Windows bundles). Also, if you know the name of the bundle you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.8, “Dependency Bundles,” on page 145.

6.17.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.18 Action - Launch Java Application

The Action - Launch Java Application dialog box lets you configure a Java program to be executed on the managed device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.18.1, “General,” on page 92
- Section 6.18.2, “Advanced,” on page 93
- Section 6.18.3, “Requirements,” on page 95

6.18.1 General

The General page lets you configure a Java program to be executed on the managed device.

Java Program Name

Specify the Java program name. For example, com.novell.TestProg.

Program Parameters

Specify the program parameters.

Path to Java Runtime Executable (JRE)

Specify the path to the Java Runtime Executable (JRE).
JRE Parameters
Specify the JRE parameters.

Wait Before Proceeding to Next Action
Specify what happens after the Java application launches:

- **No wait**: The next action in the list is immediately performed.
- **When launch action is complete**: The next action in the list is performed after the launch action completes.
- **Wait for _ seconds**: Wait the specified number of seconds before proceeding to the next action.
- **Terminate action if wait period exceeded**: If you select the Wait for _ seconds option, this option is enabled. If the specified number of seconds is exceeded and the action is not successfully performed, the action is terminated.

Run As
Click More Options to specify the Java application’s Run As settings.

- **System**: Runs the application as the system account (as a service).
- **Administrator**: Runs the application as a dynamic administrator user. A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications or running scripts. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

  **NOTE**: Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

- **User**: The application runs using the logged-in user’s credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.

The following options are available for Linux:

- **Root**: The application runs only if the root user is logged in to the device.
- **User**: The application runs using the logged-in user’s credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.

6.18.2 Advanced

Working Directory
Click More Options to specify the Java application’s working directory.

Specify the initial working directory for the application.
Success Return Codes

Specify the non-zero success codes that the executable returns. You can specify multiple success codes separated by commas.

If an executable returns non-zero success codes, you should specify these non-zero success codes while launching the action. For example, explorer.exe in Windows returns a success code of 1. To successfully launch the Explorer application, you should add 1 as the success code while launching the action.

If you leave this field blank, zero will be considered as the success code. Specify the Success Return Code as * to enable any non-zero code returned by a script to be treated as success.

Priority

Click More Options to specify the Java application's priority.

Specify the priority of the process that runs the application. This option lets you configure how much of the CPU usage the application process consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal, and Low.

Executable Security Level

On Windows 2000, Windows XP, Windows Vista, or Windows 7 device, the application executable can run in either the "user" space or the "system" space. By default, the Run normal option is selected, which causes the application to run in the "user" space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the application, you can configure the application to run in the "system" space or as a dynamic administrator, as described below:

- **Run as logged in user:** The MSI application inherits the logged-in user's credentials. For example, the application has the same rights to the registry and the file system as the logged-in user.

  Select the application’s display mode: Normal, Minimized, Maximized, or Hidden. In Hidden mode, the application runs normally without a user interface available. This is useful if you want the application to process something, then go away without user intervention.

  Select Grant administrator privilege to user during installation to provide administrator privileges to the logged-in user. However, providing administrator privileges to a user might pose security risks. If this option is selected, the user on the managed device is prompted to enter the password when the MSI is installed on the device. To install the MSI, the user must log in to the device with a user account that has a password configured.

  **NOTE:** On a Vista device, if the administrator is logged in to the device and the Grant administrator privilege to user during installation is selected, the action is performed in the quiet mode.

- **Run as secure system user (Don't allow system to interact with desktop):** The application is run under the Local System user and inherits Administrator-level credentials. For example, the application has full rights to the registry and the file system. Because the security level is set to Secure, the application’s interface is not displayed to the user and the application is only visible in the Task Manager. This option is useful when running applications that require full access to the workstation but require no user intervention.
Run as dynamic administrator: A dynamic administrator is an administrator account that is locally created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. Because the dynamic administrator does not have access to the network, the network shares on which the MSI is available must be made publicly accessible. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

Select credential for network access: If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

For more information on Credential Vault and adding credential to the Credential Vault, see “Adding a Credential” in the ZENworks Control Center Reference.

NOTE: Performing this action as a dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

6.18.3 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.19 Action - Launch URL

The Action - Launch URL dialog box lets you specify the URL to launch on the device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

NOTE: When you create a bundle and select the Launch URL action, then assign the bundle to a device, each action launches the URL in a new tab in the same window.

In a whitelisted environment, the Launch URL action might not work as expected. By default, the whitelisting feature is disabled for the Launch URL action. To enable the Launch URL action to work in a whitelisted environment, you need to add a registry String value named UseShellExecute, to HKLM\Software\Novell\ZCM\AgentSettings, and set the value data to false. However, when the whitelisting feature is enabled, the action launches the URL in a new browser window instead of a new tab.

The following sections contains additional information:

- Section 6.19.1, “General,” on page 96
- Section 6.19.2, “Requirements,” on page 96
6.19.1 General

The General page lets you specify the URL to launch on the device. Click Test URL to open a Web browser to verify that the URL is correct.

6.19.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.20 Action - Launch Executable

The Add Actions - Launch Executable dialog box lets you specify the Windows executable, command line parameters, and additional optional settings. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.20.1, “General,” on page 96
- Section 6.20.2, “Advanced,” on page 97
- Section 6.20.3, “Launch Options,” on page 98
- Section 6.20.4, “Requirements,” on page 99

6.20.1 General

The General page lets you specify the location of the Windows executable, the command line parameters to run when the executable launches, the working directory for the executable, and the non-zero success codes that the executable returns.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Specify the location of the Windows executable, including its filename.</td>
</tr>
</tbody>
</table>

You can specify a local path or a network drive. If you specify the local path, you must include the executable’s full path, unless the executable is included in the workstation’s search path. If you specify a network drive, you can use a mapped drive or a UNC path, if the workstation can resolve the path.

If you have not installed ZCC Helper on this device, you must do so before you can browse for a file path.

<table>
<thead>
<tr>
<th>Command Line Parameters</th>
<th>Specify the command line parameters that you want to run when the executable launches.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Working Directory</td>
<td>Specify the working directory for the executable.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Success Return Codes</strong></td>
<td>Specify the non-zero success codes that the executable returns. You can specify multiple success codes separated by commas. If an executable returns non-zero success codes, you should specify these non-zero success codes while launching the action. For example, explorer.exe in Windows returns a success code of 1. To successfully launch the Explorer application, you should add 1 as the success code while launching the action. If you leave this field blank, zero will be considered as the success code. Specify the Success Return Code as * to enable any non-zero code returned by a script to be treated as success.</td>
</tr>
</tbody>
</table>
| **Environment Variables**    | Lets you add, edit or remove the environment variables as follows:  
  - **Add**: Click Add to display the Add Environment Variable dialog box. Specify the name and value of the environment variable you want to add. For example, Name = JAVA_HOME; Value = C:\java1.4\.  
  **NOTE**: Add the ZENPREDEF_REDIRECTSTANDARDOUTPUT predefined environment variable and set it to true to redirect the standard output of a variable or command to the specified file or location. For example, if the command line parameter is /c echo%var% > c:\temp\test.txt, the standard output of var will be redirected to c:\temp\test.txt file.  
  - **Remove**: Select the environment variables to remove and click Remove.  
  - **Edit**: Select the environment variable you want to edit, then click Edit. In the Edit Environment Variable dialog box, specify the new value for the variable. For example, Name = JAVA_HOME; Value = C:\Program Files\Java\jdk1.6.0_06. |

### 6.20.2 Advanced

The Advanced page lets you specify the Window executable’s security level and the wait time after launch of windows executable and before proceeding to the next action.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Wait Before Proceeding to Next Action** | Click More Options to specify how long to wait after launching the Windows executable and before proceeding to the next action. Specify what happens after the executable launches:  
  - **No wait**: The next action in the list is immediately performed.  
  - **When launch action is complete**: The next action in the list is performed after the launch action completes. For example, enable this option if you are running the action as a dynamic administrator and you want the profile cleaned up and deleted immediately. If you do not enable this option, the profile is cleaned up and deleted at the device’s next reboot.  
  - **Wait for _ seconds**: Wait the specified number of seconds before proceeding to the next action.  
  - **Terminate action if wait period exceeded**: If you select the Wait for _ seconds option, this option is enabled. If the specified number of seconds is exceeded and the action is not successfully performed, the action terminates. |
The Launch Options page lets you specify the Window executable’s compatibility mode, display settings, and the input settings.

### Executable Security Level

The executable can run in either the "user" space or the "system" space. By default, the **Run normal** option is selected, which causes the application to run in the "user" space and inherit the same workstation security level as the logged-in user.

If the logged-in user's security level does not provide sufficient rights and file access to run the executable, you can configure the executable to run in the "system" space or as a dynamic administrator, as described below:

- **Run as logged in user:** The executable inherits the logged-in user's credentials. For example, the executable has the same rights to the registry and the file system as the logged-in user.

  Select the executable's initial window size: **Normal**, **Minimized**, **Maximized**, or **Hidden**. In Hidden mode, the executable runs normally without a user interface available. This is useful if you want the executable to process something, then go away without user intervention.

- **Run as secure system user (Don't allow system to interact with desktop):**

  The executable is run under the Local System user and inherits Administrator-level credentials. For example, the executable has full rights to the registry and the file system. Because the security level is set to **Secure**, the executable's interface is not displayed to the user and the executable is only visible in the Task Manager. This option is useful when running executables that require full access to the workstation but require no user intervention.

- **Run as dynamic administrator:** A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

  When performing actions as a dynamic administrator, ensure that you select the **When action is compete** option in the **Wait before proceeding to next action** group box. Selecting this option ensures that the action is completed and the process has terminated and released its resources before ZENworks begins cleaning up and deleting the dynamic administrator account.

  You cannot use mapped network drives to specify files and directories because dynamic administrators do not have access to mapped drives.

- **Select credential for network access:** If the file or directory specified in the action are a part of the UNC path or network share that can be accessed only through credentials, then browse through the credential vault to select a credential that has access to the network.

  For more information on Credential Vault and adding credential to the Credential Vault, see "Using the Credential Vault" in the **ZENworks Control Center Reference**.

  **NOTE:** Performing this action as dynamic administrator on a Windows domain controller fails because Microsoft does not allow the use of local administrator accounts on domain controllers.

### 6.20.3 Launch Options

The Launch Options page lets you specify the Window executable’s compatibility mode, display settings, and the input settings.
The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Compatibility Mode                   | Click More Options to specify the Window executable’s compatibility mode.  

Launches the executable in a contained environment. Some executables cannot run on workstations with newer versions of Microsoft* Windows because of incompatibility issues. The drop-down list is available after you select the Compatibility mode option.  

Select this option if you successfully ran an executable on a previous Windows version but you are unable to run the executable on the device’s current Windows version. Select the desired platform from the list.  

| Display                               | Click More Options to specify the Window executable’s display settings.  

Select the desired display options: Run in 256 colors: Sets the color quality setting to 256 colors while this executable is running. The color quality setting reverts back to your default setting when you close the executable. Run in 640 × 480 screen resolution: Sets the screen resolution setting to 640 × 480 while this executable is running. The color quality setting reverts back to your default setting when you close the executable. Disable visual themes: Disables visual themes from being applied to the executable. If you are experiencing problems with menus or buttons on the title bar of the executable, this setting might solve these problems. The theme settings revert back to your default setting when you close the executable.  

| Input Settings                        | Click More Options to specify the Window executable’s input settings.  

Temporarily turns off handwriting recognition, speech recognition, and some accessibility features. Turning off text services does not affect multiple languages or keyboards that you have added.  

| Use the operating system shell to start the process | This option is enabled by default and allows the executable specified in the action to be launched through the operating system shell.  

Deselect this option to prevent the executable specified in the action from being launched through the operating system shell. Consequently, the executable can now be launched only through the applications configured in the system’s list of allowed applications.  

To add applications to the system’s list of the allowed applications:  

1. In the ZENworks Control Center, create a new Windows Group Policy.  
2. In the Windows Group Policy settings page, select Local Group Policy and click Configure.  
3. In the Group Policy window, navigate to User Configuration > Administrative Templates > System.  
4. Double-click Run only allowed Windows applications.  
5. In the Settings tab, select Enabled and click Show.  
6. In the Show Contents window, click Add and enter the name of the application as zapp-launcher.exe and click OK.  
7. Click Apply, then OK.  

You can now launch the executable only if it is available in the NAL window.  

**6.20.4 Requirements**

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.21 **Action - Launch Macintosh Executable**

The Add Action - Launch Macintosh Executable dialog box lets you to specify the filename, parameters, security level, and environment variables. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.21.1, “General,” on page 100
- Section 6.21.2, “Requirements,” on page 101

**6.21.1 General**

The General page lets you specify the filename, parameters, security level, and environment variables.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Executable File Name</td>
<td>Specify the filename of the Macintosh executable.</td>
</tr>
<tr>
<td>Executable File Parameters</td>
<td>Specify the parameters that you want to run while launching the executable.</td>
</tr>
<tr>
<td>Executable Security Level</td>
<td>Specify the Macintosh executable’s security level.</td>
</tr>
<tr>
<td></td>
<td>You can choose any of the following options and configure the executable:</td>
</tr>
<tr>
<td></td>
<td><strong>Run normal (as logged in user):</strong> The executable is launched only if the</td>
</tr>
<tr>
<td></td>
<td>user logs in to the device.</td>
</tr>
<tr>
<td></td>
<td><strong>Run as root:</strong> The executable is launched only if the root user is logged</td>
</tr>
<tr>
<td></td>
<td>in to the device.</td>
</tr>
<tr>
<td>Wait before proceeding to next action</td>
<td>Specify the wait time before proceeding to the next action after launching the Macintosh executable.</td>
</tr>
<tr>
<td></td>
<td><strong>No wait:</strong> Select this option to immediately perform the next action in the list.</td>
</tr>
<tr>
<td></td>
<td><strong>When action is complete:</strong> Select this option to perform the next action in the list after the launch action finishes.</td>
</tr>
<tr>
<td></td>
<td><strong>Wait for _ seconds:</strong> Select this option to proceed to the next action after the specified number of seconds.</td>
</tr>
</tbody>
</table>

- **Terminate action if wait period is exceeded:**

  This check box is enabled only if you select the **Wait for _ seconds** option. Select this check box to terminate the action if the action is not performed after the wait time exceeds the specified number of seconds.
6.21.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.22 Action - Launch Windows Thin Client Application

The Action - Launch Windows Thin Client Application dialog box lets you specify to launch an ICA (Independent Computing Architecture) or RDP (Remote Desktop Protocol) client session and configure the appropriate settings.

You can also specify the specific requirements that a device must meet for the action to be executed on the device.

You can access this information by using the following methods:

- As part of the process of creating a Windows bundle by using the Thin Client Application bundle category. For more information, see Section 2.5, “Creating Windows Bundles,” on page 26.

- In ZENworks Control Center, click the Bundles tab, click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.
The following sections contain additional information:

- Section 6.22.1, "General," on page 102
- Section 6.22.2, "Requirements," on page 103

6.22.1 General

The General page lets you specify to launch an ICA (Independent Computing Architecture) or RDP (Remote Desktop Protocol) client session and configure the appropriate settings.

ICA Session

Select this option if the terminal server requires the application to run in an ICA client session. Citrix MetaFrame requires ICA client sessions.

**Published Application Name:** Type the published application name exactly as it is defined in Citrix.

**Servers Hosting the Application:** Add the Citrix servers that host the application.

1. Type the server’s IP address or hostname.
2. Click Add.

The order in which the servers are listed is the preferred order for launching. You can use the Move Up and Move Down buttons to change the order if necessary.

To set user domain name:

When creating a windows bundle, you should create the Edit INI Files action, add `Domain=[CustomerDomain]` as key, and then add the Launch Windows Thin Client Application action to set the user domain name.

For more information on Edit INI files, see Section 6.7, "Action - Edit INI File," on page 71.

If the Selecting the Append key-value separator to the key when value is not available option is selected, then the thin client bundle action enables you to pass-through a user domain name.

RDP Session

Select this option if the terminal server requires the application to run in an RDP client session. Microsoft Windows Terminal Server requires RDP client sessions.

**Terminal Server Address:** Specify the terminal server’s IP address or hostname.

**Server Port:** If the terminal server is not using default port 3389, specify the correct port number.

**Server Domain:** If the terminal server is part of a Windows NT domain or an Active Directory domain, specify the domain name. If the user’s name and password in the domain matches the user name and password in Novell eDirectory, the user is not prompted to log in to the terminal server when launching the application.

**Application Path:** Specify the path to the application’s executable file from the perspective of the terminal server.

**Application Working Directory:** Specify the path to the directory you want the application to use for its working files.

**Color Depth:** Select the number of colors for the RDP client session. You can select 256 Colors, High Color (15 bits), High Color (16 bits), or True Color (24 bits). The default is True Color (24 bits).
Screen Size: If you want the RDP client session to use the entire desktop area, select Operate in full screen mode. Otherwise, select Use specified screen size and manually set the width and height (in pixels).

Advanced Settings for redirection: Select the settings, such as drivers, printers, serial ports, and smart cards, that you want to map to the remote desktop machine.

6.22.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.23 Action - Prompt User

The Action - Prompt User dialog box lets you specify that a prompt displays on the device and configure its settings. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.23.1, “General,” on page 103
- Section 6.23.2, “Requirements,” on page 105

6.23.1 General

The General page lets you specify that a prompt displays on the device and configure its settings.

User Cancels Allowed

Specify the number of times that you can cancel the remaining actions in the action set.

Set the value of the CancelOnNoResponse registry key to 1 to cancel the remaining actions in the action set. See CancelOnNoResponse in the ZENworks Registry Keys Reference.

In addition to the prerequisite above, you need to define the prompts in the Add Action - Prompt User page. In the Define Prompt(s) table, click Add to select the locale and the prompt. In the Prompt field, in the Select Locale and Prompt dialog box, do the following:

- Include {0} in your text to provide a running counter that counts down the number of seconds to 0.
- Include {1} for prompting the number of cancels or postpones allowed.
- Include {2} for prompting the remaining cancels or postpones allowed.

For example, you can specify the following text:

Scheduled Updates: Updates will be applied if there is no response within {0} time. You have {2} attempts left out of {1} to postpone this activity.
If the action set installs an application that requires a reboot, and you select this option, you can cancel the reboot. This will in turn, cancel the installation. The install action set is performed again according to its schedule. For this reason, use this option carefully. There is no Cancel button on the dialog box if you use the default setting of 0.

If the value of the User Cancels Allowed field is 5, you can cancel the install up to 5 times. The number of cancels remaining is also displayed.

**NOTE:** If you configure the Prompt User action, with the User Cancels Allowed value set as 1 or more, the Cancel or Postpone button is displayed depending on the ShowCancelInPrompt registry key. If the value of this registry key is set to True then the Prompt User action, configured with the User Cancels Allowed option will display the Cancel button, else it will display the Postpone button. For more information, see ShowCancelInPrompt in the ZENworks Registry Keys Reference.

**Seconds to be Displayed**

Specify the number of seconds that the prompt is displayed before the action is performed. For example, you configure a prompt that appears during an application installation before the device performs a required reboot. If you specify that the user can cancel the action set and you enter 10 seconds as the value of the Seconds to be Displayed field, the prompt displays for 10 seconds and then the device reboots.

The reboot control and the prompt control messages display the time in hours, minutes and seconds.

For example, if you define the option (0) in the Prompt field and enter 3606 as the value in the Seconds to be Displayed field, then the message displays the time as 1:00:06.

**How Often to Prompt**

Select the desired option:

- **Always:** Display the prompt every time the action is performed.
- **Once per device:** Display the prompt once on the device, regardless of how many users log in.
- **Once per user:** Display the prompt once per user, regardless of how many devices the user logs in to.

**Define Prompts**

Define the prompt that you want to display on the device. Additionally, you can specify different locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the prompt defined in the same locale as the operating system locale. However, if the operating system locale does not match any of the specified locales, then ZENworks displays the prompt defined by the first locale in the list.

To create a message:

1. Click Add to display the Select Locale and Prompt dialog box.
2. Select a language from the Locale drop-down list. The message displays only on devices in the specified locale. You can create different messages, each with its own locale setting.
3. Type the text you want to display on the device.
NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a message on a new line, you must use a <br> tag before the message.

You can include \{0\} in your text to provide a running counter that counts down the number of seconds to 0, after which the prompt is auto-accepted. For example, you could specify the following text:

The machine will reboot in \{0\} seconds. Please save your work and close any open applications.

The message displays for the number of seconds specified in the **Seconds to be Displayed** field.

4. Click OK.

### 6.23.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see [Requirements](#).

### 6.24 Action - Reboot/Shutdown

The Action - Reboot/Shutdown dialog box lets you specify the reboot or shutdown action for the device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the **Bundles** tab. Click the underlined link of a bundle in the **Name** column of the **Bundles** list, click the **Actions** tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the **Add** drop-down list, then select an available action.

**NOTE:** The Reboot action should not normally be used in conjunction with a Recurring launch set to **When a device is refreshed**. Although there are some valid use scenarios for this configuration, scheduling a device to reboot upon refresh can cause a continuous loop.

The following sections contains additional information:

- Section 6.24.1, “General,” on page 105
- Section 6.24.2, “Requirements,” on page 107

### 6.24.1 General

The General page lets you specify the reboot or shutdown action for the device.

**Reboot**

Reboot the device when this action is performed.

**Shutdown**

Shut down the device when this action is performed.
**Time to Wait Before Reboot/Shutdown**

Specify the number of seconds (between -1 and 1800) before the device reboots or shuts down. When the number of seconds specified passes, the device reboots or shuts down, regardless of whether the user clicks OK or not. Clicking OK does not cause the device to immediately reboot or shut down.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If you select both this option and the Allow user to cancel option, a message displays indefinitely until the user clicks OK or Cancel.

A value of -1 causes the device to wait an indefinite period of time, essentially preventing the device from rebooting or shutting down. You should use a value of -1 in conjunction with the Display a warning message before doing Reboot/Shutdown and, optionally, the Allow user to cancel options. If you specify -1 and select the Display a warning message before doing Reboot/Shutdown option, a message displays indefinitely until the user clicks OK to perform the reboot or shutdown process. If you select this option and the Allow user to cancel option, a message displays indefinitely until the user clicks OK or Cancel.

**Display a Warning Message Before Doing Reboot/Shutdown**

Specify that a message displays on the device, warning the user that the device is going to reboot or shut down.

For example, you could provide the following prompt:

The machine will reboot in _ seconds. Please save your work and close any open applications.

Before performing the action, the message displays on the device only if the user is logged in.

**Allow User to Cancel**

Specify whether the user can cancel the reboot or shutdown procedure.

**Define Prompts**

Define the prompt that you want to display on the device. Additionally, you can specify different locales with different messages. If you do not specify another locale, a default English message displays.

To create a message:

1. Click Add to display the Select Locale and Prompt dialog box.
2. Select a language from the Locale drop-down list. The message displays only on devices in the specified locale. You can create different messages, each with its own locale setting.
3. Type the text you want to display on the device.

**NOTE:** On a Macintosh and a Linux device, the new line character does not work. To display a message on a new line, you must use a &lt;br&gt; tag before the message.
You can include \{0\} in your text to provide a running counter that counts down the number of seconds to 0, after which the prompt is auto-accepted. For example, you could specify the following text:

The machine will reboot in \{0\} seconds. Please save your work and close any open applications.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4 Click OK.

6.24.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.25 Action - Registry Edit

The Action - Registry Edit dialog box lets you configure the registry file to apply. We recommend that you back up the registry before applying the specified registry file, and ensure that the file is properly formatted and well tested. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contain additional information:

- Section 6.25.1, “General,” on page 107
- Section 6.25.2, “Advanced,” on page 110
- Section 6.25.3, “Requirements,” on page 111

6.25.1 General

The General page lets you configure the registry file to apply. You can select hives in the tree to which you want to add values and keys, rename or remove sections, or import a registry file. We recommend that you back up the registry before applying the specified registry file, and ensure that the file is properly formatted and well tested.

**NOTE:** It is recommended that you do not create a registry key with Default as value. If you create a registry key with Default as value and try to perform a registry update, then the registry edit action will update the Windows Default registry value and not the user created Default registry value.

The following table lists the tasks you can perform to manage registry tree changes:
Add a registry key

1. Select a registry hive, click **New**, then click **Key**.
2. Specify the key’s name. For example, Software.
   - You can also specify multiple levels of keys by separating them with a backslash (\). For example, Novell\ZENworks\Zfd.
   - Do not use the forward slash (/) as a separator.
3. Select one of the following registry operations:
   - **Create Always**: Creates the key regardless of whether the key currently exists in the workstation’s registry.
   - **Create If Does Not Exist**: Creates the key only if the key does not currently exist in the workstation’s registry.
   - **Rename**: Renames the key if it currently exists in the workstation’s registry.
   - **Delete**: Deletes the key if it currently exists in the workstation’s registry.
   - **Delete and Recreate**: Deletes the key if it currently exists in the workstation’s registry and then recreates the key.
   - **Delete if Empty**: Deletes the key if it currently exists in the workstation’s registry and the key is empty.
   - **None**: Does not perform any registry operation.
Add a Value

1. Select the check box next to the desired item, then click Value to display the Add Value To dialog box.

2. Select one of the following options from the Value Type list:
   - **Default**: Adds a default string value to the selected key.
   - **String**: Adds a string value to the selected key.
   - **Binary**: Adds a binary value to the selected key. Most hardware component information is stored as binary data and is displayed in hexadecimal format.
   - **Dword**: Adds a DWORD value to the selected key. DWORD values are represented by a number that is 4 bytes long. Many parameters for device drivers and services are this type and are displayed in binary, hexadecimal, or decimal format.
   - **Expandable String**: Adds an expandable string value to the selected key. An expandable string is a variable-length data string. This data type includes variables that are resolved when a program or service uses the data.
   - **Multiple String**: Adds a multi-value string to the selected key. Multiple string values contain lists or multiple values in a form that people can read. Entries are separated by spaces, commas, or other marks.
   - **Qword**: Adds a Qword string to the selected key. A Qword value is data represented by a number that is a 64-bit integer. This data is displayed in Registry Editor as a Binary Value.
   - **Link**: Adds a link string value to the selected key. A link string value is a Unicode string naming a symbolic link.
   - **None**: Does not perform any registry operation.
   - **Full Resource Descriptor**: Adds a full resource descriptor value to the selected key. A full resource descriptor is a series of nested arrays designed to store a resource list for a hardware component or driver.
   - **Resource List**: Adds a resource list to the selected key. A resource list is a series of nested arrays that is designed to store a resource list that is used by a hardware device driver or one of the physical devices it controls.
   - **Resource Requirement List**: Adds a resource requirements list to the selected key. A resource requirements list is a series of nested arrays designed to store a device driver's list of possible hardware resources the driver or one of the physical devices it controls can use.

3. Specify the data. Depending on which value type you selected in the previous step, the type of data varies.

4. Select one of the following registry operations:
   - **Create Always**: The setting is always created in the registry, even if it already exists. If it exists, the setting's current values are overwritten. For example, if PATH=C:\ already exists, PATH=C:\TEMP replaces it.
   - **Create If Exists**: The setting is created only if it already exists. The setting's current values are overwritten. For example, if PATH=C:\ already exists, PATH=C:\TEMP replaces it.
   - **Create If Does Not Exist**: The setting is created only if it does not already exist.
### Task | Steps
--- | ---
**Delete:** The setting is deleted. If the registry setting has subordinate settings, the subordinate settings are also deleted. | 1. Select the check box next to the desired item, then click **Edit > Rename**.
2. Specify the new name.

**Append If Exists, Otherwise Create:** Appends the Value if the value currently exists in the workstation’s registry. If the Value does not exist, it is created. | 1. Select the check box next to the parent folder, then click **Edit > Select All Children**.

**Prepend If Exists, Otherwise Create:** Prepends the Value if the value currently exists in the workstation’s registry. If the Value does not exist, it is created. | 1. Select the check box next to the parent folder, then click **Edit > Deselect All Children**.

**Rename an entry** | 1. Select the check box next to the desired item, then click **Edit > Rename**.
2. Specify the new name.

**Select all the objects of a parent folder** | 1. Select the check box next to the parent folder, then click **Edit > Select All Children**.

**Deselect all the objects of a parent folder** | 1. Select the check box next to the parent folder, then click **Edit > Deselect All Children**.

**Clear Selection** | 1. Click **Edit > Clear Selection**.

**Remove an entry** | 1. Select the check box next to the desired item, then click **Delete**.

**Import the contents of a registry file** | 1. Click **Import**, then specify the registry file whose contents you want to import.

**Export the contents to a registry file** | 1. Click **Export** to export the contents to a registry file named by default as `bundle_name.reg`. For example, if the name of the bundle is win, then the contents are exported to a `win.reg` file.

**Search for a Value name, registry key, or both.** | 1. Specify the name of the value or key that you want to search for.
2. Select **Registry Key/Value**, **Registry Value Data**, or **Both**.
3. Select the **Search within the selected nodes only** check box to limit the search to the node you selected in the Registry Tree list.
4. Click **Search**.

### 6.25.2 Advanced

The Advanced page lets you specify how you want the action to run (as system or user) and to back up the registry file before applying the modified registry file.

**Backup Registry Before Applying the Changes**

Select the check box, then specify the path to the backup file, for example, `c:\BackupFile.reg`.

If you select this option, the entire registry is backed up before importing the configured registry file. The backup process is performed every time this action executes. This can be a time-consuming operation and the backup file can be large.
Before you edit the registry, export the keys in the registry that you plan to edit, or back up the entire registry by selecting this option. If a problem occurs, you can then restore the registry to its previous state.

**NOTE:** On a non-XP Windows device, if you apply a bundle for which Backup registry before applying changes is selected and Run Action As is set to User, then the following occurs:

- The registry backup action fails.
- The bundle execution fails.

### Run Action As

Specify how you want the action to run:

- **System:** The action is run under the Local System user and inherits Administrator-level credentials. For example, the action has full rights to the HKEY_LOCAL_MACHINE hive.
  - Select the Apply HKEY_CURRENT_USER changes to the logged user's hive instead of .DEFAULT option to enable the changes to be made in the user's hive instead of the DEFAULT hive of HKEY_USERS.
  - Select the Resolve the environment variables specified in registry edit value in the user context option to resolve the environment variables that you have specified in the registry edit value, in the user context. If there are no logged in users available, then the environment variables will be resolved in the system context.

- **User:** The registry file is applied using the logged-in user's credentials. For example, the action has the same rights to the registry and the file system as the logged-in user. If you are changing keys in the HKEY_CURRENT_USER hive, you must run the action as User. Depending on the rights assigned to the user, the action might or might not have rights to the HKEY_LOCAL_MACHINE hive. If you select User, the user must be logged in to the device or the action fails.

### 6.25.3 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

### 6.26 Action - Run Script

The Action - Run Script dialog box lets you configure a script to be executed on the managed device. For the Run Script action to successfully complete, ensure that the script is silent (requires no user intervention). You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.26.1, “General,” on page 112
- Section 6.26.2, “Requirements,” on page 115
6.26.1 General

The General page lets you configure a script to be executed on the managed device. For the Run Script action to successfully complete, ensure that the script is silent (requires no user intervention).

The settings vary, depending on the type of script you select from the Script to run list. The following options are available:

- “Specify a File on a Managed Device” on page 112
- “Define Your Own Script” on page 113
- “Select From This Device” on page 114

Specify a File on a Managed Device

Select this option to run a script that exists on the managed device.

**Script Filename:** Specify the path to the script file on the target device, for example, C:\scripts\xyz.pl.

**Script Parameters:** Specify any additional parameters you want to place on the command line after the script filename is specified. This results in parameters being passed to your executable script.

**Path to Script Engine:** Specify the interpreter that launches to run your script. For example, C:\Program Files\Perl\bin\Perl.exe.

For Windows scripts other than batch scripts (for example, VBScript), the **Path to Script Engine** field should specify the path to the Windows Based Script Host, such as (C:\Windows\System32\wscript.exe)

**Script Engine Parameters:** Specify any parameters you want included on the command line when the script engine launches.

**Wait Before Proceeding to Next Action:** Specify what happens after the script is run:

- **No wait:** The next action in the list is immediately performed.
- **When launch action is complete:** The next action in the list is performed after the launch action completes.
- **Wait for _ seconds:** Wait the specified number of seconds before proceeding to the next action.
  - **Terminate action if wait period exceeded:** If you select the Wait for _ seconds option, this option is enabled. If the specified number of seconds is exceeded and the action is not successfully performed, the action is terminated.

**Success Return Codes:** Specify the non-zero success codes that the script returns. You can specify multiple success codes separated by commas.

If a script returns non-zero success codes, you should specify these non-zero success codes while launching the action. For example, explorer.exe in Windows returns a success code of 1. To successfully launch the Explorer application, you should add 1 as the success code while launching the action.

If you leave this field blank, zero will be considered as the success code. Specify the Success Return Code as * to enable any non-zero code returned by a script to be treated as success.

**Working Directory:** Click More Options to specify the script’s working directory. Specify the initial working directory for the script.
**Priority:** Click More Options to specify the script’s priority. Specify the priority of the process that runs the script. This option lets you configure how much of the CPU usage the script process consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal, and Low.

**Run As:** Click More Options to specify the script’s run as setting. Specify an option:

- **System:** Runs the script as the system account (as a service).
- **Administrator:** Runs the script as a dynamic administrator user. A dynamic administrator account is created on the fly to perform certain procedures, such as installing applications or running scripts. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.
- **User:** The script runs, using the logged-in user’s credentials. For example, the script has the same rights to the registry and the file system as the logged-in user.

**Define Your Own Script**

Select this option to type a script in ZENworks Control Center.

**Script Content:** Click Edit to display a text box where you type your script. This script is delivered to the assigned devices and is executed in the standard device shell environment.

For example, you can automate drive mapping using the script capabilities of bundles. Your bundle’s script could read:

```bash
net use m: \server\sys
net use w: \server\vol1
```

If the user is logged in as an eDirectory user with rights, then the mapping works. They can map a drive to a Windows share using a domain account by putting the username / password on the script line. If they are a logged in as an Active Directory user and have rights, the username / password is not required.

**Save File with Extension:** Specify the extension that you want appended to the script when it is saved. For example, .bat.

**Path to Script Engine:** Specify the interpreter that launches to run your script.

**Script Engine Parameters:** Specify any parameters you want included on the command line when the script engine launches.

**Wait Before Proceeding to Next Action:** Specify what happens after the script is run:

- **No wait:** The next action in the list is immediately performed.
- **When launch action is complete:** The next action in the list is performed after the launch action completes.
- **Wait for _ seconds:** Wait the specified number of seconds before proceeding to the next action.
  - **Terminate action if wait period exceeded:** If you select the Wait for _ seconds option, this option is enabled. If the specified number of seconds is exceeded and the action is not successfully performed, the action is terminated.

**Working Directory:** Click More Options to specify the script’s working directory. Specify the initial working directory for the script.
**Priority:** Click More Options to specify the script’s priority. Specify the priority of the process that runs the script. This option lets you configure how much of the CPU usage the script process consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal, and Low.

**Run As:** Click More Options to specify the script’s run as setting. Specify an option:

- **System:** Runs the script as the system account (as a service).
- **Administrator:** Runs the script as a dynamic administrator user. A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications or running scripts. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.
- **User:** The script runs, using the logged-in user’s credentials. For example, the script has the same rights to the registry and the file system as the logged-in user.

**Select From This Device**

Select this option to specify a script file that is already on the device on which you are running ZENworks Control Center.

**Select From This Device:** Browse to and select the script file.

**Script Parameters:** Specify any additional parameters you want to place on the command line after the script filename is specified. This results in parameters being passed to your executable script.

**Path to Script Engine:** Specify the interpreter that launches to run your script.

**Script Engine Parameters:** Specify any parameters you want included on the command line when the script engine launches.

**Wait Before Proceeding to Next Action:** Specify what happens after the script is run:

- **No wait:** The next action in the list is immediately performed.
- **When launch action is complete:** The next action in the list is performed after the launch action completes.
- **Wait for _ seconds:** Wait the specified number of seconds before proceeding to the next action.
  - **Terminate action if wait period exceeded:** If you select the Wait for _ seconds option, this option is enabled. If the specified number of seconds is exceeded and the action is not successfully performed, the action is terminated.

**Working Directory:** Click More Options to specify the script’s working directory. Specify the initial working directory for the script.

**Priority:** Click More Options to specify the script’s priority. Specify the priority of the process that runs the script. This option lets you configure how much of the CPU usage the script process consumes. Select from the following priorities: Real Time, High, Above Normal, Normal, Below Normal, and Low.

**Run As:** Click More Options to specify the script’s run as setting. Specify an option:

- **System:** Runs the script as the system account (as a service).
- **Administrator:** Runs the script as a dynamic administrator user. A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications or running scripts. Using a dynamic administrator is helpful when installing
applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

- **User**: The script runs, using the logged-in user’s credentials. For example, the script has the same rights to the registry and the file system as the logged-in user.

The following options are available for Linux:

- **Root**: The script runs by using the credentials of the root user.
- **User**: The script runs by using the logged-in user’s credentials. For example, the script has the same rights to the registry and the file system as the logged-in user.

### 6.26.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see [Requirements](#).

### 6.27 Action - Start/Stop Service

The Action - Start/Stop Service dialog box lets you specify the service that you want to start or stop. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the **Bundles** tab. Click the underlined link of a bundle in the **Name** column of the **Bundles** list, click the **Actions** tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the **Add** drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.27.1, “General,” on page 115
- Section 6.27.2, “Requirements,” on page 115

### 6.27.1 General

The General page lets you specify the service that you want to start or stop.

**Service Name**: Specify a service and indicate whether you want to start or stop that service.

**Select Action**: Select one of the following actions:

- **Start Service**: Starts the specified service. If the service is already running on the device, the Start Service task completes.
- **Stop Service**: Stops the specified service. If the service is not running on the device, the Stop Service task completes.

### 6.27.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see [Requirements](#).
6.28 Action - Terminate Application

The Action - Terminate Application dialog box is displayed when you add a Terminate Application Prompt action. This dialog box lets you undo all operations that are performed in the launch action set. You can also configure a prompt to notify users of the termination. You can also specify the specific requirements that a device must meet for the action to be executed on the device. However, you are allowed to add the Terminate Application action only if it is not already added.

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. Click Add > Terminate Application.

The following sections contains additional information:

- Section 6.28.1, “General,” on page 116
- Section 6.28.2, “Requirements,” on page 116

6.28.1 General

The General page lets you undo all operations that are performed in the launch action set. You can also configure a prompt to notify users of the termination.

The name and type of each process that is reversed displays in the list.

**Notify the User of Termination**

Define the prompt that you want to display on the device. You can also specify different locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the prompt defined in the same locale as the operating system locale. However, if the operating system locale does not match any of the specified locales, then ZENworks displays the prompt defined by the first locale in the list.

To create a message:

1. Click Add to display the Select Locale and Prompt dialog box.
2. Select a language from the Locale drop-down list. The message displays only on devices in the specified locale. You can create different messages, each with its own locale setting.
3. Specify the text you want to display on the device.
   - You can include \{0\} in your text to provide a running counter that counts down the number of seconds to 0, after which the prompt is auto-accepted. For example, you could specify the following text:
     
     The application will terminate in \{0\} seconds. Please save your work.
     
     The message displays for the number of seconds specified in the Seconds to be Displayed field.
4. Click OK.

To remove a prompt, select the check box, then click Remove.

6.28.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.29 Action - Terminate Application Prompt

The Action - Terminate Application Prompt dialog box is displayed when you add a Terminate Application Prompt action. This dialog box lets you configure a prompt to notify users before the application terminates, including the number of seconds to notify the user, the number of times the prompt retries, and different messages for different locales. You can also specify the specific requirements that a device must meet for the action to be executed on the device. However, you are allowed to add the Terminate Application Prompt action only if it is not already added.

To access this dialog box, click the Bundles tab in ZENworks Control Center. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions > Terminate. Click Add > Terminate Application Prompt.

The following sections contains additional information:

- Section 6.29.1, “General,” on page 117
- Section 6.29.2, “Requirements,” on page 118

6.29.1 General

The Action - Terminate Application Prompt dialog box lets you configure a prompt to notify users before the application terminates, including the number of seconds to notify the user, the number of times the prompt retries, and different messages for different locales.

Seconds to be Displayed

Specify the number of seconds that the prompt is displayed before the action is performed. For example, suppose you configure a prompt to notify the user that an application is in the process of terminating. If you specify that the prompt display for 10 seconds, the prompt displays for 10 seconds, then the application terminates.

Number of Retries Allowed

Specify the number of times the prompt displays before performing the next action.

Prompt the User to Save Any Unsaved Data

Define the prompt that you want to display on the device. You can also specify different locales with different messages.

The ZENworks Agent automatically detects the locale of the operating system and displays the prompt defined in the same locale as the operating system locale. However, if the operating system locale does not match any of the specified locales, then ZENworks displays the prompt defined by the first locale in the list.

To create a message:

1. Click Add to display the Select Locale and Prompt dialog box.
2. Select a language from the Locale drop-down list. The message displays only on devices in the specified locale. You can create different messages, each with its own locale setting.
3. Type the text you want to display on the device.
NOTE: On a Macintosh and a Linux device, the new line character does not work. To display a message on a new line, you must use a <br> tag before the message.

You can include {0} in your text to provide a running counter that counts down the number of seconds to 0, after which the prompt is auto-accepted. For example, you could specify the following text:

The application will terminate in {0} seconds. Please save your work.

The message displays for the number of seconds specified in the Seconds to be Displayed field.

4. Click OK.

6.29.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.30 Action - Undo Install Actions

The Action - Undo Install Actions dialog box lets you undo all operations that are performed in the install action set. The list displays the name and type of each operation that is reversed. There are no configuration tasks that you need to perform for this action.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

6.31 Action - Uninstall Bundle

The Action - Uninstall Bundle dialog box lets you select a bundle to remove from the device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:

- Section 6.31.1, “General,” on page 118
- Section 6.31.2, “Requirements,” on page 119

6.31.1 General

The General page lets you select a bundle to remove from the device. Click to browse to and select the bundle to uninstall from the device.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types of bundles are displayed (Preboot bundle, Windows bundles). If you know the name of the bundle you are looking for, you can use the Item name box to search for the bundle.
Creating this action creates a bundle dependency. For more information, see Section 8.8, “Dependency Bundles,” on page 145.

6.31.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.

6.32 Action - Repair Bundle

The Action - Repair Bundle dialog box lets you repair a bundle on the device. You can also specify the specific requirements that a device must meet for the action to be executed on the device.

Repairing a bundle ensures that the specified bundle or bundle group has been properly installed on the device.

For example, for an MSI bundle, repairing the bundle results in the task running an MSI /repair process against the bundle.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

The following sections contains additional information:
- Section 6.32.1, “General,” on page 119
- Section 6.32.2, “Requirements,” on page 119

6.32.1 General

The General page lets you repair a bundle on the device. Click to browse to and select the bundle to repair on the device.

The Look in list defaults to /Bundles. If you have created subfolders to hold your bundles, use the down-arrow to select the appropriate folder. The Items of type list defaults to All Types so that all types of bundles are displayed (Preboot bundles, Windows bundles). If you know the name of the bundle you are looking for, you can use the Item name box to search for the bundle.

Creating this action creates a bundle dependency. For more information, see Section 8.8, “Dependency Bundles,” on page 145.

6.32.2 Requirements

The Requirements page lets you define specific requirements that a device must meet for the action to be enforced on it. For information about the requirements, see Requirements.
6.33 Action - Repair Install Actions

The Repair Install Actions action repairs all operations that are performed in the Install action set. This action does not require any configuration.

To access this dialog box in ZENworks Control Center, click the Bundles tab. Click the underlined link of a bundle in the Name column of the Bundles list, click the Actions tab, click one of the action set tabs (Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot), click the Add drop-down list, then select an available action.

6.34 Requirements

The Requirements panel lets you define specific requirements that a device must meet for the action to be enforced on it.

You define requirements through the use of filters. A filter is a condition that must be met by a device in order for the bundle to be applied. For example, you can add a filter to specify that the device must have exactly 512 MB of RAM in order for the bundle to be applied, and you can add another filter to specify that the hard drive be at least 20 GB in size.

As you construct filters, you need to know the conditions you can use and how to organize the filters to achieve the desired results. Refer to the following sections for details.

- Section 6.34.1, “Filter Conditions,” on page 120
- Section 6.34.2, “Filter Logic,” on page 124
- Section 6.34.3, “Fail the action if these requirements fail,” on page 125

6.34.1 Filter Conditions

You can choose from any of the following conditions when creating a filter. Place your mouse pointer over fields that require input to display a tooltip containing example usage.

**Architecture:** Determines the architecture of Windows running on the device. The condition you use to set the requirement includes a property, an operator, and a property value. The possible operators are equals (=) and does not equal (<>). For example, if you set the condition to `architecture = 32`, the device’s Windows operating system must be 32-bit to meet the requirement.

**Associated On:** Determines the number of users or devices to which the bundle is assigned. The possible operators are equals (=) and does not equal (<>). The possible values are Users and Devices. For example, if you set the condition to `=100 users`, the total number of users must be 100 to meet the requirement.

**Bundle Installed:** Determines if a specific bundle is installed. After specifying the bundle, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the specified bundle must already be installed to meet the requirement. If you select No, the bundle must not be installed.

**Connected:** Determines if the device is connected to the network. The two conditions you can use to set the requirement are Yes and No. If you select Yes, the device must be connected to the network to meet the requirement. If you select No, it must not be connected.

**Connection Speed:** Determines the speed of the device’s connection to the network. The condition you use to set the requirement includes an operator and a value. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps),...
megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to $\geq 100$ Mbps, the connection speed must be greater than or equal to 100 megabits per second to meet the requirement.

**Disk Space Free:** Determines the amount of free disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal ($<>$), is greater than ($>$), is greater than or equal to ($\geq$), is less than ($<$), and is less than or equal to ($\leq$). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to $c: \geq 80$ MB, the free disk space must be greater than or equal to 80 megabytes to meet the requirement.

**Disk Space Total:** Determines the amount of total disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal ($<>$), is greater than ($>$), is greater than or equal to ($\geq$), is less than ($<$), and is less than or equal to ($\leq$). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to $c: \geq 40$ GB, the total disk space must be greater than or equal to 40 gigabytes to meet the requirement.

**Disk Space Used:** Determines the amount of used disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal ($<>$), is greater than ($>$), is greater than or equal to ($\geq$), is less than ($<$), and is less than or equal to ($\leq$). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to $c: \leq 10$ GB, the used disk space must be less than or equal to 10 gigabytes to meet the requirement.

**Environment Variable Exists:** Determines if a specific environment variable exists on the device. After specifying the environment variable, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the environment variable must exist on the device to meet the requirement. If you select No, it must not exist.

**Environment Variable Value:** Determines if an environment variable value exists on the device. The condition you use to set the requirement includes the environment variable, an operator, and a value. The environment variable can be any operating system supported environment variable. The possible operators are equal to, not equal to, contains, and does not contain. The possible variable values are determined by the environment variable. For example, if you set the condition to Path contains c:\windows\system32, the Path environment variable must contain the c:\windows\system32 path to meet the requirement.

**File Date:** Determines the date of a file. The condition you use to set the requirement includes the filename, an operator, and a date. The filename can be any filename supported by the operating system. The possible operators are on, after, on or after, before, and on or before. The possible dates are any valid dates. For example, if you set the condition to appl.msi on or after 6/15/07, the appl.msi file must be dated 6/15/2007 or later to meet the requirement.

**File Exists:** Determines if a file exists. After specifying the filename, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the requirement. If you select No, the file must not exist.

**File Size:** Determines the size of a file. The condition you use to set the requirement includes the filename, an operator, and a size. The filename can be any file name supported by the operating system. The possible operators are equals (=), does not equal ($<>$), is greater than ($>$), is greater than or equal to ($\geq$), is less than ($<$), and is less than or equal to ($\leq$). The possible sizes are designated in bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to doc1.pdf $\leq 3$ MB, the doc1.pdf file must be less than or equal to 3 megabytes to meet the requirement.
**File Version**: Determines the version of a file. The condition you use to set the requirement includes the filename, an operator, and a version. The filename can be any file name supported by the operating system. The possible operators are equals (\(=\)), does not equal (\(<\>\)), is greater than (\(>\)), is greater than or equal to (\(\geq\)), is less than (\(<\)), and is less than or equal to (\(\leq\)).

Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For example, the file version for `calc.exe` might be 5.1.2600.0. Each component is treated independently. For this reason, the system requirements that you set might not provide your expected results. If you do not specify all four components, wildcards are assumed.

For example, if you set the condition to `calc.exe <= 5`, you are specifying only the first component of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the condition.

However, because each component is independent, if you set the condition to `calc.exe <= 5.1`, the `calc.exe` file must be less than or equal to version 5.1 to meet the requirement.

**IP Segment**: Determines the device’s IP address. After specifying the IP segment name, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the device’s IP address must match the IP segment. If you select No, the IP address must not match the IP segment.

**Linux Distribution**: Determines the platform on which you want to distribute the bundles or the external services. The condition you use to set the requirement includes an operator and a property value. The possible properties are server type or desktop type, version, and architecture. The possible operators are equals (=) and does not equal (\(<\>)\). For example, if you set the property value to SUSE Linux Enterprise Desktop 11 - i586, the distribution will be only on SLED 11 - i586 devices.

**Linux Kernel Version**: Determines the version of the Linux kernel. The condition you use to set the requirement includes an operator and a version. The possible operators are equals (=), does not equal (\(<\>\)), is greater than (\(>\)), is greater than or equal to (\(\geq\)), is less than (\(<\)), and is less than or equal to (\(\leq\)). For example, if you set the condition as `Linux Kernel Version > 2.6`, the requirement is met only on Linux devices that have a kernel version greater than 2.6.

**Linux Service Pack**: Determines the Linux service pack level running on the device. The condition you use to set the requirement includes a property and an operator, and a property value. The possible properties are service pack, server type, and version. The possible operators are equals (=), does not equal (\(<\>\)), is greater than (\(>\)), is greater than or equal to (\(\geq\)), is less than (\(<\)), and is less than or equal to (\(\leq\)). For example, if you set the condition as `Linux Service Pack = SLES 10 SP1`, the requirement is met only on devices that are installed with SLES 10 SP1.

**Logged on to Primary Workstation**: Determines whether the user is logged on to his or her primary workstation. The two conditions you can use to set the requirement are Yes and No. If you select Yes, the user must be logged on to his or her primary workstation to meet the requirement. If you select No, if no user is logged on to the workstation, the requirement is not met. However, if a user other than the primary user is logged on to the workstation, the requirement is met.

**Memory**: Determines the amount of memory on the device. The condition you use to set the requirement includes an operator and a memory amount. The possible operators are equals (=), does not equal (\(<\>\)), is greater than (\(>\)), is greater than or equal to (\(\geq\)), is less than (\(<\)), and is less than or equal to (\(\leq\)). The memory amounts are designated in megabytes (MB) and gigabytes (GB). For example, if you set the condition to `\(\geq\) 2 GB`, the device must have at least 2 gigabytes of memory to meet the requirement.

**Novell Client Installed**: Determines if the device is using the Novell Client for its network connection. The two conditions you can use to set the requirement are Yes and No. If you select Yes, the device must be using the Novell Client to meet the requirement. If you select No, it must not be using the Novell Client.
**Operating System - Windows:** Determines the service pack level, server type, and version of Windows running on the device. The condition you use to set the requirement includes a property, an operator, and a property value. The possible properties are *service pack*, *server type*, and *version*. The possible operators are *equals* (=), *does not equal* (<>), *is greater than* (>), *is greater than or equal to* (>=), *is less than* (<), and *is less than or equal to* (<=). The property values vary depending on the property. For example, if you set the condition to *version = Windows XP Versions*, the device’s Windows version must be XP to meet the requirement.

**NOTE:** Be aware that operating system version numbers contain four components: Major, Minor, Revision, and Build. For example, the Windows 2000 SP4 release’s number might be 5.0.2159.262144. Each component is treated independently. For this reason, the system requirements that you set might not provide your expected results.

For example, if you specify *Operating System - Windows* in the first field, *Version* in the second field, > in the third field, and 5.0 -*Windows 2000 Versions* in the last field, you are specifying only the first two components of the version number: Major (Windows) and Minor (5.0). As a result, for the requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000 SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 5.0.0 to make the requirement evaluate as true because the actual revision component is greater than 0.

When you select the OS version from the drop-down, the Major and Minor components are populated. The Revision and Build components must be typed in manually.

**Primary User Is Logged In:** Determines if the device’s primary user is logged in. The two conditions you can use to set the requirement are *Yes* and *No*. If you select *Yes*, the primary user must be logged in to meet the requirement. If you select *No*, the user must not be logged in.

**Processor Family:** Determines the device’s processor type. The condition you use to set the requirement includes an operator and a processor family. The possible operators are *equals* (=) and *does not equal* (<>). The possible processor families are *Pentium*, *Pentium Pro*, *Pentium II*, *Pentium III*, *Pentium 4*, *Pentium M*, *WinChip*, *Duron*, *BrandID*, *Celeron*, and *Celeron M*. For example, if you set the condition to < > Celeron, the device’s processor can be any processor family other than Celeron to meet the requirement.

**Processor Speed:** Determines the device’s processor speed. The condition you use to set the requirement includes an operator and a processor speed. The possible operators are *equals* (=), *does not equal* (<>), *is greater than* (>), *is greater than or equal to* (>=), *is less than* (<), and *is less than or equal to* (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and gigahertz (GHz). For example, if you set the condition to >= 2.0 GHz, the device’s speed must be at least 2 gigahertz to meet the requirement.

**Registry Key Exists:** Determines if a registry key exists. After specifying the key name, the two conditions you can use to set the requirement are *Yes* and *No*. If you select *Yes*, the specified key must exist to meet the requirement. If you select *No*, the key must not exist.

**Registry Key Value:** Determines if a registry key value meets a defined condition. The condition you use to set the requirement includes the key name, the value name, an operator, a value type, and a value data. The key and value names must identify the key value you want to check. The possible operators are *equals* (=), *does not equal* (<>), *is greater than* (>), *is greater than or equal to* (>=), *is less than* (<), and *is less than or equal to* (<=). The possible value types are *Integer Type* and *String Type*. The possible value data is determined by the key, value name, and value type.
If the value type is **String Type**, ZCM compares only those values in the registry if the actual type in the registry is REG_STRING or REG_EXPANDED_STRING.

If the value type is **Integer**, ZCM compares only those values in the registry if the actual type in the registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no name and is displayed in regedit as *(Default)*.

If the value type is **IP Address**, ZCM compares only those values in the registry if the actual type in the registry is REG_STRING.

For more details, see **Registry Key Value** information in the Adding System Requirements for a Bundle section of this guide.

**Registry Key and Value Exists:** Determines if a registry key and value exist. After specifying the key name and value, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the specified key and value must exist to meet the requirement. If you select **No**, the key and value must not exist.

**Service Exists:** Determines if a service exists. After specifying the service name, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the service must exist to meet the requirement. If you select **No**, the service must not exist.

**Specified Devices:** Determines if the device is one of the specified devices. After specifying the devices, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the device must be included in the specified devices list to meet the requirement (an inclusion list). If you select **No**, the device must not be included in the list (an exclusion list).

**Version of RPM:** Determines the version of the RPM name provided if installed. For example, if you add a system requirement, `Version of RPM cups > 1.0`, then the requirement evaluates to true, if cups rpm is installed and the version of the installed cups rpm is greater than 1.0. If cups rpm is not installed, the requirement is evaluated to be false. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=).

### 6.34.2 Filter Logic

You can use one or more filters to determine whether the bundle should be distributed to a device. A device must match the entire filter list (as determined by the logical operators that are explained below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

- Designing a filter structure that is easy to understand
- Organizing the filters so that you do not create conflicting filters

**Filters, Filter Sets, and Logical Operators**

You can add filters individually or in sets. Logical operators, either **AND** or **OR**, are used to combine each filter and filter set. By default, filters are combined using **OR** (as determined by the Combine Filters Using field) and filter sets are combined using **AND**. You can change the default and use **AND**
to combined filters, in which case filter sets are automatically combined using OR. In other words, the logical operator that is to combine individual filters (within a set) must be the opposite of the operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set options a few times each to create a few filter sets, then switch between AND and OR in the Combine Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals, where filters are contained within parentheses, and sets are separated into a series of parenthetical groups. Logical operators (AND and OR) separate the filters within the parentheses, and the operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the filter list, this looks like:

```
u AND
v AND
w
OR
x AND
y AND
z
```

**Nested Filters and Filter Sets**

Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter set to match the device is used. Therefore, the order in which they are listed does not matter. You are simply looking for a match to cause the bundle to be applied to the device.

**6.34.3 Fail the action if these requirements fail**

If you check this box, the selected action will be marked as failed if the system requirements fail. As a result you cannot bypass the action that fails and move to the next action for completing the bundle execution.

**NOTE:** However you can bypass the action that fails and move to the next action, only if you have selected the check box in the Continue on Failure column.
ZENworks provides a change management capability for bundles allowing you to make changes to them with minimum disruption to IT services.

A sandbox contains changes made to a bundle and is available only to devices or users that have been flagged as test. This allows you to test the changes made to the bundle in a testing environment before rolling out the changes into the production environment. If the test results are satisfactory then you can publish the sandbox, else discard the changes by reverting the sandbox.

The published version is available to all the assigned devices and users that have been flagged as a non-test. This ensures that all the devices in the network always receive the same version of a bundle.

You can now create a bundle as a sandbox-only bundle or published version of the bundle. If you select the Create as Sandbox option on the Summary page of the bundle creation wizard, the bundle is created as a sandbox-only bundle, else a published version of the bundle is created. For more information on creating a bundle, see Chapter 2, “Creating Bundles,” on page 21.

If you create a bundle as a sandbox, the bundle content replication schedule is modified for that bundle, so that the content is excluded from all Primary and Satellite servers and is replicated only on the Primary server that was used to upload the content. For details, see Publishing Sandbox and Bundle Behavior Based on Content Replication Settings.

Also, any change made to the published version of the bundle creates a sandbox. For more information on managing the bundles versions, see Section 8.4.2, “Managing Bundle Versions,” on page 137.

You can choose to publish a sandbox either as a new version or a new bundle. For more information on publishing a sandbox, see Section 8.4.3, “Publishing Sandbox,” on page 138.
Managing Bundles

The Novell ZENworks Configuration Management Software Management features let you effectively manage software and content in your ZENworks system.

For more information about creating Preboot bundles, see the ZENworks Preboot Services and Imaging Reference.

The following sections contain information to help you manage existing bundles:

- Section 8.1, “Bundle Quick Tasks,” on page 129
- Section 8.2, “Bundle Tasks,” on page 131
- Section 8.3, “Editing Bundles,” on page 135
- Section 8.4, “Bundle Change Management,” on page 136
- Section 8.5, “Copying a Bundle to a Content Server,” on page 140
- Section 8.6, “Bundle Behavior Based on Content Replication Settings,” on page 141
- Section 8.7, “Export and Import Bundles,” on page 143
- Section 8.8, “Dependency Bundles,” on page 145

8.1 Bundle Quick Tasks

Review the following sections for the bundle related tasks that you can quickly perform on one or more devices

- Section 8.1.1, “Installing a Bundle,” on page 129
- Section 8.1.2, “Launching a Bundle,” on page 130
- Section 8.1.3, “Uninstalling a Bundle,” on page 131

8.1.1 Installing a Bundle

The Install Bundle option in the Bundle Tasks list in the left navigation pane of ZENworks Control Center lets you immediately install a bundle to one or more devices.

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle (or bundles).
3. In the Bundle Tasks list in the left navigation pane, select Install Bundle.
4. In the Devices section, click Add to select the devices where you want to install the bundle.
5. In the Select Objects dialog box, browse to and select the objects on which you want to install the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the Servers and Workstations folders are displayed along with any custom folders that you have created in the Devices folder.
Browse for and select the devices, groups, and folders to which you want to assign the bundle. To do so:

5a Click ☐ next to a folder (for example, the Workstations folder or Servers folder) to navigate through the folders until you find the device, user, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can also use the Name filter box to search for the item.

5b Click the underlined link in the Name column to select the device, group, or folder and display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.

6 Click OK.

If the bundle has not already been assigned to a device, then the bundle’s icon is placed in the application window of the device.

8.1.2 Launching a Bundle

The Launch Bundle option lets you immediately launch a bundle to one or more devices. If the bundle is not already installed, it is installed and then launched.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Quick Tasks > Launch Bundle.
4 In the Devices section, click Add to select the devices where you want to launch the bundle.
5 In the Select Objects dialog box, browse to and select the objects on which you want to launch the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the Servers and Workstations folders are displayed along with any custom folders that you have created in the Devices folder.

Browse for and select the devices, groups, and folders to which you want to assign the bundle. To do so:

5a Click ☐ next to a folder (for example, the Workstations folder or Servers folder) to navigate through the folders until you find the device, user, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can also use the Name filter box to search for the item.

5b Click the underlined link in the Name column to select the device, group, or folder and display its name in the Selected list box.

5c Click OK to add the selected devices, folders, and groups to the Devices list.

6 Click OK.

If the bundle has not earlier been assigned to a device, then the bundle’s icon is placed in the application window of the device.
8.1.3 Uninstalling a Bundle

The Uninstall Bundle quick task lets you uninstall a bundle from one or more devices. Uninstalling a bundle does not, however, remove its assignments nor prevent the bundle from being reinstalled.

**NOTE:** To use the Uninstall Bundle quick task, you must enable the bundle’s uninstall options that is disabled by default. For more information, see Section 12.2.3, “Uninstall Action Set Options,” on page 175.

To uninstall a bundle:

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle (or bundles).
3. Click Quick Tasks > Uninstall Bundle.
4. In the Bundles section, click to browse to and select the desired bundle (if necessary).
5. In the Devices section, click Add to select the devices where you want to uninstall the bundle.
6. In the Select Objects dialog box, browse to and select the objects on which you want to uninstall the bundle.

   The Select Objects dialog box opens with the Devices folder as the root folder. By default, the Servers and Workstations folders are displayed along with any custom folders that you have created in the Devices folder.

   Browse for and select the devices, groups, and folders to which you want to assign the bundle.

   To do so:
6a. Click next to a folder (for example, the Workstations folder or Servers folder) to navigate through the folders until you find the device, user, group, or folder you want to select.
   If you are looking for a specific item, such as a Workstation or a Workstation Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can also use the Name filter box to search for the item.
6b. Click the underlined link in the Name column to select the device, group, or folder and display its name in the Selected list box.
6c. Click OK to add the selected devices, folders, and groups to the Devices list.
7. Click OK, then click Apply.

If ZENworks Control Center shows that the uninstall fails, examine the device’s log file for more information.

## 8.2 Bundle Tasks

Review the following sections for the tasks that you can perform on one or more bundles.

- Section 8.2.1, “Renaming, Copying, or Moving Bundles,” on page 132
- Section 8.2.2, “Deleting a Bundle,” on page 132
- Section 8.2.3, “Preventing a Bundle from Being Deployed,” on page 133
- Section 8.2.4, “Enabling a Bundle to Be Deployed,” on page 133
- Section 8.2.5, “Enabling Bundle Ordering,” on page 133
- Section 8.2.6, “Blocking a Bundle that is Assigned to a Device,” on page 134
8.2.1 Renaming, Copying, or Moving Bundles

Use the Edit drop-down list on the Bundles page to edit an existing object. To access the Edit drop-down list, you must select an object by clicking the check box next to the object's name in the list.

Depending on the type of object you select, you can rename, copy, or move the selected object. For example, if you select a Bundle object, you can rename, copy, and move the bundle. If you select a Bundle Group object, you can rename or move the Bundle Group object, but not copy it. If the option is dimmed, that option is not available for the selected object type.

Some actions cannot be performed on multiple objects. For example, if more than one check box is selected, the Rename option is not available from the Edit menu.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the box next to the bundle's name, click Edit, then click an option:
   - Rename: Click Rename, provide a new name for the bundle, then click OK.
   - Copy: Click Copy, provide a new name for the copy, then click OK.
   - Move: Click Move, select a destination folder for the selected objects, then click OK.

   **IMPORTANT:** Do not rename Windows MSP bundles.

The copy option is useful to create a new bundle that is similar to an existing bundle. You can copy a bundle and then edit the new bundle's settings.

If you rename or move a bundle, its assignments are still in place and ZENworks Configuration Management does not redistribute the bundle to devices or users because of the name or location change. However, the changes are effective when the subsequent versions of the bundle are distributed to the devices or users.

8.2.2 Deleting a Bundle

Deleting a bundle removes the bundle content from the ZENworks content servers but does not uninstall it from devices where it has already been installed. To uninstall it from devices, you should use the Uninstall options before deleting the bundle.

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle (or bundles).
3 Click Delete.

**NOTE:** Deleting a Linux or Linux dependency bundle does not immediately remove the YUM service that was created for the bundle. The YUM service is removed when the next YUM Services Refresh is configured. Click the **Click here to Update YUM Service Now** link in YUM Service Settings to remove the YUM service immediately.
8.2.3 Preventing a Bundle from Being Deployed

A disabled bundle is not deployed to new managed devices or replicated to content servers. It remains on the device and content server to which it has already been deployed until the next device refresh.

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle (or bundles).
3. Click Action > Disable.

**NOTE:** For iOS bundles created through Apple VPP subscriptions, the Disable option will uninstall the app from the device and the app license will be revoked.

---

8.2.4 Enabling a Bundle to Be Deployed

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle (or bundles).
3. Click Action > Enable.

---

8.2.5 Enabling Bundle Ordering

- “Enabling Ordering” on page 133
- “Configuring Time Slice on the Agent” on page 134

**Enabling Ordering**

You can use Bundle Ordering to prioritize the way bundles are executed. When you assign an order value to a bundle, the bundles are executed based on the value assigned. Multiple bundles can be executed simultaneously, or the order of execution can be prioritized.

1. In ZENworks Control Center, click the Bundles tab.
2. Select an existing bundle or create a new Windows or Linux bundle.
   - For more information, see Chapter 2, “Creating Bundles,” on page 21.
3. In the General tab of the Summary page, click Yes next to the Enable Bundle Ordering field. This activates the Bundle Order field.
4. Click Edit next to the Bundle Order field.
5. In the Bundle Order dialog box that appears, specify a value and then click OK.
   - Values can range from 0 to 9999999. The default value 0, has the highest priority. Bundles are executed in the ascending order of the values assigned.
6. (Optional) Click Yes next to Wait for previous Bundle execution to complete, if you want bundles with lower priorities to wait for bundles with higher priority to complete execution.
7. Click Publish.
**Configuring Time Slice on the Agent**

Time slice configuration sets the amount of time that the agent waits before reordering the assigned bundles. The time slice duration is configurable on the agent; the default is 5 seconds. This value can be changed. It should be an integer value and is calculated in seconds.

To change the default time slice value of the ZENworks Agent on a Windows managed device:

1. Open the Registry Editor.
2. Go to HKLM\Software\Novell\ZCM\.
3. Add the BundleOrderingTimeSlice parameter as any value greater than 0, in seconds.

To change the default time slice value of the ZENworks Agent on a Linux managed device:

1. Open /etc/opt/novell/zenworks/conf/xplatzmd.properties in a text editor.
2. Add the BUNDLE_ORDERING_TIME_LAG_SEC parameter as any value greater than 0, in seconds.

**8.2.6 Blocking a Bundle that is Assigned to a Device**

In scenarios where the behavior of a bundle is not as per expectation, you can choose to block the bundle from being executed on a device. This eliminates the need of altering the bundle assignment.

1. In ZENworks Control Center, click the Devices tab.
2. Navigate to the device for which you want to block the bundle.
3. Click Relationships.
4. In the Assigned Bundles panel, select the bundles you want to block on the device.
5. Click Block.

**NOTE:** For iOS bundles created through Apple VPP subscriptions, the Block option will uninstall the bundle from the device and the app license will be revoked.

---

**8.2.7 Blocking a Bundle that is Assigned to a User**

In scenarios where the behavior of a bundle is not as per expectation, you can choose to block the bundle from being executed on a device that the user has logged in. This eliminates the need of altering the bundle assignment.

1. In ZENworks Control Center, click the Users tab.
2. Navigate to the user for which you want to block the bundle.
3. Click Relationships.
4. In the Assigned Bundles panel, select the bundles you want to block on the device that the user has logged in.
5. Click Block.

**NOTE:** For iOS bundles created through Apple VPP subscriptions, the Block option will uninstall the bundle from the device and the app license will be revoked.
8.2.8 Uninstalling a Blocked Bundle

1. In ZENworks Control Center, click the blocked bundle that you want to uninstall.
2. Click Actions > Uninstall.
3. Click Options to display the Uninstall Options dialog box.
4. Click Enable Uninstall.
5. In the Blocked Assignment Options section, select Uninstall application and click OK.
6. Click Apply.
7. Click Publish to publish the bundle to next version.

The bundle uninstalls by running the actions listed within the Uninstall action set.

8.2.9 Unblocking a Bundle That has been Blocked for a Device

1. In ZENworks Control Center, click the blocked bundle that you want to unblock.
2. In the Bundle Status panel, click Refresh.
3. Click the underlined link in the Blocked column for the device.
4. In the Bundle Status (Device assignments-Blocked) page, select the devices for which you want to unblock the bundle and click Unblock.

**NOTE:** For iOS bundles created through Apple VPP subscriptions, the Unblock option, will install the app on the device and the license information will be considered as consumed.

8.2.10 Unblocking a Bundle That has been Blocked for a User

1. In ZENworks Control Center, click the blocked bundle that you want to unblock.
2. In the Bundle Status panel, click Refresh.
3. Click the underlined link in the Blocked column for the user.
4. In the Bundle Status (User assignments-Blocked) page, select the user for whom you want to unblock the bundle and click Unblock.

**NOTE:** For iOS bundles created through Apple VPP subscriptions, the Unblock option, will install the app on the device and the license information will be considered as consumed.

8.3 Editing Bundle s

After you have assigned a bundle to a device or user, you can choose to edit the bundle:

1. In ZENworks Control Center, click the Bundles tab.
2. Click the desired bundle for which you want to edit the.
3. Click the Relationships tab.
4. Click the Assignment Details link of the assignment for which you want to edit the.
5 In the View Assignment Details dialog box, click the link next to the type you want to edit.

6 In the dialog box that displays, edit the as desired. For more information on how to edit the, click Help.

8.4 Bundle Change Management

ZENworks provides a change management capability for bundles allowing you to make changes to them with minimum disruption to IT services.

To understand bundle change management, see Chapter 7, “Understanding Bundle Change Management,” on page 127.

Review the following sections:

- Section 8.4.1, “Understanding Bundle Versions,” on page 136
- Section 8.4.2, “Managing Bundle Versions,” on page 137
- Section 8.4.3, “Publishing Sandbox,” on page 138

8.4.1 Understanding Bundle Versions

Bundle Change Management allows you to create either a sandbox-only bundle or a published version of the bundle. If you edit a published version of the bundle, a sandbox is created. You can choose to publish the sandbox either as a new version of the bundle or a new bundle.

For more information on the bundle versions, see Section 8.4.2, “Managing Bundle Versions,” on page 137.

For more information on publishing the sandbox, see Section 8.4.3, “Publishing Sandbox,” on page 138.

The Displayed Version option on the bundle’s page lists all the existing versions of the bundle, and the latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is selected by default.

Scenario:

1. Consider a bundle named sos1 that is created as a sandbox. The Displayed Version option on the bundle page lists Sandbox and it is selected by default.

2. Click Publish to publish the sandbox to a new version. The Displayed Version option on the bundle page now lists 0(Published) and it is selected by default.

3. Edit the bundle’s description to create a sandbox. The Displayed Version option on the bundle page now lists 0(Published) and Sandbox. Sandbox is selected by default.

4. Click Publish to publish the sandbox to a new version. The Displayed Version option on the bundle page now lists 0(Published), and 1(Published). The bundle’s latest version, 1(Published), is selected by default.

   0 is the older version of the bundle.

5. Edit the bundle’s description again to create a sandbox. The Displayed Version option on the bundle page now lists 0(Published), 1(Published), and Sandbox. Sandbox is selected by default.

   0 is the older version of the bundle and 1(Published) is the latest version of the bundle.
Click **Publish** to publish the sandbox to a new version. The **Displayed Version** option on the bundle page now lists 0(Published), 1(Published), 2(Published). The bundle’s latest version, 2(Published), is selected by default.

0 and 1 are the older versions of the bundle; and 2(Published) is the latest version of the bundle.

### 8.4.2 Managing Bundle Versions

The **Displayed Version** option on the bundle’s page lists all existing versions of the bundle, and the latest version of the bundle is selected by default. However, if a sandbox exists, the sandbox is selected by default.

For more information on the bundle versions, see Section 8.4.1, “Understanding Bundle Versions,” on page 136.

Select the version of the bundle whose details you want to view or edit.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Create a sandbox from the published version of the bundle | 1. Select the published version of the bundle.  
2. Edit the bundle. | A single modification made to the bundle creates a sandbox. The created sandbox is a copy of the bundle and also includes the additional edit. However, the change is not made to the published version of the bundle.  
The sandbox flows to the test devices and users to whom the bundle is assigned.  
Changes can now be made to the sandbox.  
You can revert a sandbox to the original version of the bundle or publish a sandbox to create a new version or a new bundle. |
| Create a sandbox from an older version of the bundle | 1. Select an older version of the bundle.  
2. Click **Create Sandbox**. | The created sandbox is an exact copy of the bundle version.  
Changes can now be made to the sandbox. |
| Publish a sandbox                                  | 1. Select **Sandbox**.  
2. Click **Publish** to display the Publish Option page. | The sandbox must be published for the changes to be effective on the non-test devices and users to whom the bundle is assigned. |
| Revert a sandbox                                   | 1. Select **Sandbox**.  
2. Click **Revert** to delete the sandbox. | All the changes made are discarded. The sandbox no longer exists.  
The published version of the bundle is displayed in the **Displayed Version** option. |
8.4.3 Publishing Sandbox

The sandbox must be published for the changes to be effective on the devices and users to whom the bundle is assigned. You can choose to publish the sandbox either as a new version or as a new bundle.

Review the following sections:

- “Publishing a Sandbox as a New Version” on page 138
- “Publishing a Sandbox as a New Bundle” on page 139
- “Publishing Multiple Sandbox as New Versions” on page 140

Publishing a Sandbox as a New Version

Publishing a sandbox as a new version lets you create a new version of the bundle that has a version number incremented by one from the latest available version of the bundle.

Perform the following steps in the ZENworks Control Center:

1. On the page of the bundle that you want to publish, select Sandbox in the Displayed Version option.
2. Click Publish to display the Publish Option page.
3. Click Publish as New Version.
4. (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is displayed.
   - This page lists all the bundles that the sandbox you want to publish depends on. These can include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must publish all the dependent sandbox-only bundles. However, you can choose to publish all the dependent sandbox bundles.
   - You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox-only version.
   - Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox.
4c On the Summary Page, review the information and, if necessary, use the Back button to make changes to the information.
5. Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists 0(Published), 1(Published), and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed Version option on the bundle page now lists 0(Published), 1(Published), and 2(Published).
Publishing a Sandbox as a New Bundle

Publishing a sandbox as a new bundle creates a new bundle. Perform the following steps in the ZENworks Control Center:

1. On the page of the bundle that you want to publish, select Sandbox in the Displayed Version option.
2. Click Publish to display the Publish Option page.
3. Click Publish as New Bundle.
4. Specify a name for the bundle.
   The bundle name must be different from the name of any other item (bundle, group, folder, and so forth) that resides in the same folder. The name you provide displays in ZENworks Control Center and the ZENworks Agent (on managed devices).
   For more information, see “Naming Conventions in ZENworks Control Center” in the ZENworks Control Center Reference.
5. Specify the folder name or browse to the ZENworks Control Center folder where you want the bundle to reside. The default is /bundles, but you can create additional folders to organize your bundles.
6. Select the Create as Sandbox option to create a sandbox-only version of the bundle and deploy the bundle as a sandbox. The sandbox version of a bundle enables you to test it on your device before actually deploying it.
7. Select the bundle groups that the new bundle should be a member of.
8. Click Next to display the Select Assignments page.
9. Select the device and user assignments that you want to apply to the new bundle.
10. Click Next.
11. (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is displayed.
    This page lists all the bundles that the sandbox you want to publish depends on. These can include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must publish all the dependent sandbox-only bundles. However, you can choose to publish all the dependent sandbox bundles.
   11a You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox-only version.
   11b Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox.
   11c By default, the dependent bundles are published to the next version. You can choose to select the Publish the dependent bundles as new bundles option to publish the dependent bundles as new bundles.
      Specify the name or browse to the folder where you want the new bundles to reside. If a bundle that has the same name as the new bundle already exists in the specified folder, then the new bundle is saved with a random GUID appended to its name.
12. On the Summary Page, review the information and, if necessary, use the Back button to make changes to the information.
13. Click Finish to create the bundle.
Publishing Multiple Sandbox as New Versions

Perform the following steps in the ZENworks Control Center:

1. Select a few bundle folders, bundle groups and bundles.
2. Click Action > Publish Bundle(s) to display the Publish Options page.
3. (Conditional) Select the Include bundles from subfolders also option to publish all the bundles within the selected folders as new versions of the bundles. This option is displayed only if you have selected a bundle folder in Step 1.
4. Click Next. On the Select Bundles page, select the bundles you want to publish to next version, then click Next.
5. (Conditional) If the bundle has any dependencies, the Publish Dependent Bundles Page is displayed.
   This page lists all the bundles that the sandbox you want to publish depends on. These can include sandbox-only bundles (bundles that were directly created as a sandbox), or sandbox bundles (bundles that were edited to create a sandbox). To publish the sandbox, you must publish all the dependent sandbox-only bundles. However, you can choose to publish all the dependent sandbox bundles.
   5a. You must select the Publish sandbox only bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox-only version.
   5b. Select the Publish sandbox for all bundle(s) that this bundle depends on option to publish all the dependent child bundles that have a sandbox.
   5c. On the Summary Page, review the information and, if necessary, use the Back button to make changes to the information.
6. Click Finish to create a new published version.

For example, if the Displayed Version option on the bundle page lists 0(Published), 1(Published), and Sandbox, publishing the sandbox as a new version creates a version 2. The Displayed Version option on the bundle page now lists 0(Published), 1(Published), and 2(Published).

8.5 Copying a Bundle to a Content Server

By default, a bundle’s content is copied to primary content server. If you specify certain content servers as hosts, the bundle is hosted on only those content servers; it is not copied to all content servers. You can also specify whether the selected bundle is replicated to new content servers (ZENworks Servers and satellite servers) that are added to the Management Zone.

To specify a content server:

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle (or bundles).
3. Click Action > Specify Content Server.
4. The Configure Primary Server Content Replication page lets you specify on which content servers (ZENworks Servers) the content is hosted.
   The relationships between content and content servers that you create using this wizard override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and Server 2 and you use this wizard to host it on Server 1 only, Bundle A is excluded from Server 2 and is removed during the next d replication.
   4a. In the Excluded Primary Servers list, select the desired content server.
You can use Shift+click and Ctrl+click to select multiple content servers.

4b Click the button to move the selected content server to the Included Primary Servers list.

4c Specify the default replication behavior for new ZENworks Primary Servers added to the system:

- **Include This Content**: Replicates the content to any servers created in the future.
- **Exclude This Content**: Excludes the content from being replicated to any servers created in the future.

Be aware that any content replication relationships previously set between the content and servers are lost upon completion of this wizard.

5 Click Next to display the Configure Satellite Server Content Replication page:

This page lets you specify on which content servers (satellite servers) the content is hosted. The relationships between content and content servers that you create using this wizard override any existing relationships. For example, if Bundle A is currently hosted on Server 1 and Server 2 and you use this wizard to host it on Server 1 only, Bundle A is excluded from Server 2 and is removed during the next replication.

5a In the Excluded Satellite Servers list, select the desired content server.

You can use Shift+click and Ctrl+click to select multiple content servers.

You cannot include content on a satellite server without including it on the satellite server’s parent ZENworks Server. You must select both the satellite server and its parent.

5b Click the button to move the selected content server to the Included Satellite Servers list.

5c Specify the default replication behavior for new ZENworks satellite servers added to the system:

- **Include This Content**: Replicates the content to any servers created in the future.
- **Exclude This Content**: Excludes the content from being replicated to any servers created in the future.

Be aware that any content replication relationships previously set between the content and servers are lost upon completion of this wizard.

6 Click Next to display the Finish page, then review the information and, if necessary, use the Back button to make changes to the information.

7 Click Finish to create the relationships between the content and the content servers. Depending on the relationships created, the content is replicated to or removed from content servers during the next replication.

### 8.6 Bundle Behavior Based on Content Replication Settings

When you created a bundle in earlier versions of ZENworks, the bundle inherited the content replication settings from its parent folder by default. However, with the introduction of Bundle Change Management, the behavior has been changed. For more information on this change, see the following table:
<table>
<thead>
<tr>
<th>Task</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating a bundle (not as a sandbox)</td>
<td>The new bundle inherits the settings from its parent folder by default.</td>
</tr>
<tr>
<td>Creating a bundle as a sandbox</td>
<td>The new bundle neither inherits settings from its parent folder nor does it replicate content by default.</td>
</tr>
<tr>
<td></td>
<td>To replicate the content on new Primary Servers:</td>
</tr>
<tr>
<td></td>
<td>1. In ZENworks Control Center, click the bundle.</td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Primary Server Replication</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. In the Primary Server Replication Status panel, select the <strong>New Primary Servers added to the system will include this content by default</strong> option.</td>
</tr>
<tr>
<td></td>
<td>To replicate the content on new Satellite Servers:</td>
</tr>
<tr>
<td></td>
<td>1. In ZENworks Control Center, click the bundle.</td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Satellite Server Replication</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. In the Satellite Server Replication Status panel, select the <strong>New Satellite Servers added to the system will include this content by default</strong> option.</td>
</tr>
<tr>
<td></td>
<td><strong>NOTE:</strong> The <strong>Sync Sandbox Content to Content Servers</strong> option on the Sandbox Settings page of the bundle is deselected and is not editable.</td>
</tr>
<tr>
<td>Creating a sandbox from a published version or an older version of the bundle</td>
<td>The sandbox version of the bundle neither inherits settings from its parent folder nor does it replicate content by default.</td>
</tr>
<tr>
<td></td>
<td>To replicate the content on new Primary and Satellite Servers:</td>
</tr>
<tr>
<td></td>
<td>1. In ZENworks Control Center, click the bundle.</td>
</tr>
<tr>
<td></td>
<td>2. Click the <strong>Settings</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>3. Click <strong>Sandbox Settings</strong>.</td>
</tr>
<tr>
<td></td>
<td>4. In the Sandbox Content Replication panel, select the <strong>Sync Sandbox Content to Content Servers</strong> option.</td>
</tr>
</tbody>
</table>
8.7 Export and Import Bundles

Using the Export and Import bundles feature, you can copy bundles from one zone to another. This feature helps you to export and import bundles from a test environment to a production environment.

- Section 8.7.1, “Export Bundles,” on page 144
- Section 8.7.2, “Import Bundles,” on page 144

**Use Case:** This feature is useful in a scenario where you want to deploy an application to multiple devices using the bundle feature, and prior to publishing the bundle, you want to test it to ensure that there are no glitches during deployment.
The bundle export and import feature enables you to create a bundle in a test zone and test the functionality of the bundle. After you have tested the bundle, you can export the bundle as a ZIP file to your local drive using the **Export** feature that is available in ZENworks Control Center (ZCC). The same ZIP file can then be imported to the production zone by using the **Import** feature.

### 8.7.1 Export Bundles

This feature enables you to export bundles to the local drive. When you export bundles using this feature, metadata files, icons, settings, and content files are exported. If you export bundles using the `zman bundle-export-to-file` command, only the bundle metadata (optionally bundle content) files are exported.

To export bundles:

1. Log into ZENworks Control Center, and in the left pane click **Bundles**.
2. Select the bundles that you want to export.
3. Click **Action > Export Bundle**.

   Based on the browser settings, you will be either prompted for the download location or the bundle will be automatically saved to the default download location.

### 8.7.2 Import Bundles

This feature enables you to import bundles from the local drive into the zone.

To import bundles:

1. Click **New > Import Bundle**.
2. Upload the bundle in the required format:
   - ZIP file - Click , click **Browse** to select the required file and then click **Upload**.
   - A directory - Click , and allow the browser to launch ZCC Helper. Click **Browse** to select the required folder and then click **Upload**.

   **NOTE:** To upload a directory, ensure that ZCC Helper is installed on the device.

3. Select **Maintain Folder Structure**, to retain the folder structure of the imported bundle.
4. Select **Create as Sandbox** to create a sandbox-only version of the bundle that can be tested before being published.
5. Click **Next**.
6. (Optional) In the **Bundle Configuration** page, double-click the bundle name to edit the name.
7. (Optional) The **Resolve Bundle Issues** page is displayed only if there are any issues while importing bundles.

   You can either resolve the issues, or select the issues for deletion.

8. Click **Next**. The **Bundle Summary** page displays the details of the imported bundles.
9. Click **Finish**. The **Bundle Import Status** page displays the status of all the bundles that were imported.
8.8 Dependency Bundles

When you create the following actions for a bundle, you create bundle dependencies:

- Action - Install Bundle
- Action - Launch Bundle
- Action - Uninstall Bundle
- Action - Repair Bundle

A bundle’s Dependency Bundles tree shows the chaining information of that bundle and the action sets that each dependency is in. To view the Dependency Bundles tree in ZENworks Control Center, click the Bundles tab, click a bundle that has dependent bundles, then on the Summary tab, click the Display Bundle Dependencies link in the Dependency Bundles row. If the selected bundle does not have dependent bundles, the link displays None instead of Display Bundle Dependencies.

The following sections contain additional information:

- Section 8.8.1, “Primary Applications vs. Dependent Applications,” on page 145
- Section 8.8.2, “Bundle Chains,” on page 146
- Section 8.8.3, “Distributing, Installing, and Launching a Bundle That Has Dependencies,” on page 146

8.8.1 Primary Applications vs. Dependent Applications

When working with bundle dependencies, the primary bundle is the bundle for which you are establishing dependencies. The bundles that are defined as dependencies are called the dependent bundles. The following illustration shows this relationship. Application A as the primary bundle with Applications B, C, and D as dependent bundles.

![Dependency Bundle Tree](image)

A primary bundle can have one dependent application or, as shown in the above example, it can have multiple dependent applications.

In addition, a bundle can be both a primary bundle and a dependent bundle, as shown in the following illustration. Application A as the primary bundle, with Applications B, B1, B2, C, and D as dependent bundles.

![Dependency Bundle Tree](image)
In the above example, Application B is one of Application A's dependent bundles. At the same time, Application B has dependencies on two bundles, Application B1 and Application B2.

8.8.2 Bundle Chains

A bundle chain is two or more bundles linked together by dependencies. In its simplest form, a application chain consists of two levels, as shown in the following illustration.

![Dependency Bundle Tree](illustration)

However, when bundle dependencies are nested, a bundle chain can grow to include many levels. In the following example, Application A has a dependency on Application B. Application B, in turn, has dependencies on Application B1 and Application B2. As a result, all three bundles (B, B1, B2), in addition to applications C and D, must be present in order for Application A to run.

![Dependency Bundle Tree](illustration)

In some cases, a bundle might belong to more than one bundle chain, as in the following example where Application D is a dependent application for both Application A and Application E.

8.8.3 Distributing, Installing, and Launching a Bundle That Has Dependencies

When setting up bundle dependencies, you should be aware of the following:

**Bundle Assignment:** A dependent bundle does not need to be assigned to devices or users. The primary bundle, however, must be assigned to one or more devices or users for it to function properly.

**Distribution and Installation:** If dependent bundles have not already been distributed to or installed on the user's workstation, when a user launches or installs a bundle, ZENworks Agent distributes and installs them. If ZENworks Agent is unable to distribute or install a dependent bundle (for example, the user's workstation does not meet the dependent bundle's system requirements), the primary bundle is not launched or installed.

**Distribution Through an Add-On Image:** If you distribute a bundle through an image add-on, its dependent bundles must be included as another image add-on. Otherwise, the distribution of the primary bundle fails.
**Distribution to Disconnected Workstations:** For disconnected workstations, the bundles must be force cached to the workstation before it becomes disconnected. If changes are made to dependent bundles after the bundles have been cached to workstations, the version number of the primary bundle must be updated in order to force a re-cache of the bundles.

**Launch:** Each time a bundle is launched, ZENworks Agent performs any launch operations, such as other actions, defined for its dependent bundles.

**Reboot/Shutdown:** Ensure that the dependent bundle does not include a Reboot / Shutdown action.

**Redeploying a Bundle to Refresh Its Dependencies:** ZENworks Agent distributes a dependent bundle only once, unless the dependent bundle’s version is updated or the distribution or installation is unsuccessful. If you include a dependent bundle in a primary bundle through the Install action set, and if there are changes in the dependent bundle, you need to change the primary bundle to reflect the dependent bundle changes. If you include a dependent bundle in a primary bundle through the launch action set, and if there are changes in the dependent bundle, you need to launch the primary bundle again to reflect the dependent bundle changes.
Managing Bundle Assignments

ZENworks lets you assign bundles to users as well as devices. Device-assigned bundles are available whenever the device is running; user-assigned bundles are available only when the user is logged in to the Management Zone. For example, if you assign a bundle to a user, the bundle is available only after the user logs in. Unlike devices, users are not defined in your Management Zone. Instead, you connect to the LDAP directory that you want to use as your authoritative user source. If necessary, you can connect to multiple directories. For more information on the user source, see the ZENworks User Sources Reference.

You can manage a bundle assignment from the bundle’s Relationships page (Click the bundle and then the Relationship tab). The Relationships page is not affected by the bundle change management capability.

**NOTE:** If you have different schedules configured for a bundle that is assigned to multiple objects such as users, devices, or their groups and folder assignments:

- All the assigned schedules are applicable.
- The Shortcut Location assignments, which are configured to specify the locations on the managed device where ZENworks Agent displays the bundle’s icon, are merged and the shortcut is displayed in all configured locations.

Review the following sections:

- Section 9.1, “Assigning Existing Bundles to Devices,” on page 149
- Section 9.2, “Assigning Existing Bundles to Users,” on page 152
- Section 9.3, “Assigning a Bundle Group to Devices,” on page 154
- Section 9.4, “Assigning a Bundle Group to Users,” on page 156
- Section 9.5, “Copying the Relationships of a Device to Other Devices, Folders, and Groups,” on page 157

9.1 Assigning Existing Bundles to Devices

When you create bundles, the object is created without assigning devices or users to it, or specifying distribution, launch, or availability schedules. Before the bundle can be used on assigned devices, you must complete the steps in the following procedure. You can assign bundles to devices, device groups, or device folders.

You can use ZENworks Control Center or the zman command line utility to assign bundles. The following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer the zman command line utility, see the “Bundle Commands” in “ZENworks Command Line Utilities”.

1. In ZENworks Control Center, click the Bundles tab.
2. Select the desired bundle in the Bundles list by clicking the box next to its name, click Action, then click Assign to Device.

   or

   Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.
A bundle must be assigned to devices and users before it can be distributed to them. You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle to a folder or group is the preferred method of assigning bundles. This allows for easier management of the bundle assignments and can decrease the possibility of high server utilization caused by assigning the bundle to a large number of items (for example, more than 250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign the bundle.

The Select Objects dialog box opens with the Devices folder as the root folder. By default, the Servers and Workstations folders are displayed along with any custom folders that you have created in the Devices folder.

Browse for and select the devices or users, groups, and folders to which you want to assign the bundle. To do so:

3a Click next to a folder (for example, the Workstations folder or Servers folder) to navigate through the folders until you find the device, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can also use the Item name box to search for the item.

3b Click the underlined link in the Name column to select the device, group, or folder and display its name in the Selected list box.

3c Click OK to add the selected devices, folders, and groups to the Devices list.

4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device where ZENworks Agent displays the bundle’s icon.

The possible locations include the following:

**Application Window:** Places the icon in the Application window. This location is selected by default.

**Quick Launch:** Places the icon on the Quick Launch area of the Windows taskbar.

**Desktop:** Places the icon on the device’s desktop.

**System Tray:** Places the icon in the system tray (notification area) of the Windows taskbar.

**Start Menu:** Places the icon on the Start menu on all Windows devices except for Windows Vista and later. It places the icon in Start > All Programs on Windows Vista and later.

**Taskbar:** Places the icon on the taskbar.

**Start Menu Tiles:** Places the icon on the Start menu tiles. This is applicable only for Windows 10 and later versions.

On a Windows Vista devices, if you want to change the look and feel of the Start menu or pin applications to the Start menu, see Appendix D, “Best Practices,” on page 199.

5 Click Next to display the Schedules page.

In the Schedules page select the schedules you want to define:

**Distribution Schedule:** Defines the dates and times when the content of the bundle is distributed from the ZENworks Server to the managed device or user. If you do not establish a schedule, the bundle’s content is distributed to the device or user when it is first launched. However, the schedule does not define the date and time when the action in the bundle runs.

**Launch Schedule:** Defines the dates and times when the ZENworks Agent automatically launches the bundle. If you do not establish a schedule, the bundle is launched only when the user launches it. Before launching the bundle, the ZENworks Agent checks if the bundle is
distributed and installed. If the bundle is not yet distributed, the agent first distributes the bundle, performs the bundle’s install actions to install the bundle, then performs the bundle’s launch actions to launch it.

**IMPORTANT:** If Install Immediately after Distribution and Launch Immediately after Installation options are set for the distribution schedule of a bundle, the content of the bundle is distributed as per the schedule and, then the bundle is installed and launched.

The Bundle that is distributed once will not be distributed again on the next schedule. Hence, the Install Immediately after Distribution and Launch Immediately after Installation options which are specified in the distribution schedule are not considered on subsequent schedules.

To launch the same bundle repeatedly on subsequent schedules, you need to configure the launch schedule.

**Availability Schedule:** Defines the dates and times when the bundle is available to the device or user. The ZENworks Agent displays the bundle icon only during the times defined by the schedule. If you do not establish a schedule, the bundle is available at all times.

**NOTE:** If a bundle with an assignment schedule fails to execute on a device, an attempt to execute the bundle on the device is made five times, by default.

To change the default value:

1. Open the Registry Editor.
2. Go to HKLM\Software\Novell\ZCM\.
3. Create a STRING called ScheduleRetries, and set its value as desired.

For example, if you do not want the failed bundle to be executed again on the device, set the value of the ScheduleRetries to 0.

6. (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle to be distributed to the device when it is first launched.

7. In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed information, click the Help button on the wizard page or see the following sections in the ZENworks Primary Server and Satellite Reference:

- “Date Specific”
- “Recurring”
- “Event”
- “Now”

For the 'Now' schedule to be effective during bundle assignment, ensure that the number of devices to which you want to assign a bundle does not exceed 30. The Now schedule sets a refresh device schedule and triggers a bundle quick task. To assign bundles randomly to more than 30 devices, use the Quick Tasks option in ZENworks Control Center.

For more information on the quick tasks, see “Using Quick Tasks” in the ZENworks Control Center Reference.

8. Select the following options as desired:

**Wake-on-LAN:** If the device is not on at the scheduled time, ZENworks attempts to use Wake-on-LAN (WOL) technology to power on the device. The device must support WOL.
NOTE: If you are assigning bundles to Wake-on-Lan devices with Date Specific scheduling option, you need to enable the Process immediately if device unable to execute on schedule option. This is required for the distribution to occur on schedule after the device wakes and receives the bundle distribution schedule.

**Install Immediately After Distribution**: Performs any installation actions immediately after the bundle is distributed to the device.

**Launch Immediately After Installation**: Performs any launch actions immediately after the bundle is installed. This option is available only if the Install Immediately After Distribution option is enabled.

9 (Conditional) If you selected Launch Schedule in Step 5, click Next to display the Bundle Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Agent automatically launches the bundle. The default schedule (no schedule) results in the bundle only being launched if the user launches it.

10 In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed information, click the Help button on the wizard page or see the following sections in the ZENworks Primary Server and Satellite Reference:

- "Date Specific"
- "Recurring"
- "Event"

11 (Conditional) If you selected Availability Schedule in Step 5, click Next to display the Bundle Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the managed device. ZENworks Agent displays the bundle icon only during the times defined by the schedule. The default schedule (no schedule) makes the bundle available at all times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user has not yet installed the bundle, it is only available for installation at the times specified by the schedule. If a user has already installed the bundle, it is only available for running during the scheduled times.

12 In the Schedule Type field, select one of the following schedules, then fill in the fields. For detailed information, click the Help button on the wizard page or see the following sections in the ZENworks Primary Server and Satellite Reference:

- "Date Specific"
- "Recurring"

13 Click Next to display the Finish page, review the information and, if necessary, use the Back button to make changes to the information.

14 Click Finish.

### 9.2 Assigning Existing Bundles to Users

When you create bundles, the object is created without assigning devices or users to it, or specifying distribution, launch, or availability schedules. Before the bundle can be used on assigned devices, you must complete the steps in the following procedure. You can assign bundles to users, user groups, or user folders.
You can use ZENworks Control Center or the zman command line utility to assign bundles. The following procedure explains how to assign a bundle using ZENworks Control Center. If you prefer the zman command line utility, see the “Bundle Commands” in ZENworks Command Line Utilities Reference.

1 In ZENworks Control Center, click the Bundles tab.

2 Select the desired bundle in the Bundles list by clicking the box next to its name, click Action, then click Assign to User.

or

Click the desired bundle, click Relationships. In the Device Assignments panel, click Add.

A bundle must be assigned to devices and users before it can be distributed to them.

You can assign the bundle to individual devices, users, folders, or groups. Assigning a bundle to a folder or group is the preferred method of assigning bundles. This allows for easier management of the bundle assignments and can decrease the possibility of high server utilization caused by assigning the bundle to a large number of items (for example, more than 250).

3 In the Select Objects dialog box, browse to and select the objects to which you want to assign the bundle.

The Select Objects dialog box opens with the Users folder as the root folder. By default, the user sources that have been defined are displayed, as well as the ZENworks User Groups folder.

Browse for and select the users, groups, and folders to which you want to assign the bundle. To do so:

3a Click next to a folder to navigate through the folders until you find the user, group, or folder you want to select.

If you are looking for a specific item, such as a User or a User Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can also use the Item name box to search for the item.

3b Click the underlined link in the Name column to select the user, group, or folder and display its name in the Selected list box.

3c Click OK to add the selected users, folders, and groups to the Devices list.

4 Specify the bundle’s shortcut location.

You can use the Shortcut Location assignments to specify the locations on the managed device where ZENworks Agent displays the bundle’s icon. The possible locations include the following:

**Application Window:** Places the icon in the Application window. This location is selected by default.

**Quick Launch:** Places the icon on the Quick Launch toolbar area of the Windows taskbar.

**Desktop:** Places the icon on the device’s desktop.

**System Tray:** Places the icon in the system tray (notification area) of the Windows taskbar.

**Start Menu:** Places the icon on the Start menu on all Windows devices except for Windows Vista and later. On Windows Vista and later, it places the icon in Start > All Programs.

On Windows Vista devices, if you want to change the look and feel of the Start menu or pin applications to the Start menu, see Appendix D, “Best Practices,” on page 199.

5 Click Next to display the Schedules page, then select the schedules you want to define. For information, see Step 5 in Assigning Existing Bundles to Devices (page 149).

6 (Conditional) If you selected Distribution Schedule in Step 5, click Next to display the Bundle Distribution Schedule page.
The distribution schedule defines the dates and times when the bundle is distributed from the ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle to be distributed to the device when it is first launched.

7 In the **Schedule Type** field, select one of the schedules, then fill in the fields. For more information, see Step 7 in Assigning Existing Bundles to Devices.

8 Select the following options as desired:

- **Wake on LAN:** If the device is not on at the scheduled time, ZENworks attempts to use Wake on LAN (WoL) technology to power on the device. The device must support Wake on LAN.

- **Install Immediately After Distribution:** Performs any installation actions immediately after the bundle is distributed to the device.

- **Launch Immediately After Installation:** Performs any launch actions immediately after the bundle is installed. This option is available only if the **Install Immediately After Distribution** option is enabled.

9 (Conditional) If you selected **Launch Schedule** in Step 5, click **Next** to display the Bundle Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Agent automatically launches the bundle. The default schedule (no schedule) results in the bundle only being launched if the user launches it.

10 In the **Schedule Type** field, select one of the following schedules, then fill in the fields. For information, see Step 10 in Assigning Existing Bundles to Devices.

11 (Conditional) If you selected **Availability Schedule** in Step 5, click **Next** to display the Bundle Availability Schedule page.

The availability schedule defines the dates and times when the bundle is available on the managed device. ZENworks Agent displays the bundle icon only during the times defined by the schedule. The default schedule (no schedule) makes the bundle available at all times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user has not yet installed the bundle, it is only available for installation at the times specified by the schedule. If a user has already installed the bundle, it is only available for running during the scheduled times.

12 In the **Schedule Type** field, select one of the following schedules, then fill in the fields. For more information, see Step 12 in Assigning Existing Bundles to Devices.

13 Click **Next** to display the Finish page, review the information and, if necessary, use the **Back** button to make changes to the information.

14 Click **Finish**.

If you assign bundles to Active Directory users, the assignments are available to the users only if the ZENworks server is able to resolve the DNS name of the Active Directory.

## 9.3 Assigning a Bundle Group to Devices

You can assign bundle group to devices, device groups, or device folders.

1 In ZENworks Control Center, click the **Bundles** tab.

2 In the **Bundles** list, select the check box next to the bundle group (or bundle groups).

3 Click **Action > Assign to Device**.
4 Browse for and select the devices, device groups, and device folders to which you want to assign the group. To do so:

4a Click next to a folder (for example, the Workstations folder or Servers folder) to navigate through the folders until you find the device, group, or folder you want to select.

If you are looking for a specific item, such as a Workstation or a Workstation Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can use the Item name box to search for the item.

4b Click the underlined link in the Name column to select the device, group, or folder and display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Devices list.

5 Specify the locations on the managed device where ZENworks Agent displays the bundle group’s icons. The possible locations are:

- **Application Window:** Places the icons in the Application window.
- **Desktop:** Places the icons on the device’s desktop.
- **Quick Launch:** Places the icons on the Quick Launch area of the Windows taskbar.
- **Start Menu:** Places the icons on the Start menu on all Windows devices except for Windows Vista and later. It places the icon in Start > All Programs on Windows Vista and later.
- **System Tray:** Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define. For information on schedules, see Step 5 in Assigning Existing Bundles to Devices (page 149).

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle Distribution Schedule page.

The distribution schedule defines the dates and times when the bundle is distributed from the ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle to be distributed to the device when it is first launched.

8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For information, see Step 7 in Assigning Existing Bundles to Devices.

9 Select the following options as desired:

- **Wake on LAN:** If the device is not on at the scheduled time, ZENworks attempts to use Wake on LAN (WOL) technology to power on the device. The device must support Wake on LAN.
- **Install Immediately After Distribution:** Performs any installation actions immediately after the bundle is distributed to the device.
- **Launch Immediately After Installation:** Performs any launch actions immediately after the bundle is installed. This option is available only if the Install Immediately After Distribution option is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle Launch Schedule page.

The launch schedule determines the dates and times when ZENworks Agent automatically launches the bundle. The default schedule (no schedule) results in the bundle only being launched if the user launches it.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For information, see Step 10 in Assigning Existing Bundles to Devices.

12 (Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle Availability Schedule page.
The availability schedule defines the dates and times when the bundle is available on the managed device. ZENworks Agent displays the bundle icon only during the times defined by the schedule. The default schedule (no schedule) makes the bundle available at all times.

The schedule applies regardless of whether or not the bundle is installed. For example, if a user has not yet installed the bundle, it is only available for installation at the times specified by the schedule. If a user has already installed the bundle, it is only available for running during the scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For more information, see Step 12 in Assigning Existing Bundles to Devices.

14 Click Next to display the Finish page, review the information and, if necessary, use the Back button to make changes to the information.

15 Click Finish.

9.4 Assigning a Bundle Group to Users

You can assign bundle group to users, user groups, or user folders.

1 In ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, select the check box next to the bundle group (or bundle groups).

3 Click Action > Assign to User.

4 Browse for and select the user, user groups, and user folders to which you want to assign the group. To do so:

4a Click ▼ next to a folder to navigate through the folders until you find the user, group, or folder you want to select.

   If you are looking for a specific item, such as a User or a User Group, you can use the Items of type list to limit the types of items that are displayed. If you know the name of the item you are looking for, you can use the Item name box to search for the item.

4b Click the underlined link in the Name column to select the user, group, or folder and display its name in the Selected list box.

4c Click OK to add the selected devices, folders, and groups to the Users list.

5 Specify the locations on the managed device where ZENworks Agent displays the bundle group’s icons. The possible locations are:

   Application Window: Places the icons in the Application window.

   Desktop: Places the icons on the device’s desktop.

   Quick Launch: Places the icons on the Quick Launch area of the Windows taskbar.

   Start Menu: Places the icons on the Start menu on all Windows devices except for Windows Vista and later. It places the icon in Start > All Programs on Windows Vista and later.

   System Tray: Places the icons in the system tray (notification area) of the Windows taskbar.

6 Click Next to display the Schedules Page, then select the schedules you want to define. For information on schedules, see Step 5 in Assigning Existing Bundles to Devices (page 149).

7 (Conditional) If you selected Distribution Schedule in Step 6, click Next to display the Bundle Distribution Schedule page.

   The distribution schedule defines the dates and times when the bundle is distributed from the ZENworks Server to the managed device. The default schedule (no schedule) causes the bundle to be distributed to the device when it is first launched.
8 In the Schedule Type field, select one of the following schedules, then fill in the fields. For information, see Step 7 in Assigning Existing Bundles to Devices.

9 Select the following options as desired:

   **Wake on LAN:** If the device is not on at the scheduled time, ZENworks attempts to use Wake on LAN (WoL) technology to power on the device. The device must support Wake on LAN.

   **Install Immediately After Distribution:** Performs any installation actions immediately after the bundle is distributed to the device.

   **Launch Immediately After Installation:** Performs any launch actions immediately after the bundle is installed. This option is available only if the Install Immediately After Distribution option is enabled.

10 (Conditional) If you selected Launch Schedule in Step 6, click Next to display the Bundle Launch Schedule page.

   The launch schedule determines the dates and times when ZENworks Agent automatically launches the bundle. The default schedule (no schedule) results in the bundle only being launched if the user launches.

11 In the Schedule Type field, select one of the following schedules, then fill in the fields. For information, see Step 10 in Assigning Existing Bundles to Devices.

12 (Conditional) If you selected Availability Schedule in Step 6, click Next to display the Bundle Availability Schedule page.

   The availability schedule defines the dates and times when the bundle is available on the managed device. ZENworks Agent displays the bundle icon only during the times defined by the schedule. The default schedule (no schedule) makes the bundle available at all times.

   The schedule applies regardless of whether or not the bundle is installed. For example, if a user has not yet installed the bundle, it is only available for installation at the times specified by the schedule. If a user has already installed the bundle, it is only available for running during the scheduled times.

13 In the Schedule Type field, select one of the following schedules, then fill in the fields. For information, see Step 12 in Assigning Existing Bundles to Devices.

14 Click Next to display the Finish page, review the information and, if necessary, use the Back button to make changes to the information.

15 Click Finish.

### 9.5 Copying the Relationships of a Device to Other Devices, Folders, and Groups

The Copy Relationships page allows you to copy the Bundles, Policies and Group relationships of a selected device to the target devices, folders, and groups. It also allows you to add the target devices, devices inside the target folder, members of the target groups to members of the groups in which the selected device is a member.

The Copy Relationships option is not enabled for a workstation group or a dynamic workstation group.

To perform Copy Relationships operation:

1 In ZENworks Control Center, click the Devices tab.

2 In the Devices page, select the check box next to a device.

   For the Copy Relationships operation, you need to select a device that has existing relationships to copy. Otherwise, an error message is displayed:
The selected target object has no relationships to perform copy operation

3 Click Action > Copy Relationships.

4 Select either all or only the required bundles, policies, and groups for copying.

5 Click Next to display the Select Target Objects page.

6 Select devices, folders, or groups to which you want to copy the relationships. When you select a folder or group, the relationships will be copied only to the objects within the folder or group.

7 Direct Assignment Options allow you to copy relationships easily if the target devices are members of a folder or members of groups. Select all or only the required Direct Assignment Options listed.

7a If you check this, the relationships will be copied to the devices within the selected target groups.

7b If you check this, the relationships will be copied to the devices within the selected folders.

7c If you check this, the relationships will be copied to the devices within the sub-folders of the selected target folders.

8 Conflict Resolution Options resolve the conflicts that might arise due to a conflict between the existing relationships of the target device and that of the selected device. Select all or only the required Conflict Resolution Options listed:

8a If you check this, the existing relationships of the target device will be removed while copying the selected relationships.

8b If you check this, the selected relationships will be copied to the target device and the existing relationships will be retained.

9 Group Membership Options allow you to add members of the target groups, objects of the target folder and sub-folder as members of the groups to which the selected device belongs. You can add the target devices as members of the groups in which the selected device is a member. You can also add members of target groups as members of the groups in which the selected device is a member.

9a If you check this, the members of the target group will be added as members of the group to which the selected device belongs.

9b If you check this, objects that are inside the target folders will be added as members of the groups to which the selected device belongs.

9b1 If you check this, objects inside a folder and its sub-folder will be added as members of the groups to which the selected device belongs.

9c If you check this, the group memberships of the target devices will be deleted.

10 Click Next to display the Finish page, then review the information and, if necessary, use the Back button to make changes to the configured settings for Copy Relationships> Click OK.
Managing System Requirements

The System Requirements panel lets you define specific requirements that a device must meet for the bundle to be distributed to it.

You define requirements through the use of filters. A filter is a condition that must be met by a device in order for the bundle to be applied. For example, you can add a filter to specify that the device must have exactly 512 MB of RAM in order for the bundle to be applied, and you can add another filter to specify that the hard drive be at least 20 GB in size.

Review the following sections:

- Section 10.1, “Adding System Requirements for a Bundle,” on page 159
- Section 10.2, “Copying a Bundle’s System Requirements,” on page 165
- Section 10.3, “Copying a Bundle Group’s System Requirements,” on page 166

10.1 Adding System Requirements for a Bundle

1. In ZENworks Control Center, click the Bundles tab.
2. Click the underlined link for the desired bundle to display the bundle’s Summary page.
3. Click the Requirements tab.
4. Click Add Filter, select a filter condition from the drop-down list, then fill in the fields.
   As you construct filters, you need to know the conditions you can use and how to organize the filters to achieve the desired results. For more information, see Section 10.1.1, “Filter Conditions,” on page 159 and Section 10.1.2, “Filter Logic,” on page 165.
5. (Conditional) Add additional filters and filter sets.
6. Click Apply to save the settings.

NOTE: After defining a bundle’s system requirements, you can copy its requirements and apply it to other bundles or policies. To do so, click the Bundles tab, select the check box in front of the bundle, click Edit, click Copy System Requirements, select Bundles or Policies, then click Add to select the bundles or policies to which you want to copy the selected bundle’s system requirements.

10.1.1 Filter Conditions

You can choose from any of the following conditions when creating a filter. Place your mouse pointer over fields that require input to display a tooltip containing example usage.

Architecture: Determines the architecture of Windows* running on the device. The condition you use to set the requirement includes a property, an operator, and a property value. The possible operators are equals (=) and does not equal (<>). For example, if you set the condition to architecture = 32, the device’s Windows operating system must be 32-bit to meet the requirement.
**Bundle Installed:** Determines if a specific bundle is installed. After specifying the bundle, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the specified bundle must already be installed to meet the requirement. If you select **No**, the bundle must not be installed.

**Configuration Location:** Determines if the bundle is applicable to a specific location. The condition you use to set the requirement includes an operator and a value. The possible operators are equals (=) and does not equal (<>). The values are the existing locations in the Management Zone. For example, if you set the condition to `=location_name`, the selected location must match the device’s location to meet the requirement.

**Configuration Network Environment:** Determines if the bundle is applicable to a specific network environment. The condition you use to set the requirement includes an operator and a value. The possible operators are equals (=) and does not equal (<>). The values are the existing network environments in the Management Zone. For example, if you set the condition to `=network_environment_name`, the selected network environment must match the device’s current network environment to meet the requirement.

**Connected:** Determines if the device is connected to the network. The two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the device must be connected to the network to meet the requirement. If you select **No**, it must not be connected.

**Connection Speed:** Determines the speed of the device’s connection to the network. The condition you use to set the requirement includes an operator and a value. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible values are bits per second (bps), kilobits per second (Kbps), megabits per second (Mbps), and gigabits per second (Gbps). For example, if you set the condition to `>= 100 Mbps`, the connection speed must be greater than or equal to 100 megabits per second to meet the requirement.

**Disk Space Free:** Determines the amount of free disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to `c: >= 80 MB`, the free disk space must be greater than or equal to 80 megabytes to meet the requirement.

**Disk Space Total:** Determines the amount of total disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to `c: >= 40 GB`, the total disk space must be greater than or equal to 40 gigabytes to meet the requirement.

**Disk Space Used:** Determines the amount of used disk space on the device. The condition you use to set the requirement includes a disk designation, an operator, and a value. The disk designation can be a local drive map (for example, c: or d:). The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible values are bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to `c: <= 10 GB`, the used disk space must be less than or equal to 10 gigabytes to meet the requirement.

**Environment Variable Exists:** Determines if a specific environment variable exists on the device. After specifying the environment variable, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the environment variable must exist on the device to meet the requirement. If you select **No**, it must not exist.
Environment Variable Value: Determines if an environment variable value exists on the device. The condition you use to set the requirement includes the environment variable, an operator, and a variable value. The environment variable can be any operating system supported environment variable. The possible operators are equal to, not equal to, contains, and does not contain. The possible variable values are determined by the environment variable. For example, if you set the condition to Path contains c:\windows\system32, the Path environment variable must contain the c:\windows\system32 path to meet the requirement.

File Date: Determines the date of a file. The condition you use to set the requirement includes the filename, an operator, and a date. The filename can be any filename supported by the operating system. The possible operators are on, after, on or after, before, and on or before. The possible dates are any valid dates. For example, if you set the condition to appl.msi on or after 6/15/07, the appl.msi file must be dated 6/15/2007 or later to meet the requirement.

File Exists: Determines if a file exists. After specifying the filename, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the specified file must exist to meet the requirement. If you select No, the file must not exist.

File Size: Determines the size of a file. The condition you use to set the requirement includes the filename, an operator, and a size. The filename can be any file name supported by the operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible sizes are designated in bytes (Bytes), kilobytes (KB), megabytes (MB), and gigabytes (GB). For example, if you set the condition to doc1.pdf <= 3 MB, the doc1.pdf file must be less than or equal to 3 megabytes to meet the requirement.

File Version: Determines the version of a file. The condition you use to set the requirement includes the filename, an operator, and a version. The filename can be any file name supported by the operating system. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). Be aware that file version numbers contain four components: Major, Minor, Revision, and Build. For example, the file version for calc.exe might be 5.1.2600.0. Each component is treated independently. For this reason, the system requirements that you set might not provide your expected results. If you do not specify all four components, wildcards are assumed.

For example, if you set the condition to calc.exe <= 5, you are specifying only the first component of the version number (Major). As a result, versions 5.0.5, 5.1, and 5.1.1.1 also meet the condition.

However, because each component is independent, if you set the condition to calc.exe <= 5.1, the calc.exe file must be less than or equal to version 5.1 to meet the requirement.

NOTE: If the file is missing and the ‘less than’ (<) operator is used, the system requirement will still be evaluated as true.

IP Segment: Determines the device’s IP address. After specifying the IP segment name using CIDR (Classless Inter-Domain Routing) format, the two conditions you can use to set the requirement are Yes and No. If you select Yes, the device’s IP address must match the IP segment. If you select No, the IP address must not match the IP segment.

You must specify the IP address using CIDR format. The number following the slash (/n) is the prefix length, which is the number of shared initial bits, counting from the left side of the address. The /n number can range from 0 to 32, with 8, 16, 24, and 32 being commonly used numbers.

Examples:

123.45.67.12/16: Matches all IP addresses that start with 123.45.
123.45.67.12/24: Matches all IP addresses that start with 123.45.67.

**Logged on to Primary Workstation:** Determines whether the user is logged on to his or her primary workstation. The two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the user must be logged on to his or her primary workstation to meet the requirement. If you select **No**, if no user is logged on to the workstation, the requirement is not met. However, if a user other than the primary user is logged on to the workstation, the requirement is met.

**Memory:** Determines the amount of memory on the device. The condition you use to set the requirement includes an operator and a memory amount. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The memory amounts are designated in megabytes (MB) and gigabytes (GB). For example, if you set the condition to >= 2 GB, the device must have at least 2 gigabytes of memory to meet the requirement.

**Novell Client Installed:** Determines if the device is using the Novell Client for its network connection. The two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the device must be using the Novell Client to meet the requirement. If you select **No**, it must not be using the Novell Client.

**Operating System - Windows:** Determines the service pack level, server type, and version of Windows* running on the device. The condition you use to set the requirement includes a property, an operator, and a property value. The possible properties are service pack, server type, and version. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The property values vary depending on the property. For example, if you set the condition to version = Windows XP Versions, the device's Windows version must be XP to meet the requirement.

**NOTE:** Be aware that operating system version numbers contain four components: Major, Minor, Revision, and Build. For example, the Windows 2000 SP4 release's number might be 5.0.2159.262144. Each component is treated independently. For this reason, the system requirements that you set might not provide your expected results.

For example, if you specify Operating System - Windows in the first field, Version in the second field, > in the third field, and 5.0 -Windows 2000 Versions in the last field, you are specifying only the first two components of the version number: Major (Windows) and Minor (5.0). As a result, for the requirement evaluated to true, the OS will have to be at least 5.1 (Windows XP). Windows 2003 is version 5.2, so specifying > 5.2 will also evaluate to true.

However, because each component is independent, if you specify the version > 5.0, Windows 2000 SP4 evaluates to false because the actual version number might be 5.0.2159.262144. You can type 5.0.0 to make the requirement evaluate as true because the actual revision component is greater than 0.

When you select the OS version from the drop-down, the Major and Minor components are populated. The Revision and Build components must be typed in manually.

**Primary User Is Logged In:** Determines if the device’s primary user is logged in. The two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the primary user must be logged in to meet the requirement. If you select **No**, the user must not be logged in.

**Processor Family:** Determines the device’s processor type. The condition you use to set the requirement includes an operator and a processor family. The possible operators are equals (=) and does not equal (<>). The possible processor families are Pentium, Pentium Pro, Pentium II, Pentium III, Pentium 4, Pentium M, WinChip, Duron, BrandID, Celeron, and Celeron M. For example, if you set the condition to <> Celeron, the device’s processor can be any processor family other than Celeron to meet the requirement.
**Processor Speed**: Determines the device’s processor speed. The condition you use to set the requirement includes an operator and a processor speed. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible processor speeds are hertz (Hz), kilohertz (KHz), megahertz (MHz), and gigahertz (GHz). For example, if you set the condition to >= 2 GHz, the device’s speed must be at least 2 gigahertz to meet the requirement.

**Registry Key Exists**: Determines if a registry key exists. After specifying the key name, the two conditions you can use to set the requirement are **Yes** and **No**. If you select **Yes**, the specified key must exist to meet the requirement. If you select **No**, the key must not exist. For example, if you specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login and set the requirement to **Yes**, the specified registry key must exist to meet the requirement.

**Registry Key Value**: Determines if a registry key value meets a defined condition. The condition you use to set the requirement includes the key name, the value name, an operator, a value type, and a value data. The key and value names must identify the key value you want to check. The possible operators are equals (=), does not equal (<>), is greater than (>), is greater than or equal to (>=), is less than (<), and is less than or equal to (<=). The possible value types are **Integer Type** (specify a decimal value) and **String Type**. The possible value data is determined by the key, value name, and value type.

The ${EMPTY_VALUE} variable enables you to check for empty strings in the Registry Key Value requirements, on Windows devices.

If the value type is **String Type**, ZCM compares only those values in the registry if the actual type in the registry is REG_STRING or REG_EXPANDED_STRING.

If the value type is **Integer**, ZCM compares only those values in the registry if the actual type in the registry is REG_DWORD.

Leave the key value field blank to use the default value. The default value of a registry key has no name and is displayed in regedit as (Default).

For example, if you specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login as the key name, Port as the value name, select = as the operator, select **Integer Type** as the value type, and specify 443 as the value data, the port specified as the value data must match with the port specified in the registry key to meet the requirement.

If the value type is **IP Address**, ZCM compares only those values in the registry if the actual type in the registry is REG_STRING.

**NOTE**: The filter condition Registry Key Value is available only for Windows bundles. The value type IP Address for Registry Key Value is applicable only in VDI environments (VMwareVDI and CitrixVDI).

If you have set the condition to Registry Key Value and selected IP Address as the value type, then the two conditions that you can use to set the requirements are **Is in Subnet** and **Is not in Subnet**. If you select **Is in Subnet**, then the thin-client IP address of the device must be within a specific subnet. If you select **Is not in Subnet**, then the thin-client IP address of the device must be outside the subnet.

Specify the following in the text fields:

- Path of the registry key that should be compared
- Name of the registry value, for example: ViewClient_IP_Address
- IP Address of the network and a subnet mask to compare in order to determine if the device is within the segment (Example: 10.0.0.0/24)
**For the VMware-VDI Environment**

If you are connected to a VMware desktop from any thin client, the following registry key will be created automatically in the VMware desktop, indicating the thin-client IP address through which it is connected. You can use the same Registry key as a filter to specify the filter requirement.

*Example 10-1 Example:*

**Registry key Path:** HKEY_CURRENT_USER\Volatile Environment

**Registry key Name:** ViewClient_IP_Address

**Value:** This specifies the thin-client IP address through which you are connected to the VMware desktop. This value should be in the CIDR format for both *Is in Subnet* and *Is not in Subnet* (Example: 10.0.0.0/24).

**For the Citrix- VDI Environment**

If you are connected to a Citrix desktop from any thin client, the following registry key will be created automatically in the Citrix desktop, indicating the thin-client IP address through which it is connected. You can use the same registry key as a filter to specify the filter requirement.

*Example 10-2 Example:*

**Registry key path:** HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\Ica\Session

**Registry key name:** ClientAddress

**Value:** This specifies the thin client address through which you are connected to the Citrix desktop (Example: 10.0.0.0/24).

**Registry Key and Value Exists:** Determines if a registry key and value exist. After specifying the key name and value, the two conditions you can use to set the requirement are *Yes* and *No*. If you select *Yes*, the specified key and value must exist to meet the requirement. If you select *No*, the key and value must not exist.

For example, if you specify HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login as the key name, Port as the value name, and set the requirement to *Yes*, then the HKEY_LOCAL_MACHINE\SOFTWARE\Novell\Messenger\Login key having Port as its value, must exist to meet the requirement.

**Service Exists:** Determines if a service with the given name exists in the Services list of the system. Specify a service name and ensure that the service name is not enclosed in quotes. After specifying the service name, the two conditions you can use to set the requirement are *Yes* and *No*. If you select *Yes*, the service must exist to meet the requirement. If you select *No*, the service must not exist.

**Specified Devices:** Determines if the device is one of the specified devices. After specifying the devices, the two conditions you can use to set the requirement are *Yes* and *No*. If you select *Yes*, the device must be included in the specified devices list to meet the requirement (an inclusion list). If you select *No*, the device must not be included in the list (an exclusion list).
10.1.2 Filter Logic

You can use one or more filters to determine whether the bundle should be distributed to a device. A device must match the entire filter list (as determined by the logical operators that are explained below) for the bundle to be applied to the device.

There is no technical limit to the number of filters you can use, but there are practical limits, such as:

- Designing a filter structure that is easy to understand
- Organizing the filters so that you do not create conflicting filters

Filters, Filter Sets, and Logical Operators

You can add filters individually or in sets. Logical operators, either AND or OR, are used to combine each filter and filter set. By default, filters are combined using OR (as determined by the Combine Filters Using field) and filter sets are combined using AND. You can change the default and use AND to combined filters, in which case filter sets are automatically combined using OR. In other words, the logical operator that is to combine individual filters (within in a set) must be the opposite of the operator that is used between filter sets.

You can easily view how these logical operators work. Click both the Add Filter and Add Filter Set options a few times each to create a few filter sets, then switch between AND and OR in the Combine Filters Using field and observe how the operators change.

As you construct filters and filter sets, you can think in terms of algebraic notation parentheticals, where filters are contained within parentheses, and sets are separated into a series of parenthetical groups. Logical operators (AND and OR) separate the filters within the parentheses, and the operators are used to separate the parentheticals.

For example, “(u AND v AND w) OR (x AND y AND z)” means “match either uvw or xyz.” In the filter list, this looks like:

```
  u AND
  v AND
  w
  OR
  x AND
  y AND
  z
```

Nested Filters and Filter Sets

Filters and filter sets cannot be nested. You can only enter them in series, and the first filter or filter set to match the device is used. Therefore, the order in which they are listed does not matter. You are simply looking for a match to cause the bundle to be applied to the device.

10.2 Copying a Bundle’s System Requirements

1. In ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, select the check box next to the bundle.
3. Click Edit > Copy System Requirements.
If more than one check box is selected, the Copy System Requirements option is not available on the Edit menu.

4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to copy the selected bundle’s system requirements.

10.3 Copying a Bundle Group’s System Requirements

1 In ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, select the check box next to the bundle group.
3 Click Edit > Copy System Requirements.
   If more than one check box is selected, the Copy System Requirements option is not available on the Edit menu.
4 Select Bundles or Policies, then click Add to select the bundles or policies to which you want to copy the selected bundle group’s system requirements.
The Settings page lets you manage bundle settings, including the variables that are available for use on bundles and content replication settings for ZENworks Primary Servers and Satellite devices.

Settings can be inherited from the following locations:

- **(System)**: The bundle is inheriting the setting established for the Management Zone (Configuration tab > Management Zone Settings).
- **Folder**: The bundle is inheriting the setting established for one of its parent folders.
- **Device**: The bundle is not inheriting the setting, but the setting is configured directly on the bundle. In other words, the setting is not configured at the system level, the folder level, or the bundle level.

To configure a setting for the bundle:

1. Click Bundle Management.
2. Click the setting name.
3. If the setting is configured at the system or folder level, click Override settings to enable you to configure the setting at the bundle level.
4. Fill in the fields.

To get information about the fields, click the Help button or review the following sections:

- Section 11.1, “Managing System Variables,” on page 167
- Section 11.2, “Primary Server Replication,” on page 169
- Section 11.3, “Satellite Server Replication,” on page 169
- Section 11.4, “Sandbox Settings,” on page 170
- Section 11.5, “End Point Throttle,” on page 170
- Section 11.6, “Image Bundle Flag Settings,” on page 170

### 11.1 Managing System Variables

The Bundles Settings page lets you manage the variables that are available for use on bundles.

The Inherited Variables panel displays all system variables that are inherited from the ZENworks Management Zone or parent folders. You cannot delete or modify inherited variables. However, if you add the same system variable, but give it a different value, the new variable value overrides the inherited variable value.

When specifying the variable in a field, use the following syntax:

```
$(VAR_NAME)
```

Replace `VAR_NAME` with the name of the variable.
The System Variables panel lets you define variables that can be used to replace paths, names, and so forth as you enter information. For more information on the system variables supported in Novell ZENworks Configuration Management, see “Using System Variables” and “Using Special System Variables” in the ZENworks Control Center Reference.

You can define system variables at three levels:

- **Management Zone**: The system variables are inherited by the following: device folders, devices, and bundles.

- **Device Folder**: The system variables are inherited by all devices contained within the folder or its subfolders.

- **Device or Bundle**: The system variables apply only to the device or bundle for which they are configured.

**NOTE**: Certain user-specific variables should not be used if no user has logged in to the device. Example: For device-associated bundles, user-specific variables such as Cookies, Desktop, Favorites, Fonts, NetHood, History, Personal, Programs, Recent, SendTo, StartMenu, StartUp, TempDir, Templates, WinDesktop, AdminTools, MyPictures, and PrintHood should not be used when no user has logged in. If these variables are used, they will not be resolved.

The following table lists the tasks you can perform to manage the system variables:

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add a variable | 1. If you are configuring system variables for an object (not for the entire Management Zone), click **Override settings** to activate the System Variables panel.  
2. Click **Add**, provide the name and value for the variable, then click **OK**.  
3. Click **Apply**. | When configuring system variables for an object, you can override an inherited variable by defining a new variable with the same name but a different value. For example, if Var1=c:\ is inherited, you can override it by defining Var1=d:\.  
Variable names cannot include spaces and must be unique at the level where they are defined. For example, you cannot have two variables named Var1 defined at the device level (unless one is inherited, in which case the device level variable overrides the inherited variable).  
Variable values cannot include the characters & and <. |
| Remove a variable | 1. Select the check box next to the variable (or variables).  
2. Click **Remove**.  
3. Click **Apply**. |                                                                                     |
NOTE: The \( \text{ZENUSER} \) system variable maps to the user logged into the graphical session on the Linux or Macintosh device. For example, if user 'bob' is logged into the display:0 of a Linux device, then any bundle that references the \( \text{ZENUSER} \) variable resolves to 'bob'. There are various applications to do this. For example, the \( \text{ZENUSER} \) variable can be used to install Desktop icons in the home directory of the logged-in user by setting the path of the icon file to /home/\( \text{ZENUSER} \)/Desktop/. The \( \text{ZENUSER} \) variable is applicable for only Linux and Macintosh bundles, not for Windows bundles. A system variable could also be used to set the permission of a installed file to the logged-in user.

### 11.2 Primary Server Replication

Lets you manage content replication to Primary Servers. You can specify whether or not new Primary Servers added to the system are assigned to host the bundle. You can also specify that the bundle is included or excluded from being hosted on a specified Primary Server. For more information on this page, click Help.

For more information on content replication, see “Content Replication” in the ZENworks Primary Server and Satellite Reference.

### 11.3 Satellite Server Replication

Lets you manage content replication to Satellite devices. You can specify whether or not new Satellites added to the system are assigned to host the bundle. You can also specify that the bundle is included or excluded from being hosted on a specified Satellite. For more information on this page, click Help.

For more information on content replication, see “Content Replication” in the ZENworks Primary Server and Satellite Reference.
11.4 **Sandbox Settings**

Lets you configure the settings for the sandbox version of the bundle. You can enable the Primary Server Replication settings and Satellite Server Replication settings of the published version of the bundle to be applied to the sandbox version of the bundle. You can also enable a device to receive the sandbox version of the dependent bundles if any exists when the parent bundle is assigned to the device. For details, see [Bundle Behavior Based on Content Replication Settings](#) and [Publishing Sandbox](#).

11.5 **End Point Throttle**

Allows you to override the throttle rate settings that have been set for the location or network environment of the target device.

A specific bundle or bundles in a folder can be delivered at maximum speed, by selecting the Ignore endpoint throttle value option at the bundle or the bundle folder level.

For more information on this page, click Help.

11.6 **Image Bundle Flag Settings**

Lets you configure Image bundle settings that are used when restoring an image by applying a bundle.

For more information on Image bundle settings, see the [ZENworks Preboot Services and Imaging Reference](#).
Managing Action and Action Sets

The Actions panel displays the action sets available for the bundle. Depending on the bundle type, the possible action sets are Distribute, Install, Launch, Repair, Uninstall, Terminate, and Preboot. For example, if you select a Windows bundle, all five actions sets are available. If you select an Preboot bundle, Preboot is the only available action set.

You can add an action to any of the available action sets. When you do so, that action is performed whenever the action set is applicable. For example, when you add an action to the Install action set, that action is performed whenever the bundle is installed.

- Section 12.1, “Managing Actions,” on page 171
- Section 12.2, “Modifying Action Set Options,” on page 173

12.1 Managing Actions

When you create a bundle, all actions are enabled by default, meaning that after you add them to a action set, they run according to the action set’s options. However, not all action sets are enabled by default. You can choose to modify the action sets. For more information on modifying the action set options, see Section 12.2, “Modifying Action Set Options,” on page 173.

The following table lists the tasks you can perform to manage actions associated with the bundle. For more information on the different actions, see "Actions" on page 61.

<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Add an action | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Click Add, then click the action you want to add.  
3. Fill in the appropriate fields. Click the Help button in the Add Action dialog box for details.  
4. Click Apply. |                     |
| Remove an action | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Select the check box next to the action (or actions).  
3. Click Remove. |                     |
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Edit an action               | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Click the action’s name to display the edit page.  
4. After returning to the action set page, click Apply.                                                                                     | The actions are performed in the order they are listed.                             |
| Reorder the actions          | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Select the check box next to the action you want to move.  
3. Click Move Up and Move Down to relocate it.                                                                                              |                                                                                  |
| Enable an action to be performed | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Select the check box next to the action (or actions).  
3. Click Enable.                                                                                                                              |                                                                                  |
| Prevent an action from being performed | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Select the check box next to the action (or actions).  
3. Click Disable.                                                                                                                             |                                                                                  |
| Bypass an action that fails  | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Select the check box next to the action (or actions) you want to bypass on failure  
3. Select the check box in the Continue on Failure column.                                                                                   |                                                                                  |
<p>|                              | 4. Click Apply.                                                                                                                                                                                         |                                                                                  |</p>
<table>
<thead>
<tr>
<th>Task</th>
<th>Steps</th>
<th>Additional Details</th>
</tr>
</thead>
</table>
| Configure an action set's options | 1. If you are not already on the appropriate action set tab, click Distribute, Install, Launch, Repair, Uninstall, Terminate, or Preboot.  
2. Click Options.  
3. Modify the desired settings, then click OK to return to the action set page.  
4. Click Apply. |                                                                |
| Duplicate an action     | Enables you to create another action with similar configuration but with a small change.  
1. Select the check box next to the action.  
2. Click Duplicate. |                                                                |
| Relocate an action      | Enables you to relocate a selected action to a different action set.  
1. Select the check box next to the action.  
2. Click Relocate.  
3. Choose the required action set, then click OK. |                                                                |

### 12.2 Modifying Action Set Options

When you create a bundle, all actions are enabled by default, meaning that after you add them to a action set, they run according to the action set’s options. However, not all action sets are enabled by default. The Install, Launch, and Terminate action sets are enabled, meaning that after you add an action, it runs on assigned devices according to its action set’s options. The Uninstall action set is not enabled by default.

The following sections contain information about modifying action set options and enabling the Uninstall action set:

- Section 12.2.1, “Install Action Set Options,” on page 174
- Section 12.2.2, “Launch Action Set Options,” on page 174
- Section 12.2.3, “Uninstall Action Set Options,” on page 175
- Section 12.2.4, “Terminate Action Set Options,” on page 176
12.2.1 **Install Action Set Options**

The Install Options dialog box lets you specify the how often the bundle’s install actions are performed on managed devices and to specify if users can postpone the bundle’s installation. If the install action set or its options are modified and the bundle is re-published, then when the bundle is installed or launched, the install action set is invoked again, even if it has been set to install only once.

Bundle Change Management causes a change in the behavior of the Install action set on a device. For more information on the changed behavior, see Appendix C, “How Bundle Versions Affect an Install Action Set,” on page 195.

1. In the ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary page.
3. Click the Actions tab, then click the Install tab.
4. Click Options to display the Install Options dialog box.
5. Specify how often you want the bundle’s install actions performed:
   - **Install once per device**: Performs the bundle’s install actions once on each managed device.
   - **Install once per user per device**: Performs the bundle’s install actions once for each user on each managed device.
   - **Install always**: Performs the bundle’s install action each time the bundle is run on the managed device.
6. Specify whether to allow users to postpone performing the bundle’s install actions and specify the number of postpones to allow.
   - **Always allow postpones**: Allow the user to postpone the installation an unlimited number of times.
   - **Never allow postpones**: Do not allow the user to postpone the installation.
   - **Limit postpones to**: Specify the number of times that the user can postpone the installation.
7. Click OK, then click Apply.

12.2.2 **Launch Action Set Options**

The Launch Options dialog box lets you configure how often the bundle’s launch actions are performed on managed devices. By default, the launch actions are performed according to the bundle’s or when the user launches the bundle using its shortcut (from the Application Window, desktop, and so forth). If the launch action set or its options are modified and the bundle is re-published, then when the bundle is launched, the launch action set will be invoked again even if it has been set to launch once.

1. In the ZENworks Control Center, click the Bundles tab.
2. In the Bundles list, click a bundle’s underlined link in the Name column to display its Summary page.
3. Click the Actions tab, then click the Launch tab.
4. Click Options to display the Launch Options dialog box.
5. Fill in the fields:
Select this option to configure the bundle’s launch actions, then select one of the following options. If you do not select this option (the default), the launch actions are performed each time a user launches the application contained in the bundle.

- **For each device**: Launches the bundle’s actions once on each managed device.
- **For the first user that logs in**: Launches the bundle’s actions once on each managed device when the first user logs in to that device. If subsequent users log in to the device, the action set is not launched. If you select this option, the bundle’s icon is removed from the device’s Application Window, desktop, and so forth.
- **For every user that logs in**: Launches the bundle’s actions for every user that logs in to the device.

6 Click OK, then click Apply.

### 12.2.3 Uninstall Action Set Options

The Uninstall Options dialog box lets you enable the application to be uninstalled, allow the user to perform the uninstall, and specify that the application is uninstalled if it is not used within a specified number of days.

When you create a bundle, the Undo Install action is enabled by default; however, the Uninstall Action Set is not enabled. Therefore, in order for any actions in the action set to run (including the Undo Install action), you must enable the action set.

1 In the ZENworks Control Center, click the Bundles tab.

2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary page.

3 Click the Actions tab, then click the Uninstall tab.

4 Click Options to display the Uninstall Options dialog box.

5 Select the Enable Uninstall option. The following uninstall options are available only if Enable Uninstall option is selected:

**User Options:**

Specify whether the user should be allowed to uninstall or cancel the uninstallation of an application from a device:

- **Allow User to perform uninstall**: Select this option to enable users to remove the application from their devices.
- **Display message to the user before uninstalling the application**: Select this option to specify that a message warning the user that the application is going to be uninstalled from the device is displayed.

- **Allow user to cancel the uninstallation of the application**: Select this option to specify whether the user can cancel the uninstallation of the application. You can enable this option only if the Display message to the user before uninstalling the application option is enabled.

**Blocked Assignment Option:**

- **Uninstall application**: Select this option to uninstall the blocked application from the device.

**Other Options:**

Specify additional options to enable the uninstallation of the application from the device:

- **Uninstall application if not used within _ days**: Select this option to automatically remove the application if the user has not run it within the specified number of days (the default is 30).
Ignore Chained Dependencies: Select this option to enable the uninstallation of a dependent application that is referenced by two or more applications. For example, consider three applications (A, B, and C), where C is the dependent application. Assume application A installs application C, and application B uninstalls application C. Application C is uninstalled only if Ignore Chained Dependencies is selected.

Do not uninstall application on unassignment: Select this option to prevent the application from being uninstalled after it is unassigned from the device or user.

6 Click OK, then click Apply.

12.2.4 Terminate Action Set Options

The Terminate Options dialog box lets you specify that the bundle’s actions can be terminated. This setting is used if a bundle has an availability. For example, if a bundle can be installed only between 1 p.m. and 5 p.m. and the bundle is in the process of being installed at 5 p.m., the installation process terminates.

1 In the ZENworks Control Center, click the Bundles tab.
2 In the Bundles list, click the bundle’s underlined link in the Name column to display its Summary page.
3 Click the Actions tab, then click the Terminate tab.
4 Click Options to display the Terminate Options dialog box.
5 Select or deselect the Enable Terminate check box.
6 Click OK, then click Apply.
13 Accessing Bundles on a Managed Device

The ZENworks Agent is part of the Novell ZENworks Configuration Management software that lets your administrator manage devices over the network.

NOTE: This section contains information from the Agent online Help system and is written from the perspective of the end-user.

The ZENworks Agent, commonly referred to as the Agent, provides services that help your administrator do the following without visiting devices:

- Deliver software, patches, and other files to your device
- Manage policies that determine the behavior of your device.
- Take inventory of your device’s hardware and software.
- Access your device from a remote location to troubleshoot and fix problems with hardware and software.

Software applications and other files are distributed to your device as bundles. A bundle contains all of the content (files, etc.) and instructions (registry modifications, shortcut information, etc.) required to install the software on the device.

The following information discusses how to manage bundles by using the ZENworks Agent:

- Section 13.1, “Bundles vs. Applications,” on page 177
- Section 13.3, “Accessing Bundles,” on page 178
- Section 13.4, “Understanding Bundle Icons,” on page 182
- Section 13.5, “Launching a Bundle,” on page 182
- Section 13.6, “Postponing a Bundle Download,” on page 183
- Section 13.7, “Repairing a Bundle,” on page 183
- Section 13.8, “Viewing a Bundle’s Properties,” on page 183
- Section 13.9, “Uninstalling a Bundle,” on page 184

13.1 Bundles vs. Applications

Bundles are different than standard applications, such as Windows Notepad, that already reside on your device. When you double-click a bundle to launch it, the ZENworks Agent might first complete a variety of distribution tasks before the application is launched, including installing the application files,
running scripts, and changing the device’s registry, specific INI files, or environment variables. These tasks are all configured by your administrator to ensure that the application runs correctly on your device.

In some instances, a bundle’s icon appears dimmed or grayed out. This indicates that your device does not meet the requirements that the administrator defined for the application, or the bundle is not to be available to you at that time. The Agent does not distribute the application to your device until the requirements are met or the is appropriate.

13.2 User-Assigned vs. Device-Assigned Bundles

The bundles that you see on your device might be assigned to you or they might be assigned to the device. Bundles assigned to you are referred to as user-assigned bundles, and bundles assigned to your device are referred to as device-assigned bundles.

The ZENworks Agent displays your user-assigned bundles only when you are logged in to your user directory (Microsoft Active Directory or Novell eDirectory). If you are not logged in, you can log in through the ZENworks Configuration Management login screen. To do so, right-click the icon in the notification area, then click Login.

The Agent always displays the device-assigned bundles regardless of whether or not you are logged in. Device-assigned bundles can be launched by anyone who uses your device.

13.3 Accessing Bundles

The ZENworks Agent provides three ways for you to access the bundles that are assigned to you:

- Section 13.3.1, “ZENworks Window,” on page 178
- Section 13.3.2, “ZENworks Explorer,” on page 180
- Section 13.3.3, “ZENworks Icon,” on page 182

13.3.1 ZENworks Window

The ZENworks Window is a standalone window that you can launch from the Start menu or the command prompt.

- “Using the Start Menu” on page 178
- “Using the Command Prompt” on page 179
- “Using the ZENworks Window as the Windows Shell” on page 180

Using the Start Menu

1. Click Start > Programs > Novell ZENworks > ZENworks Application Window

The ZENworks Window left pane displays the following:

- **[All] folder**: Contains all bundles that have been distributed to you, regardless of the folder in which they are located.
- **ZENworks folder**: Contains all bundles that have not been assigned to a different folder. The ZENworks folder is the default folder for bundles; however, your administrator can create additional folders to organize bundles, and can even rename the ZENworks folder.
When you select a folder in the left pane, the right pane displays the bundles that are contained within the folder. You can:

- Install a bundle or launch an application for an already installed bundle.
- View the properties of a bundle. The properties include a description of the bundle, information about people to contact for help with the bundle, the times when the bundle is available for use, and the system requirements established for the bundle.
- Repair an installed application.
- Uninstall an installed application. This is an administrator-controlled feature that might not be enabled.

**Using the Command Prompt**

1. Open the command prompt and execute the following command:
   ```
   zapp-launcher
   ```

The following command line switches can be used when starting the Application Window using `zapp-launcher`.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:</td>
<td>Hides the initial splash screen.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher:</td>
</tr>
<tr>
<td>/?</td>
<td>Displays the help.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /?</td>
</tr>
<tr>
<td>/max</td>
<td>Displays the Application Window maximized when first loaded, overriding the window state (size and position) that was saved when exiting the previous Application Window session.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /max</td>
</tr>
<tr>
<td>/min</td>
<td>Displays the Application Window minimized when first loaded, overriding the window state (size and position) that was saved when exiting the previous Application Window session.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /min</td>
</tr>
<tr>
<td>/runonce</td>
<td>This command is used for internal purposes and it is located at HKLM\SOFTWARE\Microsoft\Windows\CurrentVersion\Run. Ensure that you do not delete it.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /runonce</td>
</tr>
<tr>
<td>/s</td>
<td>Makes the Application Window act like the Windows shell. For example, on the File menu, the <strong>Exit Application Launcher</strong> option changes to <strong>Shutdown</strong> and gives the user the standard Windows shutdown options. The <strong>Contents</strong> option on the <strong>Help</strong> menu is disabled. So, you cannot view the help. This is not a true replacement for the Windows shell. If users minimize the Application Window, they have access to the normal desktop.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /s</td>
</tr>
<tr>
<td>/d</td>
<td>Displays the Application Window with the <strong>Contents</strong> option on the <strong>Help</strong> menu disabled. So, you cannot view the help.</td>
</tr>
<tr>
<td>EXAMPLE:</td>
<td>zapp-launcher /d</td>
</tr>
</tbody>
</table>
Using the ZENworks Window as the Windows Shell

If the ZENworks Window is used as a Windows shell, only the ZENworks Window is visible on the device. You do not have access to the device desktop so the Start menu, Quick Launch toolbar, and the ZENworks Icon are also not visible. Also, help is disabled on the device.

Using the ZENworks Window as a Windows shell is useful in scenarios where you want to restrict the user on the managed device to access only the applications displayed in the ZENworks Window. For example, if you want the user to access only applications such as Notepad and Calculator, ensure that the ZENworks Windows displays only these applications. To shut down the device, click File > Shutdown.

To use the ZENworks Window as a shell:

1. On the Windows device, run `regedit.exe` and locate the following setting:
   
   HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion\Winlogon

2. Change the SHELL value from `explorer.exe` to:

   `%zenworks_home%\bin\zapp-launcher.exe`

   If you want the ZENworks Window to be maximized when it comes up, add the `/max` switch to `zapp-launcher.exe` (for example, `zapp-launcher.exe /max`).

3. Close `regedit.exe`.

4. Restart Windows.

13.3.2 ZENworks Explorer

ZENworks Explorer is an extension to Windows Explorer that enables bundles to be displayed in Windows Explorer, on the desktop, on the Start menu, on the Quick Launch toolbar, and in the notification area.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>/norm</code></td>
<td>Displays the ZENworks Application window in its original state when first loaded, and maintains the window state (size and position) that was saved when exiting the previous ZENworks Application window session.</td>
</tr>
</tbody>
</table>
You can perform the same tasks on the bundles in the ZENworks Explorer as you can in the ZENworks Window.

**NOTE:** Windows does not allow certain characters in folder paths (\ / : * ? " < > | ). If you use any of these characters as part of the name of the ZENworks Explorer folder path, each character displays as an underscore (_ ) in the Start menu. The characters display correctly in the ZENworks Window.
13.3.3 ZENworks Icon

The ZENworks Icon is located in the Windows notification area. You can double-click the icon to display the ZENworks Agent properties. Located in the left navigation pane, the Bundles link lets you view the bundles that are assigned to you and to your device.

The bundle list includes the following information:

- **Name**: Displays the name of the bundle. Click the name to display the properties for the bundle, including such information as the version, folder and icon locations, and help contacts.
- **Status**: Displays the installation status for the bundle.
- **Effective**: Displays whether or not the bundle can be used on the device. If the Effective box is selected, the bundle meets all system requirements and constraints to be used. You can click the bundle icon to launch the bundle.
  
  If the box is not selected, it cannot be used; to find out why, click the bundle name to display the system requirements and properties.

13.4 Understanding Bundle Icons

A bundle icon changes to reflect the current status of the bundle. The following table shows the bundle icons with the default light blue background icon. Your administrator might choose to use a different background icon; however, the status icons such as and remain the same.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Available Icon" /></td>
<td>Available. You can launch the bundle.</td>
</tr>
<tr>
<td><img src="image" alt="Not Installed Icon" /></td>
<td>Not Installed. The bundle failed to install. Right-click the icon, then click Repair to repair the bundle.</td>
</tr>
<tr>
<td><img src="image" alt="Unavailable Icon" /></td>
<td>Unavailable. You cannot launch the bundle. Either the device does not meet the system requirements established for the bundle.</td>
</tr>
<tr>
<td><img src="image" alt="Installing Icon" /></td>
<td>Installing. The bundle is installing to the device.</td>
</tr>
<tr>
<td><img src="image" alt="Downloading Icon" /></td>
<td>Downloading. The bundle is downloading from the network location where it is stored.</td>
</tr>
<tr>
<td><img src="image" alt="Uninstalling Icon" /></td>
<td>Uninstalling. The bundle is being removed from the device.</td>
</tr>
<tr>
<td><img src="image" alt="Running Icon" /></td>
<td>Running. The bundle is currently running.</td>
</tr>
<tr>
<td><img src="image" alt="Blocked Icon" /></td>
<td>Blocked. The bundle is blocked on the device. You cannot perform any of the actions on the bundle other than viewing its properties.</td>
</tr>
</tbody>
</table>

13.5 Launching a Bundle

By default, the ZENworks Agent does not distribute (download and install) a bundle to your device until the first time you launch it. The distribution process might include installing the bundle's files, running scripts, and changing the device's registry, specific INI files, or environment variables. Or, the process might include nothing more than providing a shortcut to the application's executable file on your local device or a network server.
To launch a bundle:

1. Access the bundle in one of the following locations:
   - **ZENworks Window**: From the Start menu, click Programs > Novell ZENworks > ZENworks Window.
   - **ZENworks Explorer**: Open Windows Explorer and find the ZENworks Agent entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.
   - **ZENworks Icon**: In the notification area, double-click the icon, then click Bundles.
2. Double-click the bundle icon.

### 13.6 Postponing a Bundle Download

If, after you launch a bundle, it begins to download and you need to stop the download, you can postpone the download to a later time. When you resume the download, it continues from the point where it previously stopped.

1. Access the bundle in one of the following locations:
   - **ZENworks Window**: From the Start menu, click Programs > Novell ZENworks > ZENworks Window.
   - **ZENworks Explorer**: Open Windows Explorer and find the ZENworks Agent entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.
2. Right-click the bundle icon, then click Postpone.

### 13.7 Repairing a Bundle

If an installed application is not functioning correctly or you think it might be outdated, you can repair that the application's bundle information is still correct. If it is not, the ZENworks Agent reinstalls the bundle to your workstation.

1. Access the bundle in one of the following locations:
   - **ZENworks Window**: From the Start menu, click Programs > Novell ZENworks > ZENworks Window.
   - **ZENworks Explorer**: Open Windows Explorer and find the ZENworks Agent entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.
2. Right-click the bundle icon, then click Repair.

### 13.8 Viewing a Bundle’s Properties

You can view a bundle’s properties to see its version number, current installation status, and help contacts. In addition, if the bundle is unavailable, you can see if it is unavailable because of system requirements or restrictions.

1. Access the bundle in one of the following locations:
   - **ZENworks Window**: From the Start menu, click Programs > Novell ZENworks > ZENworks Window.
**ZENworks Explorer:** Open Windows Explorer and find the ZENworks Agent entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2. Right-click the bundle icon, then click **Properties**.

### 13.9 Uninstalling a Bundle

Uninstall is an administrator-controlled feature. By default, uninstall is not enabled, which means that you can only uninstall bundles if your administrator has enabled the feature. Uninstall is enabled on a per-bundle basis. Depending on what your administrator enables, you might be able to uninstall some bundles but not others.

When you uninstall a bundle, the ZENworks Agent removes all files from your device and undoes all configuration settings made to your device during the bundle installation. Only files that the Agent installs specifically for the bundle are removed. For example, the Agent does not remove any shared files (files used by another application) or any user-created files such as word processing documents or spreadsheets.

After you uninstall a bundle, the bundle’s icon remains on your device. This enables you to install the bundle again whenever necessary.

To uninstall a bundle:

1. Access the bundle in one of the following locations:
   - **ZENworks Window:** From the Start menu, click Programs > Novell ZENworks > ZENworks Window.
   - **ZENworks Explorer:** Open Windows Explorer and find the ZENworks Agent entry. Depending on how your ZENworks administrator configured the bundle, the bundle icon might also be displayed on the desktop, Start menu, Quick Launch toolbar, or notification area.

2. Right-click the bundle icon, then click **Uninstall**.
Install, Uninstall, and Repair MSI Bundle Parameters

While creating Windows MSI bundles, you can select install, uninstall, and repair parameters. The following sections contain information to help you select the desired options:

- Section A.1, “Install Parameters,” on page 185
- Section A.2, “Uninstall Parameters,” on page 187
- Section A.3, “Repair Parameters,” on page 188

A.1 Install Parameters

The Install Parameters dialog box lets you specify the desired parameters.

*Figure A-1 Install Parameters Dialog Box*
The following sections contain additional information:

- Section A.1.1, "Restart Options," on page 186
- Section A.1.2, "Display Options," on page 186
- Section A.1.3, "Install Options," on page 187
- Section A.1.4, “Command Line Parameters,” on page 187

A.1.1 Restart Options

In some cases, installing an application requires restarting the workstation.

In the Install Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the install process. The installation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users answer No, the installation is not completed until the next time they manually restart.

Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.1.2 Display Options

In the Install Parameters dialog box, select the desired Display options. You can choose to perform the installation with or without a user interface, whether to display a modal dialog box at the end of the install process (a modal dialog box demands a response from the user before the installation is complete), or to hide the Cancel button so that users cannot cancel the installation.

No UI (/qn): Installs the application with no user interface (silent installation).

NOTE: This is the default installation option. If you want users to be aware that ZENworks Configuration Management is installing an application to help prevent them from rebooting or calling the help desk, change the display options to Basic UI (/qb) with No modal dialog at end (-) and Hide Cancel button (!).

You can select the options in the dialog box or you can type /i /qb-! in the Command Line Parameters field.

Full UI (/qf): Installs the application with the full user interface and a modal dialog box displayed at the end of the installation.

Reduced UI (/qr): Installs the application with a reduced user interface and a modal dialog box displayed at the end of the installation.

Basic UI (/qb): Installs the application with a basic user interface consisting of a progress bar. The following settings are available with this option:

- No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed at the end of the installation.
- Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at the end of the installation.
A.1.3 Install Options

In the Install Parameters dialog box, select the desired Install options:

Install (/i): Installs the application.

Administrative Install (/a): Creates an administrative installation point for the application. This option is useful for a network installation.

For All Users (/im): Advertises the application on the computer and installs the application for all users on first use.

For Logged In User Only (/iu): Advertises the application on the computer for the logged-in (current) user and installs the application on first use. Do not use this option when performing a System installation or when using a dynamic administrator to install the application. A dynamic administrator is an administrator account that is created on the fly to perform certain procedures, such as installing applications. Using a dynamic administrator is helpful when installing applications (some MSI applications, for example) that cannot be installed in the system space. When you select this action, the dynamic administrator is created, it performs the required tasks, and then the account is deleted.

A.1.4 Command Line Parameters

Displays the install command line parameters used during the application’s installation. As you select Restart, Display, and Install options, the command line parameters in this field are automatically populated.

A.2 Uninstall Parameters

The Uninstall Parameters dialog box lets you specify the desired parameters.

The following sections contain additional information:

- Section A.2.1, “Restart Options,” on page 187
- Section A.2.2, “Display Options,” on page 188
- Section A.2.3, “Command Line Parameters,” on page 188

A.2.1 Restart Options

In some cases, uninstalling an application requires restarting the workstation.

In the Uninstall Parameters dialog box, select the desired Restart option:

None (default): Uses the MSI application’s settings to determine whether or not a restart occurs. ZENworks does not force a Restart option.

Do Not Restart (/norestart): Never restarts the workstation during the uninstall process. The uninstallation is not completed until the next time the workstation starts.

Prompt For Restart (/promptrestart): Prompts users before restarting the workstation. If users answer No, the uninstallation is not completed until the next time they manually restart.
Always Restart (/forcerestart): Forces the workstation to restart without prompting users.

A.2.2 Display Options

In the Uninstall Parameters dialog box, select the desired Display options. You can choose to perform the uninstallation with or without a user interface, whether to display a modal dialog box at the end of the uninstallation process (a modal dialog box demands a response from the user before the uninstallation is complete), or to hide the Cancel button so that users cannot cancel the uninstallation.

No UI (/qn): Uninstalls the application with no user interface (silent uninstallation).

Full UI (/qf): Uninstalls the application with the full user interface and a modal dialog box displayed at the end of the uninstallation.

Reduced UI (/qr): Uninstalls the application with a reduced user interface and a modal dialog box displayed at the end of the uninstallation.

Basic UI (/qb): Uninstalls the application with a basic user interface consisting of a progress bar. The following settings are available with this option:

- No modal dialog at end (-): Displays a basic user interface with no modal dialog box displayed at the end of the uninstallation.
- Modal dialog at end (+): Displays a basic user interface with a modal dialog box displayed at the end of the uninstallation.
- Hide Cancel button (!): Displays a basic user interface without a Cancel button, so the user cannot cancel the uninstallation process.

A.2.3 Command Line Parameters

Displays the command line parameters used during the application’s uninstallation. As you select Restart and Display options, the command line parameters in this field are automatically populated.

A.3 Repair Parameters

The Repair Parameters dialog box lets you specify the desired parameters.
The following sections contain additional information:

- Section A.3.1, "Restart Options," on page 189
- Section A.3.2, "Display Options," on page 190
- Section A.3.3, "Repair Options," on page 190
- Section A.3.4, "Command Line Parameters," on page 191

### A.3.1 Restart Options

In some cases, repairing an application requires restarting the workstation.

In the Repair Parameters dialog box, select the desired Restart option:

- **None (default):** Uses the MSI application’s settings to determine whether or not a restart occurs. ZENworks does not force a Restart option.
- **Do Not Restart (/norestart):** Never restarts the workstation during the repair process. The repair process is not completed until the next time the workstation starts.
- **Prompt For Restart (/promptrestart):** Prompts users before restarting the workstation. If users answer No, the repair process is not completed until the next time they manually restart.
- **Always Restart (/forcerestart):** Forces the workstation to restart without prompting users.
A.3.2 Display Options

In the Repair Parameters dialog box, select the desired Display options. You can choose to perform the repair process with or without a user interface, whether to display a modal dialog box at the end of the repair process (a modal dialog box demands a response from the user before the repair process is complete), or to hide the Cancel button so that users cannot cancel the repair process.

**No UI (/qn):** Repairs the application with no user interface (silent repair process).

**Full UI (/qf):** Repairs the application with the full user interface and a modal dialog box displayed at the end of the repair process.

**Reduced UI (/qr):** Repairs the application with a reduced user interface and a modal dialog box displayed at the end of the repair process.

**Basic UI (/qb):** Repairs the application with a basic user interface consisting of a progress bar. The following settings are available with this option:

- **No modal dialog at end (-):** Displays a basic user interface with no modal dialog box displayed at the end of the repair process.
- **Modal dialog at end (+):** Displays a basic user interface with a modal dialog box displayed at the end of the repair process.
- **Hide Cancel button (!):** Displays a basic user interface without a Cancel button, so the user cannot cancel the repair process.

A.3.3 Repair Options

In the Repair Parameters dialog box, select the desired Repair options:

**Missing File (p):** Instructs Windows Installer to repair a file only if it is missing.

**Older File (o):** Instructs Windows Installer to repair a file if it is missing or if the installed file’s version is older than the file in the MSI package.

**Equal or Older File (e):** Instructs Windows Installer to repair a file if it is missing or if the installed file’s version is the same as or older than the file in the MSI package.

**Different File Version (d):** Instructs Windows Installer to repair a file if it is missing or if the installed file’s version is not exactly the same as the file in the MSI package.

**Force All (a):** Instructs Windows Installer to repair all files.

**User Registration Keys (u):** Instructs Windows Installer to repair all per-user entries from the MSI package to the Windows system registry. Per-user entries are those entries contained in the HKEY_CURRENT_USER and HKEY_USERS registry hives.

**Computer Registry Keys (m):** Instructs Windows Installer to repair all per-machine entries from the MSI package to the Windows system registry. Per-machine entries are those entries contained in the HKEY_LOCAL_MACHINE and HKEY_CLASSES_ROOT registry hives.

**Failed Checksum (c):** Instructs Windows Installer to perform a checksum on all executable files and to repair a file if it is missing or if the checksum verifies that the file is corrupt. Only files that have msidbFileAttributesChecksum in the Attributes column of the MSI package’s File Table are repaired.

**Install and Re-Cache (v):** Instructs Windows Installer to repair files from the re-cache (local) source rather than the source package.
**Shortcut(s):** Instructs Windows Installer to repair the MSI application’s shortcuts, overwriting any existing shortcuts and icons.

### A.3.4 Command Line Parameters

Displays the command line parameters used during the application's repair process. As you select the Restart, Display, and Repair options, the command line parameters in this field are automatically populated.
An authentication hook enables you to control the installation or launching of the bundle.

Create an executable file containing your authentication logic and begin its name with authhook. For example, authhookinstall.exe. During the installation or launching of the bundle, the bundle manager searches for a file matching authhook*.* in the bin directory of ZENworks. If the file is found, the bundle manager passes four arguments: zone name, bundle ID, bundle name, and username of the current bundle to the file. On execution, the file returns a code. The bundle manager installs or launches the bundle only if the returned error code matches 264.
C How Bundle Versions Affect an Install Action Set

Bundle Change Management results in a change in the behavior of the Install action set on a device if the install frequency option of the action set is configured either to install once per device or install once per user per device.

- Section C.1, “Triggers that Cause an Install Action Set to Run,” on page 195
- Section C.2, “Sample Scenario,” on page 195
- Section C.3, “Additional Scenarios,” on page 196

C.1 Triggers that Cause an Install Action Set to Run

If you assign a bundle to a device or user, the Install action set runs on the device only in the following circumstances:

- If the Install action set has never run on the device.
- If the version of the Install action set is different from the version of the Install action set that has previously run on the device.

The Install action set of a bundle is internally associated with a global version identifier and the Install action set of every bundle version is internally associated with a local version identifier.

If you make any modifications to a bundle other than modifying its Install action set, the Install action set of the sandbox that is created has the same local version identifier as the bundle version you modified. However, if you modify the Install action set of a bundle, the global version identifier of the bundle’s Install action set is incremented by one and the modified Install action set’s local version identifier is set to the new value of the global version identifier.

If the install action set or its options are modified and the bundle is re-published, then when the bundle is installed or launched, the install action set is invoked again, even if it has been set to install only once.

C.2 Sample Scenario

For example, consider the following scenario:

1. In ZENworks Control Center, create a bundle (not as a sandbox).
   The bundle version, the global version identifier of the bundle’s Install action set, and the local version identifier of the created bundle version are all set to 0 (zero).
2. In the Install action set of the bundle, add one or more actions and then click Apply.
   The global version identifier for the Install action set is incremented to 1.
3. Click Publish to publish the sandbox as version, 1.
   The local version identifier of this published version also changes to 1.
4. Assign the bundle to Device A.
The bundle runs on Device A and the actions in the Install action set of the latest published version of the bundle, which has the local version identifier set to 1, are executed on the device.

5. Modify the Install action set of the bundle and click **Apply**.
   The global version identifier is incremented to 2.

6. Repeat Step 5 twice more.
   The global version identifier is incremented to 4.

7. Click **Publish** to publish the sandbox as version, 2.
   The local version identifier of this published version also changes to 4.

8. Assign the bundle to Device B.
   The bundle runs on Device B and the actions in the Install action set of the latest published version of the bundle, which has the local version identifier set to 4, are executed on the device.

### C.3 Additional Scenarios

Perform the tasks listed in the following table to understand the subsequent behavior of the Install action set on Device A and Device B. When you begin, Device A has an Install action set with version 1 (see Step 4) and Device B has an Install action set with version 4 (see Step 6) in Section C.2, “Sample Scenario,” on page 195.

<table>
<thead>
<tr>
<th>Task</th>
<th>Device A</th>
<th>Device B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modify the Install action set of the latest published version to create a sandbox and then publish the sandbox.</td>
<td>The actions in the Install action set of the latest published version of the bundle, which has the local version identifier set to 5, are executed on the device.</td>
<td>The actions in the Install action set of the latest published version of the bundle, which has the local version identifier set to 5, are executed on the device.</td>
</tr>
<tr>
<td>Starting value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New value of the local version identifier: 5</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Modify a property of bundle other than the Install action set of the latest published version to create a sandbox and then publish the sandbox.</td>
<td>The actions in the Install action set of the latest published version of the bundle, which has the local version identifier set to 4, are executed on the device.</td>
<td>Because the version of the previously run Install action set on the device is the same as the value of the local version identifier, the Install action set does not run on the device.</td>
</tr>
<tr>
<td>Starting value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Create a sandbox from an older version of the bundle, modify the Install action set to create a sandbox, and then publish the sandbox.</td>
<td>The actions in the Install action set of the latest published version of the bundle, which has local version identifier set to 5, are executed on the device.</td>
<td>The actions in the Install action set of the latest published version of the bundle, which has local version identifier set as 5, are executed on the device.</td>
</tr>
<tr>
<td>Starting value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New value of the local version identifier: 5</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
How Bundle Versions Affect an Install Action Set

If a sandbox version of a bundle is assigned to a test device or user, the execution of the Install action set depends on whether the action set is modified or not. Even though there is no change in the bundle version, the action set runs on the device if it has been modified.

**NOTE:** When you have a bundle that references a file on a share and if the file in the share location has changed, you need to modify the action set in which you are referring the file, if you want the bundle to be reinstalled with the new file.

<table>
<thead>
<tr>
<th>Task</th>
<th>Device A</th>
<th>Device B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a sandbox from an older version of the bundle, modify a</td>
<td>Because the version of the previously run Install action set on the</td>
<td>The actions in the Install action set of the latest published version of</td>
</tr>
<tr>
<td>property of the bundle other than the Install action set to create a</td>
<td>device is the same as the value of the local version identifier, the</td>
<td>the bundle, which has the local version identifier set to 1, are executed on</td>
</tr>
<tr>
<td>sandbox, and then publish the sandbox.</td>
<td>Install action set does not run on the device.</td>
<td>the device.</td>
</tr>
<tr>
<td>Starting value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>New value of the local version identifier: 4</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

If a sandbox version of a bundle is assigned to a test device or user, the execution of the Install action set depends on whether the action set is modified or not. Even though there is no change in the bundle version, the action set runs on the device if it has been modified.

**NOTE:** When you have a bundle that references a file on a share and if the file in the share location has changed, you need to modify the action set in which you are referring the file, if you want the bundle to be reinstalled with the new file.
Best Practices

The following sections contain information on the best practices to follow while using the Bundles component of Novell ZENworks:

- Section D.1, “Changing the Look and Feel of the Start Menu on a Windows Vista Device,” on page 199
- Section D.2, “Pinning Applications to the Start Menu on a Windows Vista Device,” on page 199
- Section D.3, “Assigning Bundles to a Device or User,” on page 200
- Section D.4, “ZENworks Explorer Folder Naming Convention,” on page 200
- Section D.5, “Creating Bundles with Large Content,” on page 200

D.1 Changing the Look and Feel of the Start Menu on a Windows Vista Device

On a Windows Vista device, the folders on the Start menu have a cascading effect. To have the same look and feel as the Windows XP Start menu:

1. Right-click Start.
2. Click Properties.
3. Select Classic Start Menu.
4. Click OK.

D.2 Pinning Applications to the Start Menu on a Windows Vista Device

On a Windows Vista device, you can choose to have the folders pinned to the Start menu to have the same look and feel as the pinned folders on the Windows XP Start menu.

1. Right-click Start.
2. Click Properties.
3. Select Classic Start Menu.
4. Click OK.
5. Restart the system.
D.3 Assigning Bundles to a Device or User

Do not assign more than two bundles that has the same name to a Windows managed device because only the first two bundles that are assigned to the device are displayed on the device.

Sample Scenario: Assume that bundles named test, Test, TEST are assigned to a Windows managed device. The first bundle that is assigned to the device has the specified name. The second bundle that is assigned to the device has the management zone name appended to the specified name. However, the third bundle is not displayed on the device.

D.4 ZENworks Explorer Folder Naming Convention

If the ZENworks Explorer Folder name for two or more bundles is the same but has a different case, then only one folder and containing all the bundle’s shortcuts is displayed in the start menu and the ZENworks Explorer window.

D.5 Creating Bundles with Large Content

By default, ZENworks Control Center has a 30-minute timeout value. If you choose to create bundles with a large amount of content, you must change the ZENworks Control Center timeout value as required. For information on the changing the timeout value for ZENworks Control Center, see “Changing the Timeout Value for ZENworks Control Center” in the ZENworks Control Center Reference.
Troubleshooting

The following sections explains the scenarios that you might encounter while using the Bundles component of Novell ZENworks.

- “Bundles exported using the zman command might create empty ZIP files” on page 202
- “Uploading content from a text file that contains extended characters corrupts the content” on page 202
- “While launching applications, the window prompting for user input might not be displayed” on page 202
- “Unable to execute the Install MSI action on a Windows 2000 device” on page 202
- “Cannot back up the registry and edit the HKEY_CURRENT_USER by using a single registry action on a Windows Vista device” on page 203
- “The Undo Install Actions fails to uninstall a directory” on page 203
- “Unable to launch a RDP session from a 64-bit device” on page 203
- “If the Wake-on-LAN on the managed device is behind the server’s time zone, the device fails to wake up” on page 203
- “Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7 device taskbar” on page 204
- “Repairing an MSI that is installed on a device might reboot the device even if the norestart parameter is specified” on page 204
- “Unable to install or launch a bundle on a Linux or Macintosh device” on page 205
- “Unable to import an exported registry file into the Windows registry” on page 205
- “Unable to use the uninstall option for ZENworks bundle in the start screen on a Windows 8 machine” on page 205
- “After the upgrade, unable to uninstall a bundle that is set to uninstall prior to upgrade” on page 206
- “Bundle distribution fails when you assign a bundle to be launched during Wake-on-Lan with date specific - schedule” on page 206
- “Unable to create a bundle due to internal data model exception” on page 206
- “Bundle icons are not visible on the desktop when the desktop folder is redirected to a network share for agents running on Windows 7 and Windows 2008” on page 207
- “Bundle shortcut icon is not visible in the Start Menu of a Windows 7 device” on page 207
- “On a Windows device, NAL icons are not displayed even after enabling the disabled bundle management” on page 207
- “When a Mac patch policy bundle fails, the xauth messages that are launched are not terminated” on page 208
- “When you select either the Sandbox or an old version of a bundle or policy, the status is not displayed in the summary page of the bundle or policy” on page 208
- “An error is displayed when certain user-specific variables are used when there is no user session available” on page 208
- “An error is displayed when you copy relationships of one device to another” on page 208
Bundles exported using the zman command might create empty ZIP files

Source: ZENWorks 2017
Explanation: When you export a bundle using the bundle-export-actions command, the bundle might be exported as an empty ZIP file.
Possible Cause: This issue occurs if the database contains Satellite Server entries that are removed from the zone.
Action: Run the following queries to delete the Satellite Server entries from the database:

- DELETE FROM zZENServer WHERE zZENServer.ZUID IN (select SatelliteServers from zACOSatelliteServers where id=<BundleGUID>)
- DELETE FROM zACOContentServers WHERE zACOContentServers.id=<BundleGUID>
- DELETE FROM zACOSatelliteServers WHERE zACOSatelliteServers.id=<BundleGUID>

Uploading content from a text file that contains extended characters corrupts the content

Source: ZENworks; Software Distribution.
Explanation: If you use the Edit Text File action to upload a text file containing extended characters, the content is corrupted.
Action: Open the text file, save it as UTF-8, then upload the file.

While launching applications, the window prompting for user input might not be displayed

Source: ZENworks; Software Distribution.
Explanation: If you use bundles to launch applications that require user input, the window prompting for the input might be hidden behind the application. This problem might occur if the applications are launched for the first time for each user login.
Action: If you want to immediately view the window, minimize the application. To fix the problem, restart the system.

Unable to execute the Install MSI action on a Windows 2000 device

Source: ZENworks; Software Distribution.
Explanation: If Grant administrator privilege to user during installation is selected in the Install MSI dialog box to provide administrator privileges to the logged in user, the user is prompted to provide the log in credentials when the Install MSI action is executed on the device. The action fails to execute even if the user has provided the correct password.
Action: Add the user as a part of the operating system as follows:

1. Run MMC.
2. Click File > Add/Remove Snap-in, click Add.
3. In the Add Standalone Snap-in dialog box, select Group Policy Object Editor, click Add > Finish.
4. Click Close to close the Add Standalone Snap-in dialog box.
5. Click OK.
6. In the Console Root window, double-click Computer Configuration > Windows Settings > Security Settings > Local Policies > User Rights Assignment > Act as part of the operating system.
7. Click Add User or Group.
8. In Enter the object names to select, specify the user name. Click OK.
9. Click OK.

Cannot back up the registry and edit the HKEY_CURRENT_USER by using a single registry action on a Windows Vista device

Source: ZENworks; Software Distribution.

Explanation: If you set up an action to both back up the registry and edit the HKEY_CURRENT_USER registry entry on Windows Vista*, the action fails because all user-initiated processes in Vista run as the lowest privileged user.

Action: Use two different registry actions, one to back up the registry in the system context, and another to edit HKEY_CURRENT_USER in the user context.

The Undo Install Actions fails to uninstall a directory

Source: ZENworks; Software Distribution.

Explanation: When you create an Install Directory File bundle, the directory is installed even if its name contains spaces; however, it cannot currently be uninstalled by using the Undo Install Actions action.

Action: Avoid spaces in directory names if you want to enable the uninstallation of that directory.

Unable to launch a RDP session from a 64-bit device

Source: ZENworks; Software Distribution.

Explanation: If you launch a Launch Windows Thin Client Application action configured with the RDP Session on a 64-bit managed device, the action might fail.

Action: Apply the KB925876 patch (http://support.microsoft.com/kb/925876).

If the Wake-on-LAN on the managed device is behind the server’s time zone, the device fails to wake up

Source: ZENworks; Software Distribution.
Troubleshooting

**Explanation:** If a bundle having the distribution configured is assigned to a managed device such that the Wake-on-LAN is behind the server's time zone, the device fails to wake up.

**Action:** Ensure that the Wake-on-LAN on the managed device is not behind the server's time zone.

**Bundle shortcut icon is not visible in the Quick Launch area of a Windows 7 device taskbar**

**Source:** ZENworks; Software Distribution.

**Explanation:** If you assign a bundle to a Windows 7 managed device and choose to place the bundle shortcut icon in the Quick Launch area of the device, the bundle shortcut icon is not visible because Quick Launch is disabled by default on a Windows 7 device.

**Action:** To enable Quick Launch on a Windows 7 device taskbar:

1. Right-click the taskbar and click **Toolbars**.
2. Click **New Toolbar** to open the New Toolbar window.
3. In the **Folder** option, specify the following:
   `%UserProfile%\AppData\Roaming\Microsoft\Internet Explorer\Quick Launch`.
4. Click **Select Folder**.

To customize Quick Launch on a Windows 7 device taskbar:

1. Right-click the taskbar and deselect **Lock the Taskbar**.
2. (Optional) Click and drag the Quick Launch to the desired position on the taskbar.
3. Right-click Quick Launch and deselect **Show Title** and **Show Text** to disable title or text display.
4. Right-click Quick Launch. Click **View > Small Icons** to enable small icons.

**Repairing an MSI that is installed on a device might reboot the device even if the norestart parameter is specified**

**Source:** ZENworks; Software Distribution.

**Explanation:** If you run the Install MSI action to repair an MSI that has already been installed on a device, the device might reboot. This is because `/f` option that repairs a product can reboot the device. For more information, see Microsoft Support Site (http://support.microsoft.com/kb/961883/EN-US).

**Action:** Perform the following steps to repair a package without a reboot:

1. In ZENworks Control Center, click the MSI Application Bundle you want to repair.
2. Click **Actions > Install**.
3. Click the Install MSI action to display the Edit Action - Install MSI dialog box.
4. In the **Repair Parameters** option, Click ![repair parameters](image) to display the Repair Parameters dialog box.
5. In the Command Line Parameters option, specify /i instead of /f, then click OK.

6. In the MSI Properties panel, add the following properties:
   - Name = REINSTALLMODE ; Value = omus
   - Name = REBOOT ; Value = ReallySuppress

7. Click OK.

**Unable to install or launch a bundle on a Linux or Macintosh device**

Source: ZENworks; Software Distribution.

Explanation: On a Linux or Macintosh device, if you choose to run the zac command to install or launch a bundle that has special characters such as @ or $ in its name, the bundle fails to install or launch on the device.

Action: Run the zac command and use \ to escape the special characters in the bundle name. For example, to install a bundle named mac@, run the command as follows:

```
zac bin mac\@
```

**Unable to import an exported registry file into the Windows registry**

Source: ZENworks; Software Distribution.

Explanation: On platforms that use non-Western European languages, a registry file exported by using the ZENworks Registry Edit action might contain values that prevent the registry file from being imported into the Windows registry.

Action: To export the registry file:

1. In ZENworks Control Center, click a bundle.
2. Click Actions > Registry Edit.
3. Click Export to export the registry file.

To import the registry file into the Windows registry:

1. Edit the exported registry file to remove values such as `fffffffffffffff0b0` from the file.
2. Import the file into the Windows registry.
3. Use the Windows Regedit utility to reenter the values that you removed in Step 1.

   For more information on reentering the values, refer to the Registry Edit Action page of ZENworks Control Center.

**Unable to use the uninstall option for ZENworks bundle in the start screen on a Windows 8 machine**

Source: ZENworks; Software Distribution.

Explanation: On a Windows 8 machine if you right click on the ZENworks bundle shortcut and choose the uninstall option in the charms bar, the ZENworks bundle shortcut fails to point at the underlying application or msi installer in the add remove screen of the control panel.
Possible Cause: The uninstall option that is in the charms bar of the start screen on a Windows 8 machine is not supported for ZENworks bundle.

Action: Won’t fix.

**After the upgrade, unable to uninstall a bundle that is set to uninstall prior to upgrade**

Source: ZENworks; Software Distribution.

Explanation: If you have set a bundle to uninstall on unassignment, and after the upgrade the bundle is unassigned, the bundle might not get uninstalled.

Possible Cause: After the upgrade only the new cache entries are referenced. The old cache entries of the unassigned items are not referenced.

Action: Won’t fix.

**Bundle distribution fails when you assign a bundle to be launched during Wake-on-Lan with date specific - schedule**

Source: ZENworks; Software Distribution.

Explanation: When you assign a bundle to be launched on a device during Wake-on-Lan (WOL) with the date-specific schedule, the contents of the bundle are not distributed.

Possible Cause: By the time the device wakes up (based on the Wake-on-LAN schedule) and receives the bundle assignment, the scheduled distribution time has passed, so the bundle is not distributed on the device. The primary cause of this issue is setting the same time for both the Wake-on-Lan schedule and the bundle distribution schedule.

Action: When assigning bundles to Wake-on-Lan devices, if you select a Schedule Type of Date Specific, you also need to enable the Process immediately if device unable to execute on schedule option. This option forces the bundle distribution to occur after the device wakes and receives the bundle distribution schedule.

**Unable to create a bundle due to internal data model exception**

Source: ZENworks; Software Distribution.

Explanation: When you try to create a bundle or any ZENworks object, the bundle or object throws the following data model exception:

```
com.novell.zenworks.datamodel.exceptions.InternalDataModelException: org.hibernate.QueryTimeoutException: ORA-01658: unable to create INITIAL extent for segment in tablespace CCT_XA_TAB
```

Possible Cause: This failure is because the allocated file size for the data file is used and has exceeded.

Action: Increase the tablespace to ensure sufficient disk space availability for data files in the tablespace.
Bundle icons are not visible on the desktop when the desktop folder is redirected to a network share for agents running on Windows 7 and Windows 2008

Source: ZENworks; Software Distribution.

Explanation: When the desktop folder for a ZENworks Configuration Management Agent running on Windows 7 or Windows 2008 is redirected to a network share, the shortcut icons for ZENworks Configuration Management bundles do not appear.

Action: To create the shortcut icons for bundles:

1. Open the Registry Editor.
2. Go to HKLM\Software\Novell\ZCM\NAL.
3. Create a DWORD called SetIconOnDesktop and set the value to 1.
4. Reboot the workstation.

Bundle shortcut icon is not visible in the Start Menu of a Windows 7 device

Source: ZENworks; Software Distribution.

Explanation: After assigning a bundle to a Windows 7 managed device, if you choose to place the bundle shortcut icon in the Start Menu of the device, the bundle shortcut icon is not visible.

Possible Cause: The Remove User's folders from the Start Menu GPO setting is enforced on a Windows 7 device.

Action: Disable the Remove User's folders from the Start Menu GPO setting on a Windows 7 device:

1. Run gpedit.msc
2. Click User Configuration > Administrative Templates > Start Menu and Task Bar.
3. Double click Remove user's folders from the Start Menu.
4. In the Remove User's folders from the Start Menu dialog, select Disabled.
5. Click Apply > OK.

On a Windows device, NAL icons are not displayed even after enabling the disabled bundle management

Source: ZENworks; Software Distribution.

Explanation: If you log in to a Windows device for which bundle management is disabled, the NAL explorer shell extension (NalShell.dll) that is required for enabling bundle explorer icons is not loaded by Windows Explorer. As a result, even if you enable bundle management on the device, the NAL explorer icons do not get enabled.

Possible Cause: NAL explorer shell extension (NalShell.dll) is not loaded by Windows Explorer.

Action: To restart the explorer.exe, which loads Nalshell.dll, logoff, and then log in to the workstation again.
When a Mac patch policy bundle fails, the xauth messages that are launched are not terminated

Source: ZENworks; Software Distribution

Explanation: If you launch a Mac patch policy bundle several times, the policy fails each time with a pop-up message to install xauth. These xauth messages are not terminated even after the bundle error messages disappear. This is because X11 is no longer included as a default install, starting with OS X Mountain Lion 10.8.3.

Action: Before upgrading a ZENworks agent to an OS X Mountain Lion 10.8.3 (or later) device, or before installing ZENworks agent on an OS X Mountain Lion 10.8.3 (or later) device, you need to install the X11 application.

When you select either the Sandbox or an old version of a bundle or policy, the status is not displayed in the summary page of the bundle or policy

Source: ZENworks; Software Distribution

Explanation: After assigning a bundle that has the sandbox and the published versions to a device, if you select either an old version or a sandbox version of the bundle, the Bundle Status information is not displayed in the summary page of the bundle or policy.

Action: There is no workaround.

An error is displayed when certain user-specific variables are used when there is no user session available

Source: ZENworks; Software Distribution

Explanation: Certain user-specific variables should not be used if there is no user session available. For example, for device associated bundles, user-specific variables such as TEMPDIR, DESKTOP, and FONTS should not be used when there is no user session available. If these variables are used, then the bundle will fail with the following error: The directory name is invalid.

Action: There is no workaround.

An error is displayed when you copy relationships of one device to another

Source: ZENworks; Software Distribution

Explanation: When a ZENworks administrator tries to copy relationships of one device to another, the Summary page of the Copy Relationships wizard lists the operations performed (assignments added or assignments removed). If the operation fails due to insufficient rights or any other reason, then an error icon is displayed in the Summary page.
Action: Perform the relevant action:

- If the issue is related to insufficient rights, ensure that the administrator has the required rights to perform the copy relationships operation on the relevant ZENworks objects.
- If the issue is related to any other reason, you need to refer the zcc.log file for more details.